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I. РАБОЧАЯ ПРОГРАММА ДИСЦИПЛИНЫ 
1. Цели и  задачи учебной дисциплины «Математика и информатика», 

ее место в учебном процессе. 
1.1. Цели преподавания учебной дисциплины «Математика и инфор-

матика»: 
 воспитание достаточно высокой математической культуры; 
 привитие навыков использования математических методов в практиче-

ской деятельности; 
 развитие навыков математического мышления у специалистов гумани-

тарного профиля, необходимых для обработки информации и использования 
математических моделей в компьютерных технологиях;  

 обучение студентов основам программирования и работы с ЭВМ; 
 обучение теоретическим основам и практическим навыкам проектиро-

вания и реализации программ на современных ЭВМ. 
1.2. Задачи изучения дисциплины: 
 на примерах математических понятий и методов продемонстрировать 

сущность научного подхода, специфику математики, ее роль в развитии других 
наук; 

  научить студентов приемам исследования и решения, математически 
формализованных задач; 

  выработать умения   анализировать   полученные   результаты,   при-
вить   навыки самостоятельного изучения литературы по математике. 

 углубить знания студентов по основному аппаратному обеспечению и 
периферийным устройствам компьютера; 

 научить студентов решать задачи, возникающие в процессе сопровож-
дения и эксплуатации   программных средств; 

 освоить современные методы и средства программирования, этапы раз-
работки программного  обеспечения; 

1.3. Перечень учебных курсов, освоение которых необходимо для изу-
чения дисциплины «Математика и информатика» 

Для успешного усвоения курса необходимы знания по основным аксиомам 
и теоремам элементарной геометрии, алгебры, начала математического анализа, 
курса "Информатика" в объеме средней общеобразовательной школы.  

1.4. После изучения дисциплины студенты должны знать и уметь ис-
пользовать: 

 уметь логически мыслить; 
 уметь оперировать с абстрактными объектами; 
 быть корректным в употреблении математических понятий и символов 

для выражения качественных и количественных отношений; 
 владеть навыками компьютерной обработки данных; 
 владеть методами информационного поиска (в том числе в системе Ин-

тернет); 
 владеть статистическими методами обработки филологической инфор-

мации; 
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 уметь работать с различными типами текстовых редакторов. 
2.  Содержание учебной дисциплины «Математика и информатика» 

2.1. Согласно государственному стандарту математических и естест-
венных дисциплин студент должен изучить: 

 аксиоматический метод; 
 основные структуры; 
 составные структуры; 
 вероятности; 
 языки программирования; 
 алгоритмы; 
 компьютерный практикум. 
2. 2. Темы дисциплины и их содержание. 

1. Алгебра множеств. 
Отношения. Отображения. Математические операции. Конечные и беско-

нечные множества. 
2. Элементы линейной алгебры. 
Матрицы и определители. Понятие обратной матрицы, ее экономические 

приложения. Решение систем линейных алгебраических уравнений (СЛАУ). 
3. Аналитическая геометрия на плоскости. 
Декартова переменная величина и система координат. Аналитическая геомет-

рия на плоскости. Уравнение прямой. Кривые второго порядка, их уравнения. 
4. Введение в математический анализ. 
Основные идеи математического анализа. Последовательности и предел. Бес-

конечно малая величина и ее роль в развитии математики. 
5. Дифференциальное исчисление функции одной переменной. 
Производная, ее геометрический и физический смысл. Максимум и минимум 

функции Применение производной к исследованию функции. 
6. Теория вероятностей. 
Роль случайного в жизни. Методы изучения этого явления. Элементы теории 

вероятности: предмет теории вероятности, понятие несовместных и независимых 
событий. Классическое и статистическое определение вероятности. Формула пол-
ной вероятности. Формула Байеса. Формула Бернулли. Теоремы Лапласа. 

7. Основные понятия математической статистики. 
Числовые характеристики дискретной случайной величины. Законы боль-

ших чисел. Понятие статистической гипотезы. Математические методы провер-
ки гипотез. Системы случайных величин. Корреляция. Метод наименьших 
квадратов. 

8. Информатизация общества: современное представление информа-
ции и алгоритмы ее обработки. 

История развития вычислительной техники, классификация ЭВМ. Основ-
ные  направления  в информатике.  Построение информационного общества. 
Общие характеристики   процесса сбора, хранения, обработки и передачи ин-
формации. Основные направления информатики. Информационные системы и 
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технологии. Построение алгоритма решения задач. Алгоритмы, их свойства 
описания. Представление информации с использованием графических редакто-
ров и специальных пакетов графических программ. 

9. Системы счисления. 
Понятие системы счисления. Классификация систем счисления. Двоичная 

система счисления. Правила перевода из десятичной в двоичную систему. Пра-
вила перевода из двоичной в десятичную систему счисления. Системы счисле-
ния, родственные двоичной (восьмеричная, шестнадцатеричная). 

10. Аппаратное обеспечение ПК. 
Основные блоки персонального компьютера и их назначение. Запоминаю-

щие устройства и их применение. Основные внешние  устройства персонально-
го компьютера: принтер, сканер, модем, графопостроитель, дигитайзер, мани-
пуляторы и их назначение. 

11. Программное обеспечение ПК. 
Системное программное обеспечение: базовое программное обеспечение, 

сервисное программное обеспечение. Понятие операционной системы, класси-
фикация операционных систем, примеры используемых операционных систем. 
Понятие файловой структуры, файла, каталога, директории. Прикладное про-
граммное обеспечение. 

12. Операционная система Windows: диалог “человек-компьютер”.  
Понятие операционной системы, классификация операционных систем, 

примеры используемых операционных систем. Понятие операционной оболоч-
ки. Понятие файловой структуры, файла, каталога, директории. Основные кон-
цептуальные характеристики операционной системы Windows 95/98/2000. Сер-
висное программное обеспечение в Windows: программы ScanDisk, восстанов-
ление удаленных файлов ("Корзина"), форматирование диска, дефрагментация 
диска, сжатия данных, сведения о системе, восстановление системы.  

13. Текстовые редакторы. 
Классификация текстовых редакторов: текстовые редакторы, текстовые 

процессоры, издательские системы, их основные функции. Основы работы с 
программами БЛОКНОТ, WordPad, WinWord. 

14. Электронные таблицы. 
Технология работы в электронной таблице Excel. Адресация ячеек, форма-

тирование ячеек. Размещение в ячейках текста, формул, функций. Графический 
анализ данных: построение графиков и диаграмм.  

15. Электронные презентации. 
Работа со слайдами в режиме «слайды». Дополнительные визуальные эф-

фекты. Работа с шаблонами. Дизайн презентации. Подготовка демонстрации. 
Показ слайдов. 

16. Компьютерная графика. 
Основные характеристики растровых, векторных редакторов, редакторов 

трехмерной графики.  
17. Базы данных. 
Структура базы данных. Модели базы данных. Системы управления база-

ми данных. СУБД Access. 
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18. Алгоритмизация и программирование. 
Определение исходных данных. Выбор метода решения. Понятие алгорит-

ма. Основные конструкции алгоритмов.  Понятие программы.  Этапы и методы 
разработки программ. Отладка и тестирование программ. 

2.3. Распределение учебного времени.  
2.3.1. Распределение часов на лекционные занятия 

 

Тема Кол-во часов 
1 семестр 

Алгебра множеств 2 
Элементы линейной алгебры 2 
Аналитическая геометрия на плоскости 2 
Введение в математический анализ  2 
Дифференциальное исчисление функции одной переменной 2 
Теория вероятностей   4 
Основные понятия математической статистики 4 
ВСЕГО 18 

2 семестр 
Информатизация общества: современное представление информации и ал-
горитмы ее обработки 2 

Системы счисления 1 
Аппаратное обеспечение персонального компьютера 2
Программное обеспечение персонального компьютера 2 
Компьютерная графика 1 
Операционная система Windows: диалог “человек-компьютер” 2 
Текстовые редакторы 1 
Электронные таблицы 2 
Электронные презентации 1 
Базы данных 2 
Алгоритмизация и программирование 2 
ВСЕГО 18 

2.3.2. Распределение часов на практические занятия 

Тема занятия Кол-во 
часов РГР К.р. 

1 семестр 
Математические задачи на повторение 2  
Теория множеств. Операции над множествами 2  
Отношения и отображения 2  
Определители и их свойства их вычисление. Формулы Крамера. 
Матрицы, операции над матрицами. Обратная матрица. 2 

Ранг матрицы. Метод Гаусса. 2 
+ 

Прямая на плоскости 2 
Кривые второго порядка 2 + 

Предел функции. Непрерывность. 2 
Таблица производных. Правила дифференцирования. 2 

+ 

+ 
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Приложение производной 2  
Задачи на применение классической формулы вероятности. 2 
Задачи на применение формулы Бернулли, теорем Лапласа.  2 
Закон распределения дискретной случайной величины  2 
Числовые характеристики дискретной случайной величины. 2 

+ 

Проверка статистических гипотез 4 Л/р 
Вычисление коэффициента корреляции 2 Л/р 
Определение линии регрессии методом наименьших квадратов 2 

 

Л/р 
ВСЕГО   36   

2.3.3. Распределение часов на лабораторные занятия 
2 семестр 

Тема Кол-во 
часов 

Рабочий стол Windows. Работа с окнами 2 
Стандартные программы. Работа с папками и файлами 1 
Программа «Поиск». Программа «Проводник» 1 
Создание текстового документа 2 
Форматирование текстов 2 
Создание таблиц и схем 2 
Списки, стили, оглавления 2 
Язык и статистика: редактирование формул 2 
Знакомство с электронной таблицей  2 
Создание простейшей таблицы 2 
Ввод и редактирование данных. Формат данных 2 
Адресация. Вычисления в таблицах 2 
Сортировка данных и форматирование таблиц 2 
Графический анализ данных 2 
Создание презентаций 4 
Создание таблиц базы данных 2 
Работа с формами 2 
Формирование запросов и отчетов для отдельных таблиц базы данных 2 
ВСЕГО 36 

2.4. Вопросы для самостоятельной работы. 
Кол-во часов, 
специальность Тема 

031001 030601 031202 
1 семестр 

Математизация научного знания. Особенности изучения матема-
тики. История развития математики (основные этапы). Аксиома-
тический метод. Основные черты математического мышления. 
Математические доказательства 

8 6 10 

Векторы. Линейные операторы над векторами. Направляющие ко-
синусы и длина вектора 8 6 10 

Скалярное произведение вектора и его свойства. Длина вектора и 
угол между двумя векторами в координатной форме. Условие ор-
тогональности двух векторов. Механический смысл скалярного 
произведения 

10 8 12 

Уравнение линий в пространстве. Различные формы уравнений в 8 8 7 
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пространстве. Поверхности 
Множество существенных чисел, функция, область ее определе-
ния. Способы задания. Основные элементарные функции, их свой-
ства и графики 

8 8 7 

ВСЕГО 42 36 46 
2 семестр 

Тенденция развития ЭВМ 3 2 4 
Кодирование информации 3 2 4 
Поколения и виды ЭВМ. История развития и перспективы 2 2 2 
Роль информации в современном обществе 2 2 2 
Задачи и роль специалиста-филолога в информационном обществе 1 1 2 
Компьютерные вирусы и способы защиты от них 3 2 4 
Информационная культура специалиста-филолога 2 2 2 
Перспективы применения новых информационных технологий в 
профессиональной деятельности специалиста-филолога 2 2 2 

Программа работы с изображения Adobe Photoshop 3 2 3 
Программа работы с изображениями Corel Draw 3 2 3 
Проблемы, современное состояние и тенденции, новые возможно-
сти и перспективы информационной цивилизации 4 3 4 

Искусственный интеллект и интеллектуализация компьютерных 
систем 4 4 4 

ВСЕГО 42 36 46 

3. Перечень промежуточных форм контроля знаний студентов. 
Порядок проведения зачета 

1. Студент допускается к зачету при условии: 
- наличия всех выполненных лабораторных работ (сданных ранее на занятиях 

или предъявленных на зачетном занятии);  
- зачтенных контрольных (проверочных) работ;  
2. В случае наличия незачтенных контрольных работ студент выполняет их 

непосредственно перед началом зачета (или на последнем плановом занятии в се-
местре) под контролем преподавателя. 

3.   Зачет состоит из практической и теоретической частей. 
- Зачет по практической части  состоит из практических заданий, выпол-

няемых на персональном компьютере (одно задание по каждой теме, изучаемой на 
лабораторных занятиях). Затраты времени на выполнение практической части не 
должны превышать 15-20 минут. 

- Зачет по теоретической части состоит из ответов на 3 вопроса из выше-
приведенного списка, номера которых задаются преподавателем.  

4. В случае удовлетворительного ответа на большинство теоретических во-
просов (не менее 2-х), зачет считается сданным полностью. Иначе студенту пред-
лагается ответить еще на 2 вопроса. Удовлетворительные ответы на большинство 
из общего количества заданных вопросов (общим числом 5:3 стартовых плюс 2 
дополнительных) позволяют считать зачет сданным. 

5.  Если студент не смог успешно выполнить практическую часть, ему назна-
чается дата перезачета и вся процедура повторяется заново. Если студент не сдал 
только теоретическую часть, то на перезачете он сдает именно ее, причем номера 
вопросов меняются. 

6.  На зачете разрешается пользоваться только справочной системой соответ-
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ствующего приложения (Windows, Excel, Word, ...);  
7.  Студенты, замеченные в использовании иных учебных пособий и (или) ма-

териалов, удаляются с зачета и им назначается дата повторного перезачета.  
3.1. Вопросы к зачету (1 семестр) 

1. Математизация научного знания. 
2. Основные этапы развития математики от каменного века до наших дней. 
3. Язык математики, как особая форма общения. 
4. Определение аксиоматической теории. 
5. Аксиоматический метод. 
6. Алгебра множеств. Конечные и бесконечные множества. 
7. Отношения и отображения. Математические операции 
8. Матрицы и определители. 
9. Решение СЛАУ 
10. Декартова переменная величина. 
11. Декартова система координат, ее связь с другими системами. 
12. Уравнение прямой на плоскости. 
13. Общее понятие о кривых второго порядка. 
14. Зарождение математического анализа. 
15. Применение производной к задачам исследования функции. 
16. Геометрический и физический смысл производной. 
17. Роль случайного в жизни. Методы изучения этого явления. 
18. Предмет теории вероятности 
19. Классическое и статистическое определение вероятности 
20. Теоремы сложения и умножения вероятностей. 
21. Применение формул полной вероятности и Бейеса. 
22. Схема Бернулли, ее применение 
23. Теоремы Лапласа 
24. Задачи математической статистики. Мат ожидание, дисперсия, среднеквадра-

тическое отклонение. 
25. Законы больших чисел, их применение к практическим задачам. 
26. Понятие статистической гипотезы. Виды гипотез, виды ошибок при принятии 

гипотезы. 
27. Понятие критерия проверки гипотезы. 
28. Система двух случайных величин. Корреляция. 
29. Метод наименьших квадратов. Уравнение регрессии. 
30. Отыскание коэффициентов линии регрессии для нелинейной зависимости. 

3.2. Вопросы к зачету (2 семестр). 
1. Понятие «информатика». Что изучает информатика? 
2. Информационное общество.  
3. Основные  направления  в информатике. 
4. Понятие информации. Единицы измерения информации. 
5. Общие характеристики   процесса сбора, хранения, обработки и передачи ин-

формации. 
6. История развития вычислительной техники, классификация ЭВМ. 
7. Основное аппаратное обеспечение ПК. Характеристики компьютера. 
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8. Программное обеспечение ПК.  
9. Классификация прикладных программ. 
10. Понятие операционной системы. Функции операционной системы в ПК. 
11. Сервисное программное обеспечение ПК 
12. Файл, каталог, директория, ярлык.  
13. Основные концептуальные особенности операционной системы Windows 

95/98/2000.  
14. Виды меню, типы окон в Windows.  
15. Вирус. Классы вирусов. Антивирусные программные средства. 
16. Текстовый редактор Word: назначение, возможности, основные понятия. 
17. Электронная таблица Excel, назначение, возможности, основные понятия. 
18. Программы для изготовления презентаций. 
19. Базы данных. 
20. Алгоритмизация и программирование. 

4. Учебно-методические материалы. 
4.1. Основная литература. 

1. Верещагин, Н.К. Начала теории множеств [Текст] / Н.К. Верещагин, А.А. 
Шень. – М.: МЦНМО, 2002. –  128 с. 

2. Турецкий, В.Я. Математика и информатика [Текст] / В.Я. Турецкий. – М.: 
ИНФРА, 2006. – 560 с. 

3. Гмурман, В.Е. Теория вероятностей и математическая статистика [Текст]: 
учебное пособие для вузов / В.Е. Гмурман. – М.: Высшая школа, 2006. – 479 с. 

4. Информатика. Базовый курс [Текст]: учеб.: рек. Мин. обр. РФ / Ред. С.В. 
Симонович. - СПб.: Питер, 2000, 2004,2005,2006. - 638 с.  

5. Информатика [Текст]: учеб.: рек. мин. обр. РФ / под ред. Н. В.  Макаровой. - 
М.: Финансы и статистика, 2000, 2005, 2001. - 268 с.   

6. Информатика [Текст]: практикум по технологии работы на компьютере: 
рек. Мин. обр. РФ  / под ред. Н. В.  Макаровой. - М.: Финансы и статистика, 2005. - 
256 с. 

4.2. Дополнительная литература  
1. Бермант, А.Ф. Краткий курс математического анализа [Текст] / А.Ф. Бер-

мант. – СПб.: Лань, 2005. – 736 с. 
2. Выгодский, М.Я. Справочник по высшей математике [Текст] / М.Я. Выгод-

ский. – М.: Элиста, 2006. – 991 с. 
3. Шипачев, В.С. Высшая математика [Текст]: учебник / В.С. Шипачев. –  М.: 

Высш. шк., 2005. – 479 с. 
4. Данко, П.Е. Высшая математика в упражнениях и задачах [Текст] / П.Е. 

Данко, А.Г. Попов. – М.: Наука, 2005. – 304 с. 
5. Гиляревский, Р. С. Основы информатики [Текст]:  курс лекций / Р.С. Гиля-

ревский. - М.: Экзамен, 2003. – 320 с. 
6. Ляхович, В. Ф. Основы информатики [Текст]: учеб. пособие: рек. мин. обр. 

РФ / В.Ф. Ляхович, С.О. Крамаров. – Ростов н/Д: Феникс, 2003. – 700 с. 
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II. МЕТОДИЧЕСКИЕ РЕКОМЕНДАЦИИ ПРОФЕССОРСКО-
ПРЕПОДАВАТЕЛЬСКОМУ СОСТАВУ 

1. Методические рекомендации по проведению лекционных занятий. 
Задача лекции состоит не столько в изложении системы теоретических зна-

ний, сколько в общении с аудиторией, сообщении ей смысла и значения излагае-
мого материала, в дальнейшем развитии знания. Полученные в ходе лекции зна-
ния, часто носят характер поверхностного усвоения, при этом должны служить 
дальнейшим мотивом и основой для дальнейшей организации самостоятельной 
учебно-познавательской деятельности по приобретению новых знанию и умений,  
приводящей к глубокому освоению понятий, как отдельной темы, так и науки в 
целом. 

На очном лекционном занятии в вводной части определяются минимальные 
знаний, умения и навыки, подлежащие усвоению в ходе изучения темы курса. В 
основной части рассматривается довольно большой объем материала, в основном, 
обзорного характера.  В заключительной части лекции излагается постановка ти-
повых задач темы, решение которых подробно будет рассмотрено на лаборатор-
ных занятиях. 

Изложение информационного материала лекции предполагает  использование 
объяснительно-иллюстративного метода с применением фронтальной формы ор-
ганизации обучения.  

2. Методические рекомендации по проведению лабораторных работ. 
На лабораторных занятиях по информатике формируется и совершенствуется 

практический уровень владения информационными процессами, основывающийся 
на применении теоретических знаний. Для проведения лабораторных занятий со 
студентами по дисциплине «Информатика» используются компьютерные классы. 
Занятия в компьютерном классе предполагают индивидуальную или парно-
групповую формы организации обучения.  

Этапы проведения лабораторной работы следующие: 
• Контрольный опрос студентов для проверки готовности к выполнению 

лабораторной работы (до 10 мин). 
• Выдача индивидуального задания и пояснения о порядке выполнения ин-

дивидуального задания (до 5 мин). 
• Выполнение индивидуального задания (около 1 ч.) 
• Оформление результатов работы. Сдача выполненной работы преподава-

телю (до 10 мин). 
• Получение домашнего задания (1-2 мин.) 
• Приведение в порядок рабочего места, в том числе закрытие всех рабочий 

окон и уничтожение созданных на винчестере индивидуальных файлов (3-4 мин). 
Индивидуальные задания для лабораторных работ должны быть представле-

ны конкретно-практическими и  творческими задачами. 
На первой ступени изучения темы выполняются конкретно-практические за-

дачи, при решении которых формируется минимальный набор умений. Препода-
ватель опосредованно руководит самостоятельной познавательной деятельностью 
студентов, консультирует студентов при возникновении непосильных затруднений 
в ходе решения задачи, обращает внимание группы "опасные" места решения. От-
работка минимального набора навыков завершается во внеаудиторное время при 
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выполнение домашней работы. Принимая во внимание сложность доступа некото-
рыми студентами к компьютерной техники во внеаудиторное время, домашние за-
дания по "Информатике" должны носит большей части моделирующий характер. 

Вторая ступень изучения темы  дифференцируется в зависимости от степени 
усвоения его обязательного уровня. Студенты, овладев основами теории и усвоив 
содержание типовых методов и приемов решения задач, приступают к решению 
творческих задач. Если уровень знаний и умений, демонстрируемых студентом 
при контрольном обследовании, не соответствует установленным требованиям, 
студент вновь возвращается к стандартным упражнениям, но под более присталь-
ным наблюдением преподавателя. 

По завершению изучения отдельной темы курса по результатам выполнения 
лабораторных работ каждый студент получает оценку. 

Студенты, пропустившие лабораторные занятия, должны их выполнить во 
внеаудиторное время и отчитаться до начала зачетно-экзаменационной сессии. 

3. Методические рекомендации по проведению практических занятий. 
В процессе обучения студент должен прослушать определенный теоретиче-

ский материал и закрепить этот материал на практических занятиях, а также при 
выполнении домашних самостоятельных работ. 

Практическое занятие должно начинаться с проверки домашнего задания. 
При этом допустимо некоторые, наиболее сложные задачи, с которыми не справи-
лась большая часть студентов решить на доске.  Тем самым создается прочная база 
для дальнейшего обучения.  

При изучении новой темы необходимо постоянно обращаться к теоретиче-
скому материалу. Иногда теория оказывается заданной на самостоятельное изуче-
ние. В этом случае преподаватель-практик обязан помочь студенту в выборе лите-
ратуры, разъяснить трудные и непонятные места в тексте, ответить на все вопро-
сы.  Переходить к практическим задачам возможно только после полного усвоения 
теории. Недопустимо повторять чтение лекции на практике, если студенты забыли 
конспекты лекций и не помнят их суть.  

При решении задач нужно обосновать каждый этап решения исходя из теоре-
тических положений курса. Если студент видит несколько путей решения, то не-
обходимо помочь ему выбрать наиболее рациональный. Решение каждой задачи 
должно доводиться до ответа, требуемого условием.  

Для оптимизации учебного процесса и развития практических навыков овла-
дения математикой весьма эффективным является проведение кратких самостоя-
тельных работ, как по практическому, так и по теоретическому материалу. При 
этом целесообразно формулировать вопросы по теории таким образом, чтобы для 
ответа не требовались долгие и сложные доказательства и выводы. Такая форма 
контроля позволяет выявить наличие и прочность базовых знаний по изучаемой 
теме. Аналогично, практические задания  должны быть составлены предельно 
просто и ясно. При проведении таких кратких работ студенты не должны пользо-
ваться никаким справочным материалом. 

В конце занятия необходимо подвести итог, объявить тему и план следующе-
го занятия, задать домашнее задание, указав литературу, которой желательно вос-
пользоваться при его выполнении. 
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4. Методические рекомендации по организации контроля знаний студен-
тов   

В Университете качество освоения образовательных программ оценивается 
путем осуществления текущего контроля успеваемости, проведения промежуточ-
ных аттестаций и итогового контроля по окончании семестра.  

На первом занятии до сведения студентов доводятся требования и критерии 
оценки знаний по дисциплине. 

Целью текущего контроля успеваемости является оценка качества освоения 
студентами образовательных программ в течение всего периода обучения. К глав-
ной задаче текущего контроля относится повышение мотивации студентов к регу-
лярной учебной работе, самостоятельной работе, углублению знаний, дифферен-
циации итоговой оценки знаний. 

Текущий контроль успеваемости осуществляется систематически и, как пра-
вило, преподавателем, ведущим лабораторные занятия. Формами текущего кон-
троля являются письменные опросы,  автоматизированное тестирование, аудитор-
ные контрольные работы, отчеты по лабораторным работам, домашние задания. В 
течение семестра преподавателем должно быть проведено не менее 7-ми кон-
трольных проверок знаний по каждому студенту из учебной группы. 

Результаты текущего контроля служат основанием для прохождения студен-
том промежуточной аттестации. 

Итоговый контроль (зачет или экзамен) по информатике преследуют цель 
оценить работу студентов за курс, полученные теоретические знания, их проч-
ность, развитие творческого мышления, навыки самостоятельной работы, умение 
синтезировать полученные знания и применять их при решении практических за-
дач. Задания итогового контроля состоят из двух частей: письменного теоретиче-
ского опроса (от 6 до 12 вопросов) и практических заданий (от 1 до 3), выполняе-
мых на компьютере.  

Во время проведения итогового контроля (зачета или экзамена) студентам не 
разрешается пользоваться вспомогательными материалами Их использование, а 
также попытки общения с другими студентами или иными лицами, в т.ч. с приме-
нением электронных средств связи, перемещения без разрешения экзаменатора и 
т.д., являются основанием для удаления студента из аудитории с последующим 
выставлением в ведомость неудовлетворительной оценки. 

Критериями ОЗ - оценки знаний студента являются: 
• ТМ - уровень освоения теоретического материала, предусмотренного про-

граммой курса; 
• ПЗ - умение использовать теоретические знания при решении практиче-

ских задач; 
• СХ - социальные характеристики: посещаемость занятий;  корректное об-

щение с преподавателем; прилежание и трудолюбие; общая эрудиция; активность 
на занятиях; 

• ТК – результаты текущего контроля. 
Каждый критерий и итоговая оценка знаний студентов оценивается в баллах 

(«отлично», «хорошо», «удовлетворительно», «неудовлетворительно»). 
Итоговая оценка знаний студентов рассчитывается: 

ОЗ = 0,25*ТМ+0,25*ПЗ+0,1*СХ+0,4*ТК. 
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III. КОНСПЕКТЫ ЛЕКЦИЙ 
 

1 семестр – раздел «Математика» 
 

Тема. Множества. Числовые множества. 
1. Основные понятия и обозначения. 
Одним из важнейших понятий в математике является понятие «множест-

ва». Под множеством мы будем понимать совокупность некоторых объектов, 
объединенных по какому-либо признаку. Например: множество студентов ин-
ститута, множество геометрических фигур, множество всех натуральных чисел, 
множество корней уравнения x2+2x+2=0 и т.д. Множества состоят из элемен-
тов. Запись x∈М означает, что х является элементом множества М.  Говорят, 
что множество А является подмножеством множества М (запись: А ⊂  М), ес-
ли все элементы А являются элементами М.  

Пример 1: Дана некоторая совокупность предметов V={1, 2, 3,…, 11}. То-
гда А={1,2,4,6} и В={2,3,4,8,9} – подмножества. 

Рассмотрим четыре класса элементов: 
С0={5,7,10,11} – элементы, которые не обладают ни одним из названных 

свойств. 
С1={1,6} - элементы, обладающие только свойством А. 
C2={3,8,9} - элементы, обладающие только свойством В. 
C3={2,4} - элементы, которые обладают одновременно двумя названными 

свойствами. 
Эти классы удобно изображать с помощью кругов Эйлера - Вена. 

 
Множества А и В равны (запись: А=В), если они содержат одни и те же 

элементы (другими словами А ⊂  В и В ⊂  А). Пустое множество Ø не содер-
жит ни одного элемента и является подмножеством любого множества. 

2. Операции над множествами. 
Введем операции на множествах. 
Объединение А ∪  В состоит из элементов, которые принадлежат хотя бы 

одному из множеств А и В. Запись: А ∪  В={x / x∈ A или x∈ B}. 
Пересечение А ∩  В двух множеств А и В состоит из элементов, которые 

принадлежат обоим множествам А и В. Запись: А ∩  В={x / x∈ A и x∈ B}. 
Разность А\В состоит из элементов, которые принадлежат А, но не при-

надлежат В. Запись: А\В={ x / x∈ A,  x ∉  B }.  
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Симметричная разность А ∆ В состоит из элементов, которые принадле-
жат ровно одному из множеств А и В. Запись:  А ∆ В = (А\В) ∪  (В\А) 

Пример 2: Дано А={1,2,4,6}, B={2,3,4,8,9}.  
Объединение множеств:  А ∪  В={1,2,3,4,6,8,9}. 
Пересечение множеств:   А ∩  В={2,4}. 
Разность множеств:  А \ В={1,6}. 
Симметричная разность множеств: А ∆ В={1,8,9}.  
3. Числовые множества. 
Множества, элементами которых являются числа, называются числовыми 

множествами. Примерами числовых множеств являются: 
N={1;2;3;…;n;…} – множество натуральных чисел; 
Z0={0;1;2;…;n;…} – множество целых неотрицательных чисел; 
Z={0; ;...;...;2;1 n±±± } - множество целых чисел; 

Q={
n
m ; m Z∈ , n N∈ } - множество рациональных чисел; 

R – множество действительных чисел. 
Между этими множествами существует соотношение: 

RQZZN ⊂⊂⊂⊂ 0  
Пример 3: Дано: А – множество интегрируемых функций, 
    F – множество непрерывных функций, 
    S – множество дифференцируемых функций. 
Какие из следующих утверждений верны: 
1) А ⊂  F;  2) А I  S = S;  3) F U  S = А  4) S ⊂  F 

Решение: Из курса алгебры нам известно, что из дифференцируемости 
функции следует непрерывность, а из непрерывности – интегрируемость. Тогда 
множества А, F, S можно изобразить схематически. 

Тогда легко проверить утверждения: 
1) нет 
2) да 
3) нет 
4) да 
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Тема. Элементы линейной алгебры. 
1. Матрицы. 

Основные понятия 
Матрицей называется прямоугольная таблица чисел, содержащая m строк 

(или  n столбцов) одинаковой длины. Матрица записывается в виде:  

A=
⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

mnmm

n

n

aaa

aaa
aaa

...
............

...

...

21

22221

11211

   или, сокращенно, A=(aij), mi ,1= - номер строки,  

 nj ,1=  - номер столбца.  Матрицу А называют матрицей размера m×n.    
Числа aij, составляющие матрицу, называют ее элементами.   
Квадратной называется матрица, у которой   число строк равно числу 

столбцов. 
 Элементы, стоящие на диагонали, идущей из левого верхнего угла,  обра-

зуют главную диагональ квадратной матрицы.  Элементы, стоящие на диагона-
ли, идущей из левого нижнего угла,  образуют побочную диагональ.  

 Матрицы равны между собой, если равны все соответствующие элементы 
этих матриц, т.е. А=В, если aij= bij, где mi ,1= , nj ,1= . 

Диагональной называется квадратная матрица, у которой все элементы вне 
главной диагонали ( т.е. с индексами i≠ j) равны нулю. 

Единичной (Е) называется диагональная матрица, у которой каждый эле-
мент главной диагонали, равен единице. 

Нулевой называется матрица, все элементы которой  равны нулю.  
Матрица, содержащая один столбец или одну строку, называется векто-

ром (или вектор-столбец, или вектор-строка соответственно).   
Матрица, полученная из данной заменой каждой ее строки столбцом с тем 

же номером, называется транспонированной к данной. Обозначается АТ.  
Действия над матрицами. 

Определение 1.  Суммой двух матриц Аm×n= aij  и Bm×n= bij   называется 
матрица Cm×n= cij  такая, что cij= aij+ bij  ( mi ,1= , nj ,1= ). 

В общем виде:  

А22+В22= ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
++
++

=⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
+⎟⎟

⎠

⎞
⎜⎜
⎝

⎛

22222121

12121111

2221

1211

2221

1211

baba
baba

bb
bb

aa
aa

     

Замечание 1: операция сложение (вычитание) матриц вводится только для 
матриц одинаковых размеров.  

Пример 1:  А22+В22= ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ −
=⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
−

+⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ −
62
311

42
28

24
53

     

Аналогично определяется разность матриц. 

Пример 2:  А22-В22= ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−
−−

=⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

−⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ −
26
75

42
28

24
53

  

Определение 2. Произведение матрицы Аm×n= aij  на число k называется 
матрица Bm×n= bij   такая, что bij= k× aij,  где  ( mi ,1= , nj ,1= ).  



 18

В общем виде:  

k*А22 =k* ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
××
××

=⎟⎟
⎠

⎞
⎜⎜
⎝

⎛

2221

1211

2221

1211

akak
akak

aa
aa

     

Пример 3:  k×A22=4× ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ −
=⎟⎟

⎠

⎞
⎜⎜
⎝

⎛ −
816
1512

24
53

     

Определение 3.  Произведением матрицы Аm×n= aij  на матрицу Bn×p=bjk  
называется матрица  Cm×p= cik  такая, что cik =  ai1×b1k+ai2×b2k+…+ain×bnk , где 
( mi ,1= , nj ,1= ). 

В общем виде:  

А22×В22= ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
×+××+×
×+××+×

=⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
×⎟⎟
⎠

⎞
⎜⎜
⎝

⎛

2222122121221121

2212121121121111

2221

1211

2221

1211

babababa
babababa

bb
bb

aa
aa

    

Замечание 2: операция умножения двух матриц вводится только для слу-
чая, когда число столбцов первой матрицы равно числу строк второй матрицы.  

Пример 4: 

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
=

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−×+×+××+−×+×
−×−+×+××−+−×+×
−×+×−+××+−×−+×

=
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−×

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

−
⋅ =

1134
2722
436

)3(2114422)2(184
)3()3(12442)3()2(284
)3(11)5(4321)2()5(83

32
12
48

214
324

153

2222 BA      

Операции сложения и умножения матриц обладают следующими свойствами: 
1. А+В=В+А 
2. А+(В+С)=(А+В)+С 
3. А+О=А 
4. А-А=О 
5. 1×А=А 
6. k×(A+B)=k×A+k×B 

7. (k+t) ×A=k×A+t×A 
8. k×(t×A)=(k×t) ×A 
9. A×(B×C)=(A×B) ×C 
10. A×(B+C)=A×B+A×C 
11. (A+B) ×C=A×C+B×C 
12. k×(A×B)=(k×A) ×B  

2. Определители. 
Квадратной матрице  А порядка n можно сопоставить число det A (или A , 

или ∆), называемое ее определителем, следующим образом: 

Например: n=2,  A= ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛

2221

1211

aa
aa ;    det A=

2221

1211

aa
aa  

Определитель второго порядка вычисляется: 

det A=
2221

1211

aa
aa = 12212211 aaaa ×−×  

При вычислении определителя 3го  порядка удобно пользоваться правилом 
треугольников (или Саррюса). 

Определитель третьего порядка вычисляется по формуле: 

  122133112332132231322113312312332211

333231

232221

131211

det aaaaaaaaaaaaaaaaaa
aaa
aaa
aaa

A −−−++==  

Свойства определителей: 
Свойство 1. Определитель не изменяется, если его строки заменить соот-

ветствующими столбцами, и наоборот. 
Свойство 2. При перестановке двух соседних  строк (столбцов) определи-
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тель меняет знак. 
Свойство 3. Определитель, имеющий две одинаковых строки (или столб-

ца), равен нулю. 
Свойство 4. Общий множитель элементов какой-либо строки (или столб-

ца) определителя можно вынести за знак определителя. 
Свойство 5. Если элементы какой-либо строки (или столбца) определителя 

представляют собой сумму двух слагаемых, то определитель может быть раз-
ложен на сумму двух соответствующих определителей.  

Свойство 6. Определитель не изменится, если к элементам одной строки 
(или столбца) прибавить соответствующие элементы другой строки (или столб-
ца), умноженные на любое число.  

Пример 5.  Вычислить определитель: 
304
313

011

−
−

−
. 

Решение: 
I способ (правило Саррюса): 
∆=

09123)3(01)3()1(3014)3()1(4030)3(11
304
313

011
=−+−=−⋅⋅−−⋅−⋅−⋅⋅−−⋅−⋅+⋅⋅+−⋅⋅=

−
−

−
 

II способ. Зная свойства определителя видно, что  третья строка является 
суммой двух других. Поэтому определитель равен 0. 

3. Системы линейных уравнений. 
Системой линейных уравнений, содержащих m уравнений и n неизвест-

ных, называется    система вида: 

⎪
⎪
⎩

⎪
⎪
⎨

⎧

=+++

=+++
=+++

bmxaxaxa

bxaxaxa
bxaxaxa

nmnmm

nn

nn

...
.................................................

...
...

2211

22222121

11212111

, где числа aij ( mi ,1= , nj ,1= ) называются коэф-

фициентами системы, числа bi – свободными членами. 
Такую систему удобно записывать в матричной  форме: A×X=B, где 

А=
⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

mnmm

n

n

aaa

aaa
aaa

...
............

...

...

21

22221

11211

 - матрица коэффициентов системы, X=
⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

nx

x
x

...
2

1

-вектор-

столбец из неизвестных xj; B=
⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

mb

b
b

...
2

1

-вектор-столбец из свободных членов bi. 

1. Формулы Крамера 
Пусть дана система n линейных уравнений с n неизвестными  
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⎪
⎪
⎩

⎪
⎪
⎨

⎧

=+++

=+++
=+++

nnnnnn

nn

nn

bxaxaxa

bxaxaxa
bxaxaxa

...
.................................................

...
...

2211

22222121

11212111

 

Находим определитель матрицы А:  ∆ A=

nnnn

n

n

aaa

aaa
aaa

...
............

...

...

21

22221

11211

 и определители 

при каждой переменной: 

∆ x1=

nnnn

n

n

aab

aab
aab

...
............

...

...

2

2222

1121

 ,     ∆ x2=

nnnn

n

n

aba

aba
aba

...
............

...

...

1

2221

1111

 ,  …,    ∆ xn=

nnn baa

baa
baa

...
............

...

...

21

22221

11211

 

Так находим: x1= ∆
∆ 1x  , x2= ∆

∆ 2x  , … , xn= ∆
∆ nx  . 

Формулы xi=
∆
∆ ix   - называют формулами Крамера. 

2. Метод Гаусса 
Пусть дана система уравнений 

⎪
⎪
⎩

⎪
⎪
⎨

⎧

=+++

=+++
=+++

nnnnnn

nn

nn

bxaxaxa

bxaxaxa
bxaxaxa

...
.................................................

...
...

2211

22222121

11212111

 

Процесс решения по методу Гаусса состоит из двух этапов. На первом этапе 
составляется расширенная матрица системы, которая приводится к ступенчатому 
(треугольному) виду, используя элементарные преобразования.  На втором этапе 
идет последовательное определение неизвестных из этой ступенчатой системы.  

Пример 6: Решите систему уравнений 
⎩
⎨
⎧

=+
=−

73
,02

21

21

xx
xx     методом Крамера: 

 ∆ А= 7
31
12
=

− ≠0,   ∆1= 7
37
10
=

− ,  ∆2= 14
71
02
=  

Значит, x1= 1
7
7
= ,  x2= 2

7
14

=  

Пример 7. Решить систему уравнений методом Гаусса: 

⎪
⎩

⎪
⎨

⎧

=++
−=−+

=−−

32
32

032

zух
zух

zух
 

Решение: Составим расширенную матрицу системы 

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−−

−−

3121
3211

0132

M

M

M

  ~  
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−
−−
0132
3211

3121

M

M

M

 ~ 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−−
−−

6370
3211

3121

M

M

M

 ~ 
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Проводим эквивалентные преобразования со строками 

~ 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−−
−−−

6370
6310

3121

M

M

M

 ~  
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−−−
361800

6310
3121

M

M

M

 

Получим систему вида:  

⎪
⎩

⎪
⎨

⎧

=
−=−−

=++

3618
63

32

z
zу
zух

   

Отсюда  находим неизвестные  
⎪
⎩

⎪
⎨

⎧

=
=
=

1
0
2

x
у
z

 

Пример 8.  Вычислить: А · В – 2Е, если   А = 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

124
131
201

     В = 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

753
102
113

 

Решение: 
По правилу умножения матриц 

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

124
131
201

 ·  
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

753
102
113

 = 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

13911
646

15119
 

Е – обозначает единичную матрицу, т.е.   квадратную матрицу, у которой 
по главной диагонали находятся единицы, а остальные элементы – нули.  

Подберем размер Е так, чтобы вычитание стало возможно. 

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

13911
646

15119
 -2 

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

100
010
001

 = 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

11911
626

15117
 

Тема. Аналитическая геометрия на плоскости. 
1. Основные понятия. 
Под системой координат на плоскости понимают способ, позволяющий 

численно описать положение точки плоскости. Одной из таких систем является 
прямоугольная (декартова) система координат. 

Прямоугольная система координат задается двумя взаимно перпендику-
лярными прямыми – осью абсцисс (осью Оx) и осью ординат (осью Оy), еди-
ничным отрезком и точкой пересечения координат О – начало координат. Ко-
ординаты точки записывают М(x;y), где число x – называется абсциссой точки, 
а число y – ординатой точки. 

Полярная система координат задается точкой 
О, называемая полюсом, лучом Ор, называемым 
полярной осью, и единичным вектором er . Коор-
динаты точки в полярной системе координат запи-
сывают М(r;φ), где r – полярный радиус, φ – поляр-
ный угол. 
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Прямоугольные координаты точки можно выразить через полярные: 

⎩
⎨
⎧

⋅=
⋅=

ϕ
ϕ

sin
,cos

ry
rx . 

Полярные координаты точки можно выразить через прямоугольные: 

⎪
⎩

⎪
⎨

⎧

=

+=

x
ytg

yxr

ϕ

,22

. 

Определяя величину φ, следует установить (по знакам x и y) четверть, в кото-
рой лежит искомый угол, и учитывать, что π− <φ π≤ .  

2. Уравнения прямой на плоскости. 

  1)   Общее уравнение прямой Ax+By+C=0, где А, В, С – произвольные числа. 
Некоторые частные случаи общего уравнения прямой: 

а) если А=0, то уравнение приводится к виду 
B
Cy −= . Это есть уравнение 

прямой, параллельной оси Ох; 
b) если В=0, то уравнение приводится к виду 

A
Cx −= . Это есть уравнение 

прямой, параллельной оси Оy; 
c) если C=0, то уравнение приводится к виду Ax+By=0. Прямая проходит че-

рез начало координат. 
  2) Уравнение прямой с угловым коэффициентом име-

ет вид: y=kx+b, где k=tgα – угловой коэффициент прямой, а 
угол α – это угол между положительным направлением оси 
Ох и прямой NM. 

Некоторые частные случаи  уравнения прямой с угло-
вым коэффициентом: 

a) если прямая проходит через начало координат, то b=0 и уравнение примет 
вид: y=kx; 

b) если прямая параллельна оси Ох, то k=0 и уравнение примет вид: y=b; 
c) если прямая параллельна оси Оy, то k не существует и уравнение примет 

вид: x=а, где а – абсцисса точки пересечения прямой с осью Ох. 
3)Уравнение прямой, проходящей через данную точку М(x0;y0)  в данном на-

правлении имеет вид: y-y0=k(x-x0). 
4)Уравнение прямой, проходящей через две точки М1(x1;y1) и М2(x2;y2) имеет 

вид: 
12

1

12

1

xx
xx

yy
yy

−
−

=
−
− . 

Если x2=x1, то прямая параллельна оси Оу. Ее уравнение имеет вид x=x1. 
Если y2=y1, то прямая параллельна оси Оx. Ее уравнение имеет вид y=y1. 
5)Уравнение прямой в отрезках имеет вид: 1=+

b
y

a
x , где 

прямая пересекает ось Ох в точке М1(а;0), а ось Оу – в точке 
М2(0;b).   

6)Уравнение прямой, проходящей через данную точку 
М(x0;y0) перпендикулярно данному вектору );( BAn =  имеет 
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вид A(x-x0)+B(y-y0)=0, где М(x;y) – произвольная точка на прямой. 
3. Основные задачи. 
Расстояние между двумя точками М1(x1;y1) и М2(x2;y2) находится 

2
12

2
12 )()( yyxxd −+−= . 

Деление отрезка, соединяющего точки  М1(x1;y1) и М2(x2;y2) точкой 

);( 000 yxМ ,  в заданном отношении λ 1−≠  находится, 
λ
λ

+
+

=
1

21
0

yy
y  и 

λ
λ

+
+

=
1

21
0

xx
x . 

Частный случай: деление отрезка пополам находится: 
2

21
0

xx
x

+
= , 

2
21

0
yy

y
+

= . 

Площадь треугольника ∆S , проходящего через вершины А(x1;y1), В(x2;y2) и 

С(x3;y3) находится 
1213

1213

2
1

yyyy
xxxx

S
−−
−−

⋅=∆ .    

Угол между двумя прямыми и условия параллельности и перпендикулярно-
сти двух прямых: если прямые L1 и L2 заданы уравнениями с угловыми коэф-
фициентами y=k1x+b1 и y=k2x+b2, то угол между прямыми находится                

21

12

1 kk
kk

tg
⋅+

−
=ϕ ; 

− если прямые параллельны, то φ=0, а значит k2=k1. 
− если прямые перпендикулярны, то φ=

2
π , а значит 121 −=⋅ kk . 

Расстояние от точки  М(x0;y0) до прямой L: Ax+By+C=0 находится  

22

00

BA

CByAx
d

+

++
= . 

4. Линии второго порядка на плоскости. 

Окружностью радиуса с центром в точке М0 назы-
вается множество всех точек М плоскости, удовлетво-
ряющих условию М0М=R.  

Уравнение окружности: ( ) 22
0

2
0 )( Ryyxx =−+− . 

Если центр окружности совпадает с началом коор-
динат О(0;0), то уравнение примет вид 222 Ryx =+ . 

Эллипсом называется множество всех точек плоско-
сти, сумма расстояний от каждой из которых до двух данных точек этой плоско-
сти, называемых фокусами, есть величина постоян-
ная, большая, чем расстояние между фокусами. Кано-

ническое уравнение: 1
)()(

2

2
0

2

2
0 =

−
+

−
b

yy
a

xx , где  а – 

большая полуось, b- малая полуось. Если центр эл-
липса совпадает с началом координат О(0;0), то урав-

нение примет вид 12

2

2

2

=+
b
y

a
x . 
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Гиперболой называется множество всех точек плоскости, модуль разности 
расстояний от каждой из которых до двух данных точек этой плоскости, назы-
ваемых фокусами, есть величина посто-
янная, меньшая, чем расстояние между 
фокусами.  

Каноническое уравнение: 

1
)()(

2

2
0

2

2
0 =

−
−

−
b

yy
a

xx , где  а – действи-

тельная полуось, b- мнимая полуось.  
Если центр гиперболы совпадает с 

началом координат О(0;0), то уравнение 

примет вид 12

2

2

2

=−
b
y

a
x . 

Асимптотами гиперболы являются диагонали основного прямоугольника, 
которые определяются уравнениями: x

a
by ±= . 

Параболой называется множество всех точек 
плоскости, каждая из которых равноудалена от за-
данной точки этой же плоскости, называемой фоку-
сом, и заданной прямой, называемой директрисой. 

Каноническое уравнение имеет вид: y2=2px, где 
число р>0, равное расстоянию от фокуса F до ди-
ректрисы l, называется параметром параболы.  

Пример 1: Найти вершину, фокус и директри-
су параболы 582 2 −+−= xxy , построить эскиз графика. 

Решение: преобразуем уравнение, выделив в правой части полный квадрат:  
3)2(2)

2
3)2((2)

2
5444(2)

2
54(2 2222 +−−=−−−=−−+−−=+−−= xxxxxxy ,  

т.е. y=-2(x-2)2+3 или ).3(
2
1)2( 2 −−=− yx  Так как  0<p , то ветви параболы сона-

правлены с отрицательным направлением оси Oу.   
Вершина параболы имеет координаты (2;3); 2р=

2
1 , 

тогда р=
4
1 .  

Координаты фокуса х=2, y=3-
8
1 =2

8
7 , т.е. F(2;

8
72 ). 

Уравнение директрисы 
8
13

8
13

2
3 =+=+=

py . 

График изображен на рисунке.  
 Пример 2:  Даны координаты вершин треуголь-

ника АВС. 
А (-1; 3);  В (1; 0);  С (5; 4).  Найти уравнение медианы, проведенной из т.А. 

Сделать чертеж. 
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Решение: Начнем с чертежа. Медиана – это линия, соединяющая вершину с 
серединой противоположной стороны. 

Найдем М – середину ВС. 

           х  = 
2

51 +  = 3;    у  = 
2

40 +  = 2;  М (3; 2) 

Уравнение АМ – уравнение прямой, проходящей через 2 точки. 

31
1

−−
+х  = 

23
3

−
−у  ;      у = 

4
1

−
+х  + 3;     у = х

4
1

−  + 
4

11 . 

Уравнение медианы АМ:   у = -0,25 · х + 2,75 
Тема. Начала математического анализа. 

1. Функция одного действительного переменного. 
Пусть из множества действительных чисел 

выделены подмножества X  и  Y. Причем каж-
дому элементу множества  X поставлен в соот-
ветствии единственный, определенный элемент 
множества  Y. Тогда говорят, что на множестве  
X задана функция, отображающая X  в  Y. 

)(xfyилиYX f =⎯→⎯  
Графиком функции )(xfy =    называется 

множество всех точек плоскости Оxy, для каждой из которых х является значе-
нием ордината, а у – соответствующим значением функции. 

Определение  1: Число A  называется пределом функции  )(xf  в точке 0x , 
если для любого сколь угодно малого положительного числа  ε  найдется число 

0>δ  такое, что, как только δ<− 0xx , то ε<− Axf )( . 
Обозначение: Axf

xx
=

→
)(lim

0

. 

Понятие предела является важнейшим в теории функции.  На нем основа-
ны такие понятия как непрерывности и дифференцируемости.  

Определение  2: Функция )(xfy =  называется непрерывной в точке  0x , 
если   )()(lim 0

0

xfxf
xx

=
→

 

Определение  3: Функция непрерывна на числовом промежутке, если она 
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непрерывна в каждой точке этого промежутка. 
Основные правила нахождения пределов 

1. )(lim)(lim))()((lim
000

xxfxxf
xxxxxx
ϕϕ

→→→
±=±  

2. )(lim)(lim))()((lim
000

xxfxxf
xxxxxx
ϕϕ

→→→
⋅=⋅  

3. constCCC
xx

==
→

,lim
0

 

4. )(lim)(lim
00

xfCxfC
xxxx →→

⋅=⋅  

5. 0)(lim,
)(lim

)(lim

)(
)(lim

0

0

0

0

≠=
→

→

→

→
x

x

xf

x
xf

xx
xx

xx

xx
ϕ

ϕϕ
 

2. Методы вычисления пределов. 
1. Непосредственное вычисление - предел вычисляется непосредственной 

подстановкой  ( )()(lim 0
0

xfxf
xx

=
→

). 

Пример 1. 
2
1

24
32lim

1
−=

−
−

→ x
x

x
 

2. Пределы вида ⎥⎦
⎤

⎢⎣
⎡=

→ 0
0

)(
)(

lim
0 xQ

xP

m

n

xx
 вычисляются  разложением числителя и 

знаменателя на множители. После сокращения выражения  ( 0xx − ) предел пре-
образуется и может быть вычислен непосредственной подстановкой. 

Пример 2. 0
2

0
4
2lim

)4)(2(
)2)(2(lim

86
44lim

222

2

2
=

−
=

−
−

=
−−
−−

=
+−
+−

→→→ x
x

xx
xx

xx
xx

xxx
 

3. Пределы вида ⎥⎦
⎤

⎢⎣
⎡
∞
∞

=
∞→ )(

)(
lim

xQ
xP

m

n

x
 вычисляются по схеме 

⎪
⎪
⎩

⎪
⎪
⎨

⎧

>∞

−=

<

язнаменателстепенибольшечислителястепеньmnесли

коэфстаршиеbaязнаменателстепениравначислителястепеньmnесли
b
a

язнаменателстепенименьшечислителястепеньmnесли

,

.),(,

,0

00
0

0

 
Пример 3. равныстепенистаршиекактак

xx
xx

x
,

3
2

6
4

236
124lim 23

23

==
−−
+−

∞→
 

4. Пределы, содержащие иррациональность, преобразуются к одному из 
описанных видов путем  умножения числителя и знаменателя на сопряженное 
выражение. 

Пример 4. 
( )( )

( ) 4
1

24
1lim

)24(
44lim

24
2424lim24lim

0000
=

++
=

++
−+

=
++

++−+
=

−+
→→→→ xxx

x
xx

xx
x

x
xxxx

 

5. При вычислении пределов выражений, содержащих тригонометриче-
ские функции, часто используют предел  1sinlim

0
=

→ x
x

x
 - называемый  первым за-

мечательным  пределом. 

Пример 5. 
2
3

62
6sin3lim

0
0

4
6sinlim

00
=

⋅
=⎥⎦

⎤
⎢⎣
⎡=

→→ x
x

x
x

xx
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6.  Неопределенность вида [ ]∞1  раскрывается с помощью второго замеча-

тельного предела.    ( ) eиe
n

n

n
=+=⎟

⎠
⎞

⎜
⎝
⎛ +

→∞→
λ

λ
λ

1

0
1lim11lim  

Пример 6. [ ] 3
33

1
3

lim11lim111lim ee
xx

x
x

x

x
xx

x

x

x
==⎟

⎟
⎠

⎞
⎜
⎜
⎝

⎛
⎟
⎠
⎞

⎜
⎝
⎛ +==⎟

⎠
⎞

⎜
⎝
⎛ +

∞→∞→

∞

∞→
 

Пример 7. ( ) [ ] ( ) 5
5

0

15

5
1

0

1

0
lim51lim151lim eexx x

x

x

x
x

x
x

x
x

==⎟
⎠
⎞

⎜
⎝
⎛ +==+

→→

∞

→
 

7. С помощью эквивалентных функций, приведенных в таблице: 
sin x ~ x при х→0 ex-1 ~ x (х→0) 
tg x ~ x (х→0) ax-1 ~ x aln⋅  (х→0) 
arcsin x ~ x (х→0) ln(1+x)  ~x (х→0) 
arctg x  ~ x (х→0) loga(1+x) ~ x ealog⋅  (х→0) 

1-cos x  ~
2

2x  (х→0) 
(1+x)k-1 ~ xk ⋅ , k>0 (х→0) 

 Пример 8. Найти 
x
xtg

x 3sin
2lim

0→
. 

Так как tg 2x~ 2x, sin 3x ~3x при х→0, то 
3
2

3
2lim

3sin
2lim

00
==

→→ x
x

x
xtg

xx
. 

Тема. Дифференциальное исчисление функции одного действительно-
го переменного. 

1. Производная. 
Если в точке или на промежутке  для функции выполнены условия непре-

рывности, то можно ввести понятие  дифференцируемости. 
Определение: Производной функции )(xfy =  в точке 0x  называется предел 

отношения приращения функции к приращению аргумента, когда приращение 

аргумента стремится к 0.  Т.е. f′(x0)=
0

0 )()(
lim

0 xx
xfxf

xx −
−

→
. 

 Функция )(xfy = , имеющая производную в каждой точке интервала (a;b), 
называется дифференцируемой. Нахождение производной называется диффе-
ренцированием функции. 

Основные правила дифференцирования 
Пусть С - постоянная, )(),( xvvxuu ==  - функции имеющие производные. 

Тогда: 
1) 0=′С  
2) 1=′x  
3) ( ) vuvu ′±′=±  
4) ( ) uCCu ′=′  
5) ( ) vuvuuv ′+′=′  

6) 2v
vuvu

v
u ′−′

=
′
⎟
⎠
⎞

⎜
⎝
⎛
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Формулы дифференцирования основных функций   
1.  ( ) 1−=

′ mm mxx     8.   ( )
x

tgx 2cos
1

=′  

  2.  ( )
x

x
2

1
=

′
     9.  ( )

x
ctgx 2sin

1
−=′  

  3.  2

11
xx

−=
′
⎟
⎠
⎞

⎜
⎝
⎛    10.  ( )

21
1arcsin

x
x

−
=′  

  4.  ( ) xx ee =
′    11.  ( )

21
1arccos

x
x

−
−=′  

  5.  ( ) aaa xx ln=
′    12.  ( ) 21

1
x

arctgx
+

=′  

  6.  ( ) xx cossin =′    13.  ( ) 21
1
x

arcctgx
+

−=′  

  7.  ( ) xx sincos −=′    14.  ( )
ax

xa ln
1log =′  

Пример 1. Найти производную функции  123 34 −+−= xxxy  
Решение: 

( ) ( ) ( ) ( ) ( ) ( ) 2940234123)123( 23333434 +−=−′+
′

−=′−′+
′

−
′

=′−+−=′ xxxxxxxxxxxy  
Пример 2. Найти производную функции  )26( −= xtgy  

Решение: 
)26(cos

6)26(
)26(cos

1))26(( 22 −
=′−

−
=′−=′

x
x

x
xtgy  

2. Геометрический смысл производной 
Пусть функция ( )xfy =   имеет производ-

ную в точке 0x . Тогда существует касательная 
к графику этой функции в точке ( )000 ; yxM , 
уравнение которой имеет вид 

( )( )000 xxxfyy −′=− . При этом 
( ) −=′ αα гдеtgxf ,0 угол между положитель-

ным направлением оси Ох и касательной к 
оси Ox . 

Прямая,  проходящая через точку касания,  перпендикулярно касательной, 
называется нормалью к кривой и имеет уравнение              

( ) ( )0
0

0
1 xx
xf

yy −⋅
′

−=− .  

Если  ( ) 00 =′ xf (т.е. касательная горизонтальна), то нормаль вертикальна и 
имеет уравнение 0xx = . 

Пусть даны две пересекающиеся в точке ( )000 ; yxM  кривые ( )xfy 1=  и   
( )xfy 2= , причем обе функции имеют производные в точке  0x . Тогда углом ме-

жду этими кривыми называется угол между касательными к ним, проведенны-

ми в точке 0M . Угол находится по формуле: ( ) ( )
( ) ( )0201

0102

1 xfxf
xfxf

tg
′⋅′+
′−′

=ϕ . 
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Пример 3. Составить уравнение касательной и нормали к графику функ-
ции 

32
3
−
−

=
x

xy в точке с абсциссой 20 =x . 

Решение: Вычислим значение функции в точке 20 =x ; 1
322

23
0 =

−⋅
−

=y .  

Производная функции 
( ) ( ) ( ) ( )

( )
( )

( ) ( )222 32
3

32
)3(2321

32
323323

32
3

−
−

=
−

−⋅−−⋅−
=

−

′−⋅−−−⋅′−
=

′
⎟
⎠
⎞

⎜
⎝
⎛

−
−

=′
xx

xx
x

xxxx
x

xy . 

Значение производной в точке 20 =x : ( )
( )

3
322

32 2 −=
−⋅

−
=′y . 

Уравнение касательной имеет вид: 
( )( )000 xxxfyy −′=− ( ) 073231 =−+−⋅−=−⇒ xyилиxy . 

Уравнение нормали: ( ) ( )0
0

0
1 xx
xf

yy −⋅
′

−=− ( ) 0132
3
11 =−−⇒−=−⇒ xyxy . 

Производная используется для исследования функции. 
Функция  )(xf  называется  возрастающей на интервале ),( ba ,  если для 

любых двух точек 1x  и 2x  из указанного интервала, удовлетворяющих неравен-
ству 21 xx < , выполняется неравенство ( )21 )( xfxf < . 

Функция  )(xf  называется  убывающей  на интервале ),( ba ,  если для лю-
бых двух точек 1x  и 2x  из указанного интервала, удовлетворяющих неравенству 

21 xx < , выполняется неравенство ( )21 )( xfxf > . 
Признаки возрастания и убывания функции.  
1) Если 0)( 0 >′ xf , то функция )(xf  возрастает в точке  0x . 
2) Если 0)( 0 <′ xf , то функция )(xf  убывает  в точке  0x . 
Определение: Точка х0 называется точкой максимума функции y=f(x), ес-

ли существует такая δ – окрестность точки х0, что для всех х≠х0 из этой окрест-
ности выполняется неравенство f(x)<f(x0). 

Определение: Точка х0 называется точкой минимума функции y=f(x), если 
существует такая δ – окрестность точки х0, что для всех х≠х0 из этой окрестно-
сти выполняется неравенство f(x)>f(x0). 

 Максимум или минимум функции  называется экстремумом функции.  
Точка максимума или минимума функции называется точкой ее экстремума. 

Необходимое условие экстремума.  Если функция )(xf  в точке 0x , имеет 
экстремум,  то ( ) 00 =′ xf , либо не существует. 

Точки, в которых  ( ) 0=′ xf  или ( )xf ′  не существует, называются критиче-
скими точками. Точка 0x ,  в которой ( ) 00 =′ xf  называется стационарной точкой.  
Не всякая критическая точка является точкой экстремума. 

Достаточные условия экстремума.  
1) Пусть функция )(xf  непрерывна в точке 0x , и дифференцируема в неко-

торой ее окрестности. Тогда, если  ( )xf ′  меняет знак при переходе через точку 

0x , то 0x  - точка экстремума (если с «+» на  «-» - максимум, если же с «-» на 
«+» - минимум). 
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2) Пусть функция )(xf  имеет  в точке 0x  производные первого и второго 
порядка. Тогда, если  ( ) 0=′ xf ,  ( ) 0≠′′ xf , то 0x - точка экстремума. В частности, 
если ( ) 0=′ xf , ( ) 0<′′ xf , то 0x  - точка максимума, а  если ( ) 0=′ xf , ( ) 0>′′ xf , то 

0x  - точка минимума.  
Для нахождения наибольшего (наименьшего) значения функции  на отрез-

ке [ ]ba,  нужно из значений  функции на границах отрезка и в критических точ-
ках, принадлежащих этому отрезку, выбрать наибольшее (наименьшее). 

 Определение: График   дифференцируемой функции  
( )xfy =  называется выпуклым на  интервале ( )ba, ,  если он 

расположен ниже касательной, проведенной в любой  точке 
этого интервала. 

Определение: График дифференцируемой функции  
( )xfy =  называется вогнутым  на  интервале ( )ba, , если он 

расположен выше касательной, проведенной в любой точке 
этого интервала. 

 Если при переходе через точку x0 функция меняет на-
правление выпуклости, то эта точка называется точкой пере-
гиба.  

                                                 
Теорема.  Если функция  ( )xfy =  во всех точках интервала  ( )ba,  имеет от-

рицательную вторую производную, т.е.  ( ) 0<′′ xf , то график функции является 
выпуклым в этом интервале. Если же  ( ) 0>′′ xf  для любого ( )bax ,∈  - график 
функции вогнутый. 

Теорема (достаточное условие существования точек перегиба). Если 
вторая производная ( )xf ′′  при переходе через точку 0x , в которой она равна 
нулю или не существует, меняет знак, то точка графика с абсциссой 0x  есть 
точка перегиба.  

Построение графиков функции. 
1) Найти область определения функции. 
2) Исследовать функцию на четность, нечетность. 
3) Найти точки пересечения графика функции с осями координат. 
4) Найти интервалы возрастания и убывания функции  и  ее экстремумы. 
5) Найти интервалы выпуклости и вогнутости кривой и точки ее перегиба. 
6) Построить график. 
Пример. Построить с исследованием график функции ( ) 32 24 ++−= xxxy   
Решение: ( ) 32 24 ++−= xxxy  
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1) D(y)=R 
2) ( ) 32 24 ++−=− xxxy -четная функция. 
3) xxy 44 3 +−=′ ⇒ 044 3 =+− xx ⇒ 0)1)(1(4 =+−− xxx  
 Критические точки:0;1;-1. 

x  1−<<∞− x  -1 01 <<− x  0 1−<<∞− x 1 1−<<∞− x
( )xy′  + 0 - 0 + 0 - 

( )xy   4 
 

3 4 
 

  max  min  max  
( ) 41max =−= yy ; ( ) 41max == yy ; ( ) 30min == yy  

4) 412)44( 23 +−=′+−=′′ xxxy 0
3

1
3

1120412 2 =⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
+⋅⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
−−⇒=+−⇒ xxx  

  
3

1
1 =x ; 

3
1

2 −=x  

x 
3

1
−<<∞− x  

3
1

−  
3

1
3

1
<<− x  

3
1  ∞<< x

3
1  

)(xy ′′  -  +  - 
y(x) ∩  

9
22  ∪  

9
22  ∩  

  Точка 
перегиба

 Точка 
перегиба

 

5) Построение  графика. 
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Тема. Основы теории вероятности. 

1.  Элементы комбинаторики. 
Комбинаторика происходит от латинского слова «combinatio» — соедине-

ние. Группы, составленные из каких-либо предметов (безразлично каких, на-
пример, букв, цветных шаров, кубиков, чисел и т. п.), называются соеди-
нениями (комбинациями). Предметы, из которых состоят соединения, называ-
ются элементами. 
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Различают три типа соединений: размещения, перестановки и сочетания. 
Размещениями из п элементов по т в каждом называются такие соедине-

ния, из которых каждое содержит т элементов, взятых из числа данных n эле-
ментов, и которые отличаются друг от друга либо самими элементами (хотя бы 
одним), либо лишь порядком их расположения. 

)!(
!
mn

nm
n −
=Α

 
Понятие факториала: Произведение п натуральных чисел от 1 до n обо-

значается сокращенно п!, т. е. 1·2·3·...·(n -1)·n= n! (читается: п факториал). На-
пример: 

5!=1·2·3·4·5=120. 
Считается, что 0! = 1, 1!=1. 
Очевидно, что Аn

1= п (при m = 1) и Аn
0=n (при m= 0). 

Пример 1. 
Сколькими способами 4 юноши могут пригласить четырех из шести 

девушек на танец? 
Решение: 
Два юноши не могут одновременно пригласить одну и ту же девушку. 

И варианты, при которых одни и те же девушки танцуют,  с  разными 
юношами считаются, разными, поэтому: 

360
2

720
)!46(

!64
6 ==

−
=Α

  
Возможно 360 вариантов. 
Сочетаниями из п элементов по m в каждом называются такие соедине-

ния, из которых каждое содержит т элементов, взятых из числа данных п эле-
ментов, и которые отличаются друг от друга по крайней мере одним элементом. 

Число сочетаний из п элементов по m в каждом обозначается символом Cn
m 

и вычисляется так: 

!)!(
!

mmn
nC m

n

m
nm

n −
=

Ρ
Α

=  

Пример 2.  Правление коммерческого банка выбирает из 10 кандида-
тов 3 человек на одинаковые должности (все 10 кандидатов имеют равные 
шансы). Сколько всевозможных групп по 3 человека можно составить из 
10 кандидатов? 

Решение: 
Состав различных групп должен отличаться, по крайней мере, хотя бы од-

ним кандидатом и порядок выбора кандидата не имеет значения, сле-
довательно, этот вид соединений представляет собой сочетания. По условию 
задачи  п = 10,  

т = 3.  Получаем     
                       120

!7!3
!103

10 =
⋅

=С    

Можно составить 120 групп из 3 человек по 10. 
Перестановками из п элементов называются такие соединения, из кото-
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рых каждое содержит все п элементов и которые отличаются друг от друга 
лишь порядком расположения элементов. 

!nРn =  
Пример 3.  Студент ежедневно просматривает 6 журналов. Если порядок 

просмотра журналов случаен то, сколько существует способов его осуществле-
ния? 

Решение: 
Способы просмотра журналов различаются только порядком, так как чис-

ло, а значит, и состав журналов при каждом способе неизменны. Сле-
довательно, при решении этой задачи необходимо рассчитать число перестано-
вок. 

По условию задачи  п = 6. Следовательно, 
Рn  = 6! =1·2·3·4·5·6 = 720. 
Можно просмотреть журналы 720 способами. 
 2. Элементы теории вероятности. 

Основные понятия. Определение вероятности. 
Теория вероятностей – это наука о случайных событиях. Случайными на-

зываются события, которые могут произойти или не произойти в результате не-
которого испытания.  

Испытание (опыт, эксперимент) — это процесс, включающий опреде-
ленные условия и приводящий к одному из нескольких возможных исходов. 
Исходом опыта может быть результат наблюдения или событие. 

Например, испытание – бросание игральной кости, случайное событие – 
выпадение четверки. 

Каждому случайному событию А можно поставить в соответствие число 
Р(А), которое назовем вероятностью. 

Достоверным называется событие, которое обязательно произойдет в ре-
зультате испытания. 

 Например, если в урне содержатся только белые шары, то извлечение из 
нее белого шара есть событие достоверное. 

Невозможным называется событие, которое не может произойти в резуль-
тате данного испытания. 

Например, извлечение черного шара из урны с белыми шарами есть собы-
тие невозможное.  

Достоверные и невозможные события, вообще говоря, не являются слу-
чайными. 

Несколько событий называются совместными, если в результате экспери-
мента наступление одного из них не исключает появления других. 

Например, при бросании 3 монет выпадение цифры на одной не исключа-
ет появления цифр на других монетах. 

Несколько событий называются несовместными в данном опыте, если по-
явление одного из них исключает появление других.  

Например, брошена монета, появление «герба» исключает появление 
«решки». 

Несколько событий называются равновозможными, если в результате ис-
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пытания ни одно из них не имеет объективно большую возможность появления, 
чем другие. Например, при бросании игральной кости появление каждой из ее 
граней — события равновозможные. 

Два события  А  и  А  называются противоположными, если в данном ис-
пытании они несовместны и одно из них обязательно произойдет. 

Например, монету бросают один раз. Событие А – выпадение «герба», со-
бытие   А  - выпадение «решки». События А и  А  противоположны.  

Два события называются независимыми, если вероятность одного из них 
не зависит от появления или не появления другого, в противном случае  назы-
ваются зависимыми. 

Например, бросают две игральные кости. Событие А – появление «двойки» 
на первой кости. Событие В – появление «двойки» на второй  кости. Тогда со-
бытия А и В независимы.  

 3. Классическое определение вероятности. 
Вероятностью появления события А называют отношение числа исхо-

дов, благоприятствующих наступлению этого события, к общему числу всех 
единственно возможных и несовместных элементарных исходов. 

Обозначим число благоприятствующих событию А исходов через m, а 
число всех исходов — n: 

n
mAP =)( . 

Замечание: 0≤P(A)≤1. 
Пример 4. Абонент, набирая номер, забыл последние 3 цифры. Помня 

лишь то, что они различны, набирает их на удачу. Какова вероятность угадать 
номер. 

Решение: 
Число различных трехзначных номеров с неповторяющимися цифрами 

равно 3
10А . Из них верным является только один вариант. По формуле классиче-

ской вероятности Р(А) = 
n
m     m = 1  n= 3

10А , 
)!310(

10!
3
10 −
= ⋅А  = 720     Р(А) = 

720
1 . 

Пример 5.  В урне 12 шаров: 3 белых, 4 черных и 5 красных. Какова веро-
ятность вынуть из урны черный шар? 

Решение: 
A - вынули черный шар.   n=12;   m=4 ( )

3
1

12
4
==⇒ AP .  

4. Теоремы сложения и умножения вероятностей.. 
Сумма двух событий А и В (А+В) есть событие, состоящее в появлении 

хотя бы одного из событий А или В. 
Произведением двух событий А и В ( ВА ⋅ ) есть событие, состоящее в од-

новременном появлении событий А и В. 
Теорема сложения вероятностей. 
1. Вероятность суммы двух несовместных событий А и В равно сумме ве-

роятностей этих событий:  Р(А+В)=Р(А) + Р(В). 
2. Вероятность суммы двух совместных событий А и В равно сумме веро-
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ятностей этих событий без вероятности их произведения:  Р(А+В)=Р(А) + Р(В) 
– Р( ВА ⋅ ). 

Теорема умножения  вероятностей. 
1.Вероятность  произведения двух независимых событий А и В равна про-

изведению вероятностей этих событий: то Р( ВА ⋅ )= )()( ВРАР ⋅ . 
2.Вероятность произведения двух зависимых событий А и В равна произ-

ведению одного из них на условную вероятность другого, найденную в предпо-
ложении, что первое уже наступило:  Р( ВА ⋅ )= )()()()( АРВРВРАР ВА ⋅=⋅ . 

Следствия: 
1.  )(1)( АРАР −= , (вероятность противоположного события). 
2. Сумма вероятностей событий nААА ,..,, 21  образующих полную группу 

равна   единице:  ( 1)(...)()( 21 =+++ nАРАРАР ). 
Пример 6. Опыт состоит в случайном извлечении карты из колоды в 52 

карты. Чему равна вероятность того, что это будет или туз, или карта масти 
треф? 

Решение: 
Определим события: А — «Извлечение туза», В — «Извлечение карты 

трефовой масти». Вероятность извлечения туза из колоды карт Р(А) = 4/52; ве-
роятность извлечения карты трефовой масти — Р(В) = 13/52; вероятность их 
пересечения — извлечение трефового туза - Р(АВ) = 1/52. 

События  А и В — совместные, поскольку в колоде есть трефовый туз. 
Вероятность суммы совместных событий  А  и  В:   
Р(А + В) = Р(А) + Р(В) - Р(АВ) = 4/52 + 13/52 - 1/52 = 16/52 = 4/13. 
Пример 7.  В урне 2 белых и 7 черных шаров. Из нее последовательно вы-

нимают 2 шара. Какова вероятность того,  что 2-й шар окажется белым при ус-
ловии, что первый шар был черным? 

Решение: 
Событие А-1-й шар черный, 
Событие В- 2-й шар белый. 
События А и В совместные, зависимые.  

8
2)(,

9
7)( == ВРAP А ;   ( ) ( )

36
7

8
2

9
7)()( =⋅=⋅⇒⋅=⋅ BAPВРАРBAP А .  

Пример 8. Одна карта вынимается из колоды игральных карт (52). Какова 
вероятность того, что это будет карта валет или дама? 

Решение: 
Событие А - карта валет; 
Событие В – карта дама. 
( )

52
4

=AP , ( )
52
4

=BP . 

События А и В - несовместные ( ) ( ) ( )
13
2

52
8

52
4

52
4

==+=+=+⇒ BPAPBAP . 

Пример 9.  В первом ящике 2 белых и  10 черных шаров, во втором ящике 
8 белых и 4 черных шара. Из каждого ящика вынули по шару. Какова вероят-
ность того, что оба шара белые. 
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Решение: 
Событие А - появление белого шара в 1-м ящике; 
Событие В - появление белого шара в 2-м ящике. 
События А и В – совместные, независимые. 
( )

6
1

12
2
==AP ;   ( )

3
2

12
8
==BP  ( ) ( ) ( )

9
1

3
2

6
1

=⋅=⋅=⋅⇒ BPAPBAP . 

Теорема. Вероятность появления хотя бы одного из событий nAAA ...,,, 21  
независимых в совокупности, вычисляется по формуле: 

( ) ( ) ( ) ( )nn APAPAPAAAP ⋅⋅⋅−= ...1...,,, 2121 . 
Пример 10. Вероятность того, что студент сдаст первый экзамен, равна 

0,9; второй – 0,8; третий -0,6. Найти вероятность того, что студентом  будут 
сданы:  

a) только второй экзамен; 
b) только один экзамен; 
c) хотя бы один. 
Решение: 
а) Обозначим события: А1-студент сдаст 1-ый экзамен; А2-студент сдаст 2-

ый экзамен; А3-студент сдаст 3-ый экзамен.  
( ) ( ) ( ) 6,0;8,0;9,0 321 === APAPAP . 
( ) ( ) 1,09,011 11 =−=−= APAP ; ( ) ( ) 2,08,011 22 =−=−= APAP  ( ) ( ) 4,06,011 33 =−=−= APAP . 

В-студент сдаст только второй экзамен из 3-х, т.е.студент сдаст второй эк-
замен,  и не сдаст первый и третий  экзамен. 

( ) ( ) ( ) ( ) 032,04,08,01,0321 =⋅⋅=⋅⋅= APAPAPBP . 
b) С-студент сдаст один экзамен из трех (произойдет, если студент сдаст 

только первый экзамен из 3-х, или только второй, или только третий). 
( ) ( ) ( )

116,06,02,01,04,08,01,04,02,09,0
()() 321321321321321321

=⋅⋅+⋅⋅+⋅⋅=
=⋅⋅+⋅⋅+⋅⋅=⋅⋅+⋅⋅+⋅⋅= AAAPAAAPAAAPAAAAAAAAAPCP  

с) D- студент сдаст хотя бы один экзамен («не менее одного» экзамена). 
( ) ( ) 992,04,02,01,011 321 =⋅⋅−=⋅⋅−= AAAPDP . 

5. Формула полной вероятности. 
Пусть  несовместные события nHHH ...,,, 21  образуют полную группу. Тогда 

для любого события  А  имеет место формула полной вероятности: 
( ) ( ) ( ) ( ) ( ) ( ) ( )APHPAPHPAPHPAP

nHnHH ⋅++⋅+⋅= ...
21 21  

События  nHHH ...,,, 21  называют гипотезами, так как заранее неизвестно ка-
кое из этих событий  наступит. 

Пример 11. В сборочный  цех завода поступает 40% деталей из 1 цеха и 
60% - из 2 цеха. В первом цехе производится 90% стандартных деталей, а во 
втором – 95%. Найти вероятность того, что наудачу взятая сборщиком деталь 
окажется стандартной. 

Решение: 
Событие А - взятая наудачу деталь стандартна. 
Н1 – деталь изготовлена  1-ым цехом; 
Н2 – деталь изготовлена 2-ым  цехом; 
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События  Н1 и Н2 образуют полную группу,  
( ) ( ) 6,0

100
60;4,0

100
40H 21 ==== HPP . 

 95,0
100
95)(;9,0

100
90)(

21
==== APAP HH . 

( ) ( ) ( ) ( ) ( ) 93,095,06,09,04,0
21 21 =⋅+⋅=⋅+⋅= APHPAPHPAP HH . 

6. Формула Байеса. 
Пусть события nHHH ...,,, 21  образуют полную группу событий. Тогда ус-

ловная вероятность события ( )nkH k ,1=  при условии, что событие  А произош-
ло, задается формулой  

( ) ( ) ( )
( )AP

APHP
HP kHk

kA

⋅
= , 

где ( ) ( ) ( ) ( ) ( ) ( ) ( )APHPAPHPAPHPAP
nHnHH ⋅++⋅+⋅= ...

21 21  - формула полной вероят-
ности. 

Пример 12. В сборочный  цех завода поступает 40% деталей из 1 цеха и 
60% - из 2 цеха. В первом цехе производится 90% стандартных деталей, а во 
втором – 95%. Найти вероятность того, что эта стандартная деталь изготовлена 
2-ым цехом. 

Решение: 
Событие А-взятая наудачу деталь стандартна. 
Н1 – деталь изготовлена  1-ым цехом; 
Н2 – деталь изготовлена 2-ым  цехом; 
События  Н1 и Н2 образуют полную группу,  

( ) ( ) 6,0
100
60;4,0

100
40H 21 ==== HPP . 

 95,0
100
95)(;9,0

100
90)(

21
==== APAP HH . 

Определим вероятность гипотезы  Н2 при условии, что событие А уже про-
изошло: 

( ) ( ) ( )
( ) ( ) ( ) ( ) 613,0

31
19

93,0
95,06,0

95,06,09,04,0
95,06,0

21

2

21

2
2 ≈=

⋅
=

⋅+⋅
⋅

=
⋅+⋅

⋅
=

APHPAPHP
APHP

HP
HH

H
A . 

 7. Формула Бернулли. 
Если производится n независимых испытаний, в каждом из которых вероят-

ность появления события   А равна p, а  вероятность его непоявления  равна q=1-p, 
то  вероятность того, что событие А произойдет m раз определяется формулой 
Бернулли 

( ) nmqpCmP mnmm
nn ,...,3,2,1,0, =⋅⋅= −  

В ряде случаев требуется определить вероятности появления события А менее 
m раз(x<m), более  m раз(x>m), не менее m раз ( mx ≥ ),   не более m раз ( mx ≤ ), хо-
тя бы один раз ( 1≥x ). 

Случаи: 
a) )1(...)1()0()( −+++=< mPPPmxP nnn  
b) )(...)2()1()( nPmPmPmxP nnn +++++=>  
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c) )(...)1()()( nPmPmPmxP nnn ++++=≥  
d) )(...)1()0()( mPPPmxP nnn +++=≤  
e) )0(1)1( nPxP −=≥  
Пример 13.Четыре покупателя приехали на оптовый склад. Вероятность 

того, что каждому из этих покупателей потребуются холодильник марки «А» 
равна 0,4. Найти вероятность того, что холодильник потребуется: 

a) двум покупателям; 
b) не более,  чем трем покупателям; 
c) хотя бы одному покупателю. 
Решение: 

4,6,04,011,4,0 ==−=−== npqp . 
a) m=2 

( ) 3456,036,016,0
2
436,04,0

!2!2
!42 222422

44 =⋅⋅
⋅

=⋅⋅
⋅

=⋅⋅= −qpCP . 

b) 3≤m  
( ) ( ) ( ) ( ) ( ) 744,04,016,04,0

!0!4
!411413210)3( 4044444

444444 =−=⋅⋅
⋅

−=⋅⋅−=−=+++=≤ −qpCPPPPPmP  

c) 1≥m  
( ) 8704,06,016,04,0

!4!0
!41101)1( 4400400

44 =−=⋅⋅
⋅

−=⋅⋅−=−=≥ −qpCPmP . 

Тема. Случайные величины. 
Случайной величиной называют величину X, которая принимает в резуль-

тате опыта то или иное возможное значение x, заранее не известное, зависящее 
от случайных  обстоятельств. 

Например,  число родившихся мальчиков среди пяти новорожденных есть 
случайная величина, которая может принимать значения 0,1,2,3,4,5. 

Дискретной случайной величиной называется случайная величина, при-
нимающая отдельные друг от друга значения, которые можно перенумеровать.  

Дискретная случайная величина определена, если известны все ее значения 
и соответствующие им вероятности. 

Всякое соотношение между возможными значениями случайной величины 
и соответствующие им вероятностями называют законом распределения  дис-
кретной случайной величины. 

Простейшим способом задания дискретной случайной величины – таблица, 
которая называется рядом распределения. 

X 1x  2x 3x … nx  
P 1p  2p 3p … np  

где    ∑
=

=
n

i
ip

1

1.  

Графическое изображение ряда распределения называется многоугольни-
ком распределения.  

Функцией распределения случайной величины X называется функция 
F(x), выражающая вероятность того, что X примет значение, меньше, чем x: 
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( ) ( )xXPxF <= . 
Функция распределения обладает следующими свойствами: 
1. 1)(0 ≤≤ xF . 
2. F(x)-неубывающая функция, т.е. 1212 ),()( xxеслиxFxF >≥ . 
3. ( ) 1,0)( =∞+=−∞ FF . 
4. F(x)-непрерывна слева в любой точке x, т.е. ( ) ( ) RxxFxF ∈=− ,0 . 
5. ( ) ( ) ( )aFbFbXaP −=<≤ . 
Числовые характеристики случайных величин: математическое ожида-

ние (среднее значение случайной величины), дисперсия и среднее квадратиче-
ское отклонение (величина разброса возможных значений случайной величины 
вокруг среднего). 

Математическим ожиданием  дискретной случайной величины X  назы-
вают сумму произведений всех ее возможных  значений на соответствующие 

им вероятности   ∑
=

⋅=
n

i
ii pxXM

1
)( . 

Дисперсией дискретной случайной величины X  называют математическое 
ожидание квадрата отклонения случайной величины от ее математического 
ожидания ( ) ( ) 22 )()( XMXMXD −= . 

Средним квадратическим отклонением дискретной случайной величины 
X  называют корень квадратный из дисперсии ( ) ( )XDX =σ . 

Пример. В результате проведенных испытаний установлено распределение 
дискретной случайной  величины х:   

X 54 56 58 60 
P 0,2 0,4 0,3 0,1 

Найти: )(XM , )(XD , ( )Xσ . Составить функцию  F(x), построить ее график. 
Решение: 

Найдем ∑
=

⋅=
n

i
ii pxXM

1

)( . )(XM = 54 · 0,2 · 56 · 0,4 + 58 · 0,3 + 60 · 0,1 = 56,6 

( ) ( ) 22 )()( XMXMXD −= .  
)(XD = 542 · 0,2 + 562 · 0,4 + 582 · 0,3 + 602 · 0,1 – (56,6)2 = 3,24 

( ) ( )XDX =σ ⇒   ( )Xσ  = 1,8 
Так как  ( ) ( )xXPxF <= , находим: 

при  0)()(54 =<=≤ xXPXFx ; 
при 2,0)54()(5654 ===≤< XPXFx ; 
при 6,04,02,0)56()54()(5856 =+==+==≤< XPXPXFx ; 
при 9,03,04,02,0)58()56()54()(6058 =++==+=+==≤< XPXPXPXFx ; 
при 11,03,04,02,0)60()58()56()54()(60 =+++==+=+=+==> XPXPXPXPXFx . 
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⎪
⎪
⎪

⎩

⎪⎪
⎪

⎨

⎧

>
≤<
≤<
≤<

≤

=

60,1
6058,9,0
5856,6,0
5654,2,0

54,0

)(

xпри
xпри
xпри
xпри

xпри

xF -функция распределения случайной величины. 

Построим график этой функции. 

 
Тема. Основы математической статистики 
Математическая статистика – раздел математики, в котором изучаются ме-

тоды сбора, систематизации и обработки результатов наблюдений массовых 
случайных явлений для выявления существующих закономерностей. Матема-
тическая статистика тесно связана с теорий  вероятности. 

1. Первичная обработка результатов эксперимента. 
Явления, происходящие в природе, обществе, человеке сложны и разнооб-

разны. Ученые изучают разные стороны этих явлений, причем каждая наука 
вырабатывает свои специфические методы исследования.  Такое важное соци-
альное  явление как преступность изучают не только юристы, но и социологи, 
медики и т.д. Их задача состоит в том, чтобы подвергнуть  математической об-
работке огромный статистический материал – отчеты органов внутренних дел и 
любые другие документы, содержащие различные числовые данные. 

Результаты обработки представляют в виде таблиц, графиков, диаграмм и 
различных числовых характеристик, которые называются параметрами. Важ-
нейшие из них – среднее  арифметическое и дисперсия. 

2. Среднее арифметическое. 
Понятие среднего значения используется для описания разнообразных яв-

лений для описания разнообразных явлений природы и общественной жизни. 
Например, во время предвыборной  кампании  службы  по изучению общест-
венного мнения составляют прогнозы, в которых оценивают шансы на успех 
различных кандидатов. Ясно, что  провести опрос всех избирателей  невозмож-
но, поэтому проводят опрос небольшой части населения. По   результатам оп-

x

)(xF

54 5856 60

2,0

6,0

9,0

1
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роса прогнозируют средние проценты популярности кандидатов у различных 
социальных групп и в разных регионах.  

Средней величиной называют среднее арифметическое. 
Пусть nxxx ...,,, 21  - некоторые числа. Их средним арифметическим называ-

ется число  )...(1
21 nxxx

n
x +++=    

Среднее арифметическое можно найти и с помощью следующей формулы: 
)~...~~(1

2211 kk mxmxmx
n

x ⋅++⋅+⋅= , 

где  ix~  - число  правонарушений за день; im  - число дней с одним и тем же ко-
личеством правонарушений ( nmmm k =+++ ...21 ).  

Пример 1. По сведениям автоинспекции,  количество дорожных происше-
ствий на улицах города Дрюкова в первую декаду октября было таким: 

6     8     10     7     6     11     9     8        7      11. 
В сводке за следующие 10 дней оказались такие данные:  

0       5     7      7     12      11     14    13    7     6. 
Определить среднее число дорожных происшествий? 
Решение: 
Среднее арифметическое первой декады октября:   

3,8
10
83)1178911671086(

10
1

==+++++++++=x  

показывает среднее число дорожных происшествий в день. 
Среднее арифметическое за следующие 10 дней:   

2,8
10
82)67131411127750(

10
1

==+++++++++=y  

Средние значения 8,2 и 8,3 отличаются друг от друга значительно меньше, 
чем число происшествий за каждый день. 

3. Дискретные случайные величины. 
Случайной величиной называют величину X, которая принимает в результате 

опыта то или иное возможное значение x, заранее не известное, зависящее от слу-
чайных  обстоятельств. 

Например,  число родившихся девочек  среди пяти новорожденных есть слу-
чайная величина, которая может принимать значения 0,1,2,3,4,5. 

Дискретной случайной величиной называется случайная величина, прини-
мающая отдельные друг от друга значения, которые можно перенумеровать. Дис-
кретная случайная величина определена, если известны все ее значения и соответ-
ствующие им вероятности. 

Всякое соотношение между возможными значениями случайной величины и 
соответствующие им вероятностями называют законом распределения  дискрет-
ной случайной величины. 

Простейшим способом задания дискретной случайной величины – таблица, 
которая называется рядом распределения. 

X 1x  2x  3x  … nx  
P 1p  2p  3p  … np  
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где    ∑
=

=
n

i
ip

1
1.  

Графическое изображение ряда распределения называется многоугольником 
распределения (полигон) – ломанная  с вершинами в точках ),( ii px , где  ni ,1= .  

Числовые характеристики случайных величин: 
− математическое ожидание (среднее значение случайной величины),  
− дисперсия,  
− среднее квадратическое отклонение (величина разброса возможных значе-

ний случайной величины вокруг среднего). 
Математическим ожиданием  дискретной случайной величины X  назы-

вают сумму произведений всех ее возможных  значений на соответствующие 

им вероятности   ∑
=

⋅=
n

i
ii pxXM

1

)( . 

Дисперсией дискретной случайной величины X  называют математическое 
ожидание квадрата отклонения случайной величины от  ее математического  
ожидания ( ) ( ) 22 )()( XMXMXD −= . 

Средним квадратическим отклонением дискретной случайной величины 
X  называют корень квадратный из дисперсии ( ) ( )XDX =σ . 

Пример 2. В результате проведенных испытаний установлено распределе-
ние дискретной случайной  величины х:  

X 2 3 10 12 
P 0,1 0,4 0,5 0,2 

Найти: 
a)  )(XM , )(XD , ( )Xσ  
b) построить многоугольник распределения 
Решение: 

а) Найдем     ∑
=

⋅=
n

i
ii pxXM

1

)( ,    ( ) ( ) 22 )()( XMXMXD −=  

)(XM = 2 · 0,1+3 · 0,4 + 10 · 0,5+12·0,2 =0,2+1,2+5+2,4=8,8  
8,828,28506,34,02,0125,0104,031,02)( 22222 =+++=⋅+⋅+⋅+⋅=XM  

)(XD = 36,544,778,82)8,8(8,82 2 =−=−  
( ) ( )XDX =σ ⇒   ( ) 315,236,5 ≈=Xσ  

b) Многоугольник распределения 
c)  

 

ip
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4. Интервальный ряд. Гистограмма. 
При  обработке  большого числа экспериментальных данных их предвари-

тельно группируют и оформляют в виде так называемого интервального ряда.  
Совокупность всех подлежащих изучению объектов или возможных результатов 
всех мыслимых наблюдений, называется генеральной совокупностью.  

Наблюдаемое значение ix  называется вариантой, а их последовательность, 
записанная в возрастающем порядке, – вариационным   рядом.  Число наблюде-
ний in  называется частотой, а значение его отношения к объему выборки – отно-
сительной частотой. 

Статистическим распределением  выборки называют перечень вариант  и 
соответствующих им частот или относительных частот. 

Выборочной совокупностью (выборкой) называется совокупность объек-
тов, отобранных случайным образом из генеральной совокупности.  Число объек-
тов (наблюдений) в совокупности называется ее объемом ( n ).      

Установленную область значений величины делят на k равных частей. При 
выборе интервалов можно пользоваться  следующей таблицей: 

объем выборки 40-60 60-100 100-200 200-500 
число интервалов 5-7 7-10 10-14 14-17 

Выбрав число интервалов,  определяют длину интервала: 

 
k

xx minmax −=∆ ,  (∆  можно округлить).  

Результаты заносятся в таблицу: 
№ интервалов границы ин-

тервалов 
подсчет частот, 

in  
частота в интерва-

ле, ip  
середины ин-
тервалов,  ix  

1 
2 
3 
… 
k 

    

Итого n 
Сгруппированный статистический ряд:   

ix 1x 2x … kx

ip 1p 2p  kp

где ix - середина i-го интервала, ip - соответствующая ему частота ( ip =
n
ni ), при-

чем 1
1

=∑
=

k

i
ip . 

Гистограммой частот  называют ступенчатую фигуру, состоящую из пря-
моугольников, основаниями которых служат частичные интервалы длины ∆ , а 

высоты равны отношению 
∆

in , ki ,1= . 

Полигоном частот  –  ломанная  с вершинами в точках  ki
n

x i
i ,...,2,1),,( =
∆

. 

Полигоном относительных частот – ломанная с вершинами в точках  
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ki
n
n

x i
i ,...,2,1),,( =

∆⋅
. 

Пример 3.  Для проведения демографических исследований выбрали 50 
семей и получили следующие данные о количестве членов семьи: 
2     5     3     4     1     3    6     2     4     3     4     1     3     5     2     3     4     4     3     3     
2     5     3     4     4     3     3     4    4     3     2     5     3     1     4     3     4        2     6     3     
2     3     1     6     4     3     3     2     1     7 

Построить: 1. сгруппированный статистический ряд; 2. гистограмму; 3. по-
лигон относительных частот. 

Решение: 
1. minx =1;   maxx =7;   n =50 

 
k

xx minmax −=∆  => 1
7
6

7
17

≈=
−

=∆  

Левая граница интервала равна 5,0
2
11 =−  

№ интерва-
лов 

границы интервалов подсчет частот, 
in  

частота в ин-
тервале, 

ip  

середины ин-
тервалов, 

ix  
1 
2 
3 
4 
5 
6 
7 

0,5 – 1,5 
1,5 – 2,5 
2,5 – 3,5 
3,5 – 4,5 
4,5 – 5,5 
5,5 – 6,5 
6,5 – 7,5 

5 
8 
17 
12 
4 
3 
1 

505  
508  
5017  
5012  
504  
503  
501  

1 
2 
3 
4 
5 
6 
7 

n =50 
Сгруппированный статистический ряд имеет вид  
ix  1 2 3 4 5 6 7 

ip  505  508  5017  5012  504  503  501  
2.  

№ интервалов границы интер-
валов in  

плотность частоты, 

∆
in

 n
ni

⋅∆
 

1 
2 
3 
4 
5 
6 
7 

0,5 – 1,5 
1,5 – 2,5 
2,5 – 3,5 
3,5 – 4,5 
4,5 – 5,5 
5,5 – 6,5 
6,5 – 7,5 

5 
8 

17 
12 
4 
3 
1 

5 
8 

17 
12 
4 
3 
1 

505  
508  
5017  
5012  
504  
503  
501  
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Гистограмма 

 

Полигон относительных частот 

Вывод: 
По данному полигону  относительных частот  видно, что подавляющее 

большинство семей имеют в своем составе три человека. 
С помощью гистограммы можно определить вид закона распределения ге-

неральной совокупности, который позволит выбрать для исследования явления 
математический аппарат. 

Тема. Элементы теории корреляции.  
Часто результат опыта описывается не одной, а несколькими случайными 

величинами. В этом случае говорят, что имеем систему случайных величин. 
Систему двух случайных величин ( YX ; )  можно изобразить случайной точкой 
на плоскости. Закон распределения системы двух случайных величин может 
быть задан при помощи таблицы.  

          Х 
Y 

1y  2y  … ny  

1x  11P  12P  … nP1  

2x  21P  22P  … nP2  
… … … … … 

mx  1mP  2mP  … mnP  
где  mxxx <<< ...21 ;  nyyy <<< ...21  

ijP  - вероятность события, заключающегося в одновременном выполнении 

ixX = ; jyY = . 

При этом  ∑∑
= =

=
m

i

n

j
P

1 1
1 

Между случайными величинами может существовать функциональная за-
висимость, когда каждому возможному значению одной случайной величины 
соответствует определенное значение другой случайной величины. Например,  
зависимость между возрастом дерева и количеством годовых колец. Но между 
случайными  величинами может существовать связь и другого рода, прояв-
ляющаяся в том, что изменения  одной из них  влечет изменения закона распре-
деления другой. Например, связь между ростом человека  и возрастом.  Такая 
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связь называется стохастической (вероятностной) или статистической. Стати-
стическая связь между  двумя величинами появляется обычно тогда, когда  
имеются  общие случайные факторы, влияющие на обе случайные величины 
одновременно, наряду с другими, неодинаковыми для обеих случайных вели-
чин факторами. В частности, статистическая зависимость проявляется в том, 
что при изменении  одной из величины изменяется среднее значение другой. 
Условным средним xy называют среднее арифметическое значений Y, соответ-
ствующих значению xX = . 

Если каждому значению x  соответствует одно значение условной средней, 
то условная средняя есть функция от x . В этом случае случайная величина Y 
зависит от X корреляционно. 

Например, рост и размер обуви. 
Пусть случайная величина x - рост людей, а y - размер их обуви. Фиксиру-

ем x , значит,  рассматриваем только людей одного роста и вычисляем услов-
ную среднюю, т.е. измеряем их размер обуви. Тогда росту одного человека со-
ответствует одно среднее значение размера обуви. Следовательно, мы имеем 
дело со статистической (корреляционной) зависимостью. 

Корреляционной зависимостью Y от X называют функциональную зависи-
мость )(xfyx = . Это уравнение называется уравнением регрессии Y на  X, а ее 
график – линией регрессии Y на X. 

Теория корреляции  позволяет решить две задачи: 
1. Установить форму  корреляционной связи, т.е. вид функции регрессии 

(линейная, квадратичная, показательная и т.д.). Наиболее часто встречаются 
линейные функции регрессии.  

2. Оценить тесноту (силу)  корреляционной связи. Теснота корреляцион-
ной зависимости Y от X  оценивается по величине рассеяния значений Y вокруг 
условного среднего.  

 Метод наименьших квадратов. 

Предположим, X  и Y связаны линейной,  зависимостью baXY += , где  

ba, - неизвестные.  Найдем их из условия, что ( )
2

1
∑
=

−+
n

i
ii ybax - минимально (сум-

ма  квадратов отклонений  по y ).  
Заметим, что эта сумма есть функция от двух переменных ba,  

∑
=

−+=
n

i
ii ybaxbaF

1

2)(),( . Необходимым условием экстремума (в тои числе – ми-

нимума) является равенство нулю первых частных производных. 

⎪
⎪
⎩

⎪⎪
⎨

⎧

=+

=+
⇒

⎪
⎪
⎩

⎪⎪
⎨

⎧

=⋅−+

=−+
⇒

⎪
⎪
⎩

⎪⎪
⎨

⎧

=
∂
∂

=
∂
∂

∑∑

∑∑ ∑

∑

∑

==

== =

=

=

n

i
i

n

i
i

n

i
ii

n

i

n

i
ii

n

i
ii

n

i
iii

ybnxa

yxxbxa

ybax

xybax

b
F
a
F

11

11 1

2

1

1

01)(2

0)(2

0

0
. 

Решая эту систему относительно неизвестных  a и  b, получим формулы: 
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∑ ∑

∑∑∑

= =

===

⎟
⎠

⎞
⎜
⎝

⎛
−

−
=

n

i

n

i
ii

n

i
i

n

i
i

n

i
ii

xxn

yxyxn
a

1

2

1

2

111 ,    
∑ ∑

∑∑∑∑

= =

====

⎟
⎠

⎞
⎜
⎝

⎛
−

−
=

n

i

n

i
ii

n

i
ii

n

i
i

n

i
i

n

i
i

xxn

xyxyx
a

1

2

1

2

1111

2

. 

Для проверки точности вычислений служит величина  σ   и заранее задан-

ная погрешность ε :   ( )∑
=

−⋅
−

=
n

i
iik yxP

n 1

2)(
1

1σ , где ( )xPk  - многочлен степени k. 

Если  εσ >>  степень многочлена недостаточна, велика, надо увеличить 
степень. 

Если  εσ <<  старшие коэффициенты недостоверны, надо уменьшить  сте-
пень многочлена. 

Если  εσ ≈  - число коэффициентов оптимально. 
При решении (для небольших k) удобно результаты записывать в таблицу. 

          Х 
Y 

ix  iy  2
ix  ii yx  

1     
2     
…     
n     
∑  ∑

=

n

i
ix

1
 ∑

=

n

i
iy

1
 ∑

=

n

i
ix

1

2  ∑
=

n

i
ii yx

1
 

Для характеристики системы двух случайных величин применяются сле-
дующие понятия: центр рассеивания системы случайных  величин ( )yx mm , , где  

ij

m

i

n

j
ix PxXMm ∑∑

= =

==
1 1

)( ; ij

m

i

n

j
ix PyYMm ∑∑

= =

==
1 1

)( . 

xm  и ym  это математические ожидания дискретных случайных величин X и  Y. 
Для определения дисперсий X  и Y имеем формулы: 

( )
2

1 1
)( ∑∑

= =

−=
m

i

n

j
xiij mxPXD  ;  ( )

2

1 1
)( ∑∑

= =

−=
m

i

n

j
yiij myPYD    или  [ ]

[ ]22

22

)()()(

)()()(

YMYMYD

XMXMXD

−=

−=  

Средние квадратические отклонения случайных величин  X  и Y: 
)(XDx =σ ;  )(YDy =σ . 

В случае, когда вероятность появления пары ( )ji yx ,  есть ее частота 
n
n

P ij
ij = , 

математическое ожидание вычисляется, как среднее - арифметическое случай-
ной величины: 

n

nx
xXM

n

i
ii∑

=

⋅
== 1)( ;      

n

ny
yXM

n

i
ii∑

=

⋅
== 1)(  

Дисперсия: 

21

2

)( x
n

nx
XD

n

i
ii

−
⋅

=
∑
= ;    21

2

)( y
n

ny
YD

n

i
ii

−
⋅

=
∑
=  
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Среднеквадратическое   отклонение: )(XDx =σ ;   )(YDy =σ .  

Выражение yx
n

nyx
Cгде

C
r

n

i
iii

xy
yx

xy
xy ⋅−==

∑
=1,

σσ
называется коэффициентом 

корреляции, который  является главной характеристикой связи между X и Y.  
Если, 31 ≥−⋅ nrxy  то связь между X и  Y достаточно вероятна и выражает-

ся формулой:  )( xxryy
x

y
xyx −⋅=−

σ
σ

-формула линии регрессии y  на x. 

Коэффициент корреляции удовлетворяют условию: 11 ≤≤− xyr . 
Если случайные величины X,Y независимы, то 0=xyr . При большом числе 

наблюдений одно и то же значение x может встретиться xn  раз, одно и то же зна-
чение y может встретиться yn раз, одна и та же пара  чисел (x,y) может наблюдать-
ся  xyn раз. Поэтому данные наблюдений группируются, т.е. подсчитывают частоты  

xn , yn , xyn . Все сгруппированные данные записывают в виде таблицы, которую на-
зывают корреляционной. 

Пример. Выборочно обследовано 100 снабженческо-сбытовых предприятий 
некоторого региона по количеству работников Х и объемом складской реализации 
Y  (ден. ед.). Результаты представлены в корреляционной таблице. 

         X  
Y 

5 15 25 35 45 ny 

130 7 1    8 
132 2 7 1   10 
134 1 5 4   11 
136  1 15 10 8 34 
138   3 12 15 30 
140    1 6 7 
nx 10 14 23 24 29 n=100 

 По данным исследования требуется: 
 1) В прямоугольной системе координат построить эмпирические  ломаные 

регрессии Y на Х и   Х на Y . Сделать предположение о виде корреляционной свя-
зи. 

 2) Оценить тесноту линейной корреляционной связи. 
 3) Составить линейные уравнения регрессии Y на Х, построить их графики в 

одной системе  координат. 
Решение:  
1. Для построения  эмпирических  ломаных регрессий вычислим условия 

средние хΥ  и уΧ .  Вычисляем  хΥ при каждом  х.  

2. Например:  Υ х=5  =   
127

113421327130
++

⋅+⋅+⋅  = 130,08 

Аналогично:   Υ  х=15   = 132,86 
Полученные таким образом данные заносим в таблицы. 

Х  5 15 25 35 45 

Υ х 130,8 132,86 135,74 137,08 137,86 
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Υ  130 132 134 136 138 140 
Χ 4 6,25 14 19,54 32,35 39 43,57 

В прямоугольной системе нанесем точки  Аι (хι ; ιхΥ ) и Вj(хуj;уj).  Постро-
енные эмпирические регрессии Y на Х и Х на Y, свидетельствуют о том, что 
между количеством работающих Х и объемом складских реализаций (Y) суще-
ствует линейная зависимость. 

2. Оценим тесноту связи. Вычислим выборочный коэффициент корреляции. 

rв = 
ух

ухху
σσ ⋅
⋅−    ;  х= 

N
nх х∑ ι ; хσ  = 22 хх − ;  у  = 

N

nу у∑ jj  

уσ = 22 уу −  ;  2х  = 
N

nх х∑ ιι
2

 

х = 29,8   у  = 135,78      2у  = 
N

nу у∑ jj
2

 

(

) 4075,556 · 45 · 140  1 · 35 · 140 
 15 · 45 · 138  12 · 35 · 138  3 · 25 · 138 8 · 45 · 136  10 · 35 · 136  15 · 25 · 136  1 · 15 · 136  1 · 35 · 134 

 4 · 25 · 134  5 · 15 · 134  1 · 5 · 134 1 · 25 · 132  7 · 15 · 132  2 · 5 · 132  1 · 15 · 130  7 · 5 · 130
100

1

=+++
++++++++++

++++++++=yx

хσ  = 13,08  уσ  = 2,68   rв = 0,84. 
Значение  rв говорит о том, что линейная связь между количеством работ-

ников и объемом складским реализаций высокая. 
Запишем уравнения регрессии. 

ху - у  = rв 
х

у

σ

σ  (х - х) ; ху  - х = rв 
у
х

σ
σ  (у - у ) 

ху  - 135,78 = 
68,2

08,1384,0 ⋅   · (x – 29,8)  или ух  = 4,1 у – 526,9 

 

 

 

 

 

 

 
 Уравнение регрессии X на Y. 
 Уравнение регрессии Y на X. 
Замечание: Если в корреляционной таблице даны интервальные распреде-

ления, то за значения вариант надо убрать середины частичных интервалов.  

1

2

X

Y
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2 семестр – раздел «Информатика» 

Тема. Информатизация общества: современное представление ин-
формации и алгоритмы ее обработки. 

Информатика – это наука, изучающая все аспекты получения, хранения, 
переработки, передачи и использования информации. 

Слово «Информатика» образовалось из 2-х французских слов INFORma-
tion (информация) autoMATIQUE (автоматика). Первоначально в научный оби-
ход оно вошло во  Франции в 60-е годы для обозначения автоматической пере-
работки информации в широкой области научной и производственной деятель-
ности человека. В качестве источников информатики обычно называют доку-
менталистику (изучение рациональных средств и методов повышения эффек-
тивности документооборота) и кибернетику. 

Задачи информатики 
1) Исследование информационных процессов любой природы. 
2) Разработка информационной техники и создание новейшей технологии пере-
работки информации на базе полученных результатов исследования информа-
ционных процессов. 
3) Решение научных и инженерных проблем создания, внедрения и обеспечения 
эффективного использования компьютерной техники и технологии во всех 
сферах общественной жизни. 

Основные направления информатики: теоретическая информатика, кибер-
нетика, программирование, информационные системы, вычислительная техни-
ка, информатика в обществе, информатика в природе. 

Этапы развития информатики: ручной, механический, электромеханиче-
ский, электронный. 

Классификация ЭВМ: 
1. По истории создания:  

I поколение: элементарная база — лампы, оперативная память на элек-
тронно-лучевых трубках и ферритовых сердечниках, быстродействие до 20000 
оп/сек., охлаждение, однопрограммность. 

II поколение: элементарная база — полупроводниковые транзисторы, бы-
стродействие 104–105 оп/сек. Объем памяти — до 150 слов при длине слова до 
50 двоичных разрядов. Программирование велось на  алгоритмических языках 
Фортран, Алгол, Кобол. 

III поколение:  элементарная база — интегральные схемы (ИС), быстро-
действие 106–107 оп/сек. Резко снижены габариты и энергопотребление ЭВМ. 
Оперативная память строилась на ИС и достигала объема 105–106 байт. Унифи-
цировались периферийные устройства. Появился широкий выбор языков про-
граммирования.  

IV поколение: элементарная база — большие и сверхбольшие ИС (БИС и 
СБИС). Быстродействие 107–108 оп/сек. Формируются два направления — мно-
гопроцессорные и персональные ЭВМ.  

2. По размерам: суперЭВМ, большие ЭВМ, малые ЭВМ, микроЭВМ 
Классификация РС: 
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3. Стационарные. 
4. Переносные: портативные, блокноты, электронные словари, органайзе-

ры (электронные записные книжки). 
Информационное общество – это общество, в котором большинство рабо-

тающих занято производством, хранением, переработкой или реализацией ин-
формации, особенно высшей ее формой – знаний.  

В период перехода к информационному обществу необходимо подготовить 
человека к быстрому восприятию и обработке больших объемов информации, 
овладению  им современными средствами, методами и технологией работы. 
Поэтому современный человек должен иметь определенный уровень информа-
ционной культуры. 

Информационное общество характеризуется – 50% людей занято в сфере 
информационных услуг. 

Информационная система – взаимосвязанная совокупность средств, мето-
дов и персонала, используемых для хранения, обработки и выдачи информации 
в интересах достижения поставленной цели. 

Информационная технология – процесс, использующий совокупность 
средств и методов отбора, обработки и передачи данных для получения инфор-
мации нового качества. 

Сигнал – физический процесс, имеющий информационное значение, уста-
новленное принятым соглашением. В обычной жизни под сигналом понимают 
физический процесс, который человек воспринимает как звук, свет и т. д. Дан-
ные – зарегистрированные сигналы. Данные могут рассматриваться как призна-
ки или записанные наблюдения, которые по каким-то причинам не используют-
ся, только хранятся. Если появляется возможность использовать эти данные для 
уменьшения неопределенности в чем-либо, то данные превращаются в инфор-
мацию. 

Информация – сведения об объектах и явлениях окружающей среды, их 
параметрах, свойствах и состоянии, которые уменьшают имеющуюся о них 
степень неопределенности, неполноты знаний. 

Одной из важнейших разновидностей информации является информация 
экономическая. Экономическая информация – совокупность сведений, отра-
жающих социально-экономические процессы и служащих для управления эти-
ми процессами и коллективами людей в производственной и непроизводствен-
ной сфере. 

Свойства информации: объективность, достаточность (полнота), достовер-
ность, доступность, актуальность, адекватность, своевременность, полнота, эн-
тропия информации. 

Классификация информации по разным признакам: 
1. По месту возникновения: входная, выходная, внутренняя, внешняя. 
2. По стабильности: переменная, постоянная. 
3. По стадии обработки: первичная, вторичная, промежуточная, резуль-

татная. 
4. По способу отображения: текстовая, графическая. 
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Информация всегда связана с материальным носителем (диски, кассеты, 
бумажные носители, человек, негатив и т. д.), а ее передача с затратами энер-
гии. Закодированное сообщение приобретает вид сигналов - носителей инфор-
мации, которые текут по каналам связи. При выходе из канала связи сигналы 
должны обрести вновь общепонятный вид в декодирующем устройстве. (При-
меры: фонарик, телефон, живой нерв, компьютер).  

Однако, одну и ту же информацию можно хранить в различном матери-
альном виде (на бумаге, магнитной ленте, магнитном диске, оптическом диске) 
и передавать с различными энергетическими затратами (по телефону, по почте, 
с курьером).   

Различают две формы представления информации — непрерывную (анало-
говую) и прерывистую (цифровую, дискретную).  

Непрерывная форма характеризует процесс, который не имеет перерывов и 
теоретически может изменяться в любой момент времени и на любую величину 
(например, речь человека, музыкальное произведение). Цифровой сигнал может 
изменяться лишь в определенные моменты времени и принимать лишь заранее 
обусловленные значения (например, только значения напряжений 0 и 3,5 В). 
Моменты возможного изменения уровня цифрового сигнала задает тактовый 
генератор конкретного цифрового устройства. 

Для преобразования аналогового сигнала в цифровой сигнал требуется 
провести дискретизацию непрерывного сигнала во времени, квантование по 
уровню, а затем кодирование отобранных значений. 

Дискретизация – замена непрерывного (аналогового) сигнала по-
следовательностью отдельных во времени отсчетов этого сигнала. 

Количественное описание информации базируется на вероятностном под-
ходе. За единицу информации принимается один бит. Это такое количество ин-
формации, получаем в результате  реализации одного из двух равновероятных 
событий, например, при бросании монеты. Термин «бит» произошел от выра-
жения binary digit, что означает «двоичная цифра», т.е. принимающая значение 
0 или 1. 

Более крупная единица информации — байт — равна 8 бит. Проверка при-
сутствия или отсутствия на лекции 24 студентов дает лектору три байта инфор-
мации. Еще более крупная единица информации — 1 Кбайт — равна 1024 бай-
там. Далее— 1 Мбайт равен 1024 Кбайтам, 1 Гбайт равен 1024 Мбайтам, а 1 
Тбайт равен 1024 Гбайтам. 

Задача 1. Решить систему уравнений (найти x, y). В ответе необходимо 
указать единицы измерения.  
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Задача 2. Одна страница книги содержит 25 строк по 80 символов. В книге 
300 страниц. Каков объем информации необходим для хранения книги? 

Задача 3. Один музыкальный файл занимает 6 Кб на диске. Сколько файлов 
можно записать на CD-диск объемом 600 Мб.  

Тема. Системы счисления. 
Под системой счисления понимается способ изображения чисел с помо-

щью символов совместно с правилами выполнения действий над этими числа-
ми. 

Классификация систем счисления 
Все системы делятся на позиционные и непозиционные. 
В непозиционных системах каждая цифра имеет свой вес и ее значение не 

зависит от положения в числе – от позиции. Пример – римская система. Число 
76 в этой системе выглядит так: LXXVI, где L=50, X=10, V=5, I=1. Как видно 
цифрами здесь служат латинские символы. 

В позиционных системах значения цифр зависят от их положения (пози-
ции) в числе. Так, например, человек привык пользоваться десятичной позици-
онной системой – числа записываются с помощью 10 цифр. Самая правая циф-
ра обозначает единицы, левее – десятки, ещё левее – сотни и т.д. 

В любой позиционной системе число может быть представлено в виде 
многочлена. 

Покажем, как представляют в виде многочлена десятичное число. 
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Обобщим это представление на случай использования другого набора 
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Основанием системы счисления называется количество цифр и символов, 
применяющихся для изображения числа, например р=10. 

База системы — это последовательность цифр, используемых для записи 
числа. Ни в одной системе нет цифры, равной основанию системы. 

В настоящее время арифметические действия выполняются в десятичной 
системе, где р=10. База этой системы 0,1,2,3,4,5,6,7,8,9.  

Двоичная система счисления 
Представление информации с помощью двоичного кодирования наиболее 

оптимально для ЭВМ, так как данные в ЭВМ передаются по проводам с помо-
щью двух сигналов «есть напряжение» и «нет напряжения».  Поскольку все 
данные в ЭВМ кодируются числами, то для передачи их по  проводам необхо-
димо применять двоичную систему. 
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Двоичная система имеет основание р=2 и базу 0 и 1. То есть, для изобра-
жения  числа используются только два знака.  

Правила перевода из десятичной в двоичную СС 
Для перевода десятичного числа в двоичную систему отдельно переводят 

дробную и целую части. 
Чтобы перевести целое число из 10-ой в 2-ую систему нужно выполнять 

последовательное деление числа на 2 до тех пор, пока результат не станет 
меньше 2. Последний результат и остатки от деления, взятые в обратном по-
рядке дают двоичное число. 

Пример. Перевести число 164 из 10-ой СС в 2-ую. 
164 2       
164 82 2      
0 82 41 2     
 0 40 20 2    
    1 20 10 2   
     0 10 5 2  
      0 4 2 2 
     1 2 1 
      0  
В результате 16510=101001002. 
Для перевода правильной дроби из 10-системы счисления в 2-ю СС нужно 

умножить исходную дробь и дробные части получающихся произведений на ос-
нование 2, представленное в старой 10-системе. Целые части получающихся 
произведений дают последовательность цифр, которая является представлением 
дроби в 2-ой системе счисления. 

Правила перевода из двоичной в десятичную СС 
Для перевода необходимо разложить число по основанию системы счисле-

ния и посчитать результат. 
Пример. 
1011012=1·25+0·54+1·23+1·22+0·51+1·20=32+8+4+1=4510 

+⋅+⋅+⋅+⋅+⋅+⋅+⋅+⋅+⋅= −101234567
2 212020212020212021101,10100100  

10
3175232 625,164128324212121222120 =++=⋅+⋅+⋅++==⋅+⋅+ −−−−  

Существенным недостатком двоичной системы счисления является гро-
моздкая запись чисел. Для упрощения записи двоичных чисел могут быть ис-
пользованы восьмеричная и шестнадцатеричная системы счисления. 

Система называется родственной двоичной, если ее основание является 
степенью числа 2. К таким системам относятся четверичная, восьмеричная и 
шестнадцатеричная. Мы рассмотрим восьмеричную и шестнадцатиричную сис-
темы.  

Восьмеричная система 
Основание р=8. База — цифры от 0 до 7. 
Для перевода целого десятичного числа в восьмеричную СС необходимо 

выполнить последовательное деление на 8 до тех пор, пока результат не станет 
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меньше 8. Последний результат и остатки, взятые в обратном порядке дадут 
восьмеричное число. 

Для перевода правильной дроби из 10-ой СС в 8-ю нужно умножить исход-
ную дробь и дробные части получающихся произведений на основание 8. Целые 
части получающихся произведений дают последовательность цифр, которая яв-
ляется представлением дроби в 8-ой СС. 

Для перевода восьмеричного числа в десятичную систему необходимо раз-
ложить его по степеням основания системы 8 и выполнить сложение.  

Шестнадцатеричная  система 
Основание р=16. База — цифры от 0 до 9 и буквы A, B, C, D, E, F (A – 10, B 

– 11, C – 12, D – 13, E – 14, F – 15.) 
Для перевода целого десятичного числа в шестнадцатеричную систему не-

обходимо выполнить последовательное деление на 16 до тех пор, пока резуль-
тат не станет меньше 16. Последний результат и остатки, взятые в обратном по-
рядке дадут шестнадцатеричное число. 

Для перевода правильной дроби из 10-системы счисления в 16-ю СС нужно 
умножить исходную дробь и дробные части получающихся произведений на ос-
нование 16. Целые части получающихся произведений дают последовательность 
цифр, которая является представлением дроби в 16-ой системе счисления. 

Для перевода шестнадцатеричного числа в десятичную систему необхо-
димо разложить его по степеням основания системы 16 и выполнить сложение.  

Вообще, для того чтобы перевести целое число из одной системы счисле-
ния в другую необходимо выполнить следующие действия: 

1) поделить данное число на основание новой системы счисления; 
2) перевести остаток от деления в новую систему счисления; получается 

младший разряд нового числа; 
3) если частное от деления больше основания новой системы, продолжать 

деление, как указано в п.1; новый остаток, переведенный в новую систему 
счисления, дает второй разряд числа 

Тема. Аппаратное обеспечение ПК.  
Современный компьютер состоит из двух взаимосвязанных частей – аппа-

ратного (Hardware)  и программного  (Software) обеспечения. К аппаратному 
обеспечению относится все то, что можно потрогать руками (микросхемы, дис-
ки, платы).  

Архитектура компьютера определяется совокупностью ее свойств, сущест-
венных для пользователя. Основное внимание при этом уделяется структуре и 
функциональным возможностям машины, которые можно разделить на основ-
ные и дополнительные. 

Персональный компьютер — это настольная или переносная ЭВМ, удовле-
творяющая требованиям общедоступности и универсальности применения.  

Основные блоки ПК и их назначение 
Персональный компьютер — универсальная техническая система. Сущест-

вует понятие базовой конфигурации, которую считают типовой. Понятие базо-
вой конфигурации может меняться. В настоящее время в базовой конфигурации 
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рассматривают четыре устройства: системный блок, монитор, клавиатуру, 
мышь. 

Системный блок представляет собой основной узел, внутри которого уста-
новлены наиболее важные компоненты. Устройства, находящиеся внутри сис-
темного блока, называют внутренними, а устройства, подключаемые к нему 
снаружи, называют внешними. Внешние дополнительные устройства, предна-
значенные для ввода, вывода и длительного хранения данных, также называют 
периферийными. 

Системный блок обычно включает в себя системную плату, блок питания, 
накопители на дисках, разъемы для дополнительных устройств и платы расши-
рения с контроллерами – адаптеры внешних устройств. 

На системной плате (Mother Board) размещаются самые главные детали:  
1. Микропроцессор (МП) - это центральный блок ПК, предназначенный 

для управления работой всех блоков машины. В его состав входят: 
1) устройство управления (УУ) — формирует и подает во все блоки машины в 
нужные моменты времени определенные сигналы управления (управляющие 
импульсы); формирует адреса ячеек памяти, используемых выполняемой опе-
рацией, и передает эти адреса в соответствующие блоки ЭВМ; опорную после-
довательность импульсов устройство управления получает от генератора такто-
вых импульсов. В УУ входят регистр команд – запоминающий регистр, в кото-
ром хранится код команды, дешифратор операций и т.д.; 
2) арифметико-логическое устройство (АЛУ) - предназначено для выполнения 
всех арифметических и логических операций над числовой и символьной ин-
формацией; 
3) математический сопроцессор - используется для ускоренного выполнения 
операций числами, для вычисления некоторых трансцендентных, в том числе 
тригонометрических, функций. Математический сопроцессор имеет свою сис-
тему команд и работает параллельно (совмещение во времени) с основным МП, 
но под управлением последнего; 
4) микропроцессорная память (МПП) - служит для кратковременного хра-
нения, записи и выдачи информации, непосредственно используемой в вычис-
лениях в ближайшие такты работы машины; 
5) регистры - быстродействующие ячейки памяти различной длины;  
6) интерфейсная система микропроцессора - реализует сопряжение и связь с 
другими устройствами ПК;  

2. Генератор тактовых импульсов - он генерирует последовательность 
электрических импульсов; частота генерируемых импульсов определяет такто-
вую частоту машины. 

Основными характеристиками процессоров являются разрядность и быст-
родействие. Разрядность — это число одновременно обрабатываемых бит. Бы-
стродействие — число выполняемых команд в секунду. Быстродействие связа-
но с  тактовой частотой, на которой работает процессор. Чем выше тактовая 
частота, тем выше и быстродействие. 

3. Источник питания - это блок, содержащий системы автономного и сете-
вого энергопитания ПК. 
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4. Таймер  - это внутримашинные электронные часы, обеспечивающие при 
необходимости автоматический съем текущего момента времени (год, месяц, 
часы, минуты, секунды и доли секунд).  

5. Системная шина - это основная интерфейсная система компьютера, 
обеспечивающая сопряжение и связь всех его устройств между собой. Систем-
ная шина обеспечивает три направления передачи информации: 

1) между микропроцессором и основной памятью; 
2) между микропроцессором и портами ввода-вывода внешних устройств; 
3) между основной памятью и портами ввода-вывода внешних устройств. 

Запоминающие устройства ПК 
Регистровая КЭШ-памятъ — высокоскоростная память сравнительно 

большой емкости, являющаяся буфером между ОП и МП. Используется для ус-
корения выполнения операций за счет запоминания на некоторое время полу-
ченных ранее данных, которые будут использоваться процессором в ближай-
шее время..  

Основная память делится на оперативное (RAM — Random Access Memory 
— память вольным доступом) и постоянное (ROM — Read-Only Memory) запо-
минающие устройство. 

Оперативное запоминающее устройство предназначено для хранения ин-
формации (программ и данных), непосредственно участвующей в вычисли-
тельном процессе на текущем этапе функционирования ПК. ОЗУ — энергоза-
висимая память: при отключении напряжения питания информация, хранящая-
ся в ней, теряется.  

Постоянное запоминающее устройство используется для хранения неизме-
няемой информации: загрузочных программ операционной системы, программ 
тестирования устройств компьютера и некоторых драйверов базовой системы 
ввода-вывода (BIOS — Base Input-Output System) и др. Из ПЗУ можно только 
считывать информацию, запись информации в ПЗУ выполняется вне ЭВМ в 
лабораторных условиях. ПЗУ — энергонезависимое запоминающее устройство. 

Внешние запоминающие устройства 
Внешние запоминающие устройства (ВЗУ) предназначены для долговре-

менного хранения программ и данных. Устройства выполняют в виде накопи-
телей, носителями информации в которых могут служить диски и ленты. Нако-
пители могут быть со сменными  носителями и со стационарными носителями 
информации. 

По способу доступа ВЗУ делятся на устройства прямого доступа и устрой-
ства последовательного доступа. Накопители на дисках — устройства прямого 
доступа, так как позволяют обратиться непосредственно к любому месту дис-
кового пространства. Накопители на магнитных лентах — устройства последо-
вательного доступа, так как доступ к нужной информации требует предвари-
тельного просмотра всей предыдущей.  

Основные характеристики ВЗУ— информационная емкость и время доступа. 
Диски относятся к машинным носителям с прямым доступом, это означает, 

что ПК может «обратиться» к дорожке, начинается участок с искомой инфор-
мацией или куда нужно записать нужную информацию, где бы ни находилась 
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головка записи/чтения накопителя.   
Магнитные диски (МД) относятся к магнитным машинным носителям ин-

формации. В качестве запоминающей среды у них используются магнитные 
материалы со специальными свойствами (с прямоугольной петлей гистерезиса), 
позволяющими фиксировать два магнитных состояния — два направления на-
магниченности. Каждому из этих состояний ставятся в соответствие двоичные 
цифры: 0 и 1. Диски бывают жесткими и гибкими, сменными и встроенными в 
ПК. Устройство для чтения и записи информации на магнитном диске называ-
ется дисководом. 

Все диски характеризуются своим диаметром или, иначе, формфактором. 
Информация на МД записывается и считывается магнитными головками 

вдоль концентрических окружностей — дорожек. Количество дорожек на МД и 
их информационная емкость зависят от типа МД, конструкции накопителя на 
МД, качества магнитных головок и магнитного покрытия. 

Каждая дорожка МД разбита на сектора. В одном секторе дорожки может 
быть помещено 128, 256, 512 или 1024 байт, но обычно 512 байт данных. Обмен 
данными между НМД и ОП осуществляется последовательно целым числом 
секторов. Кластер — это минимальная единица размещения информации на 
диске, состоящая из одного или нескольких смежных секторов дорожки. 

При записи и чтении информации МД вращается вокруг своей оси, а меха-
низм управления магнитной головкой подводит ее к дорожке, выбранной для 
записи или чтения информации. 

Накопители на дисках очень разнообразны. Существуют накопители на 
гибких магнитных дисках (НГМД), накопители на жестких магнитных дисках 
(НЖМД), накопители на оптических дисках. 

ВНЕШНИЕ УСТРОЙСТВА 
Внешние устройства ПК обеспечивают взаимодействие машины с окру-

жающей средой: пользователями, объектами управления и другими ЭВМ. ВУ 
весьма разнообразны и могут быть классифицированы по ряду признаков.  

1. Устройствам ввода информации. 
1) Клавиатура — устройство для ручного ввода числовой, текстовой и 

управляющей информации в ПК. С помощью клавиатуры управляют компью-
терной системой. 

2) Графические планшеты (диджитайзеры) - для ручного ввода графи-
ческой информации, изображений путем перемещения по планшету специаль-
ного указателя (пера).  

3) Сканеры (читающие автоматы) — для автоматического считывания с 
бумажных носителей и ввода в ПК машинописных текстов, графиков, рисун-
ков, чертежей.   

4) Цифровые фотокамеры. Как и сканеры, эти устройства воспринимают 
графические данные с помощью приборов с зарядовой связью, объединенных в 
прямоугольную матрицу.  

5) Манипуляторы (устройства указания) Они предназначены для ввода 
графической информации на экран дисплея путем управления движением кур-
сора по экрану с последующим кодированием координат курсора и вводом их в 
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ПК: 
a) джойстик—рычаг; 
b)  мышь, самый распространенный манипулятор. 
c) трекбол — шар в оправе, в отличие от мыши он устанавливается ста-

ционарно, и его шарик приводится в движение ладонью руки. 
d) световое перо;  
e) инфракрасная мышь отличается от обычной наличием устройства бес-

проводной связи с системным блоком и т.д. 
2. Устройства вывода информации. 

1. Принтеры — печатающие устройства для регистрации информации на 
бумажный носитель. Они являются наиболее развитой группой ВУ ПК и насчи-
тывают до 1000 разных модификаций. 

 1) Матричные принтеры.  
 Принцип печати этих принтеров состоит в том, что печатающая головка 

принтера, содержащая вертикальный ряд тонких металлических стержней (иго-
лок), движется вдоль печатаемой строки, а стержни в нужный момент ударяют 
по бумаге через красящую ленту, что обеспечивает формирование на бумаге 
символов и изображений. 

 2) Лазерные принтеры. 
 В лазерном принтере изображение создается лазерным лучом. Им управ-

ляет сложная электроника, которая позиционирует луч с высокой точностью. 
Луч рисует изображение на барабане внутри лазерного принтера. Там, где луч 
касается барабана, возникает электрический заряд. Барабан вращается над кар-
триджем с тонером, собирая тонер на электрически заряженные участки. Когда 
барабан входит в контакт с бумагой, тонерное изображение переводится на бу-
магу. Чтобы закрепить тонер на бумаге, используется тепло. Качество печати 
приближается к типографскому.  

 3) Струйные принтеры. 
В этих принтерах изображение формируемся микрокаплями специальных 

чернил, выдуваемых на бумагу с помощью сопел. Этот способ печати обеспе-
чивает более высокое качество печати по сравнению с матричными принтера-
ми, он позволяет получить на специальной бумаге высококачественное цветное 
изображение. Однако струйные принтеры дороже матричных и требуют более 
тщательного ухода и обслуживания. Скорость печати струйных принтеров 
примерно от 10 до 60 с на страницу.  

2. Графопостроители (плоттеры) — для вывода графической информации 
(графиков, чертежей, рисунков) из ПК на бумажный носитель. 
 3. Монитор - это устройство визуального представления данных. Его ос-
новными потребительскими параметрами являются: размер, шаг маски экрана, 
максимальная частота регенерации изображения, класс защиты. 

3. Средства связи и телекоммуникации 
1. Модем - коммуникационное устройство, позволяющее передавать цифро-

вые данные по аналоговой телефонной линии. Он осуществляет преобразование 
данных с компьютера в последовательность дискретных (разнотипных) сигналов и 
их отправку по аналоговой телефонной линии. На другом конце они расшифровы-
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ваются принимающим модемом путем аналого-цифрового преобразования.  
 2. Факс-модем - это устройство, сочетающее возможности модема и средст-

ва для обмена факсимильными изображениями с другими факс-модемами и обыч-
ными телефаксными аппаратами.  

4. Устройства речевого ввода-вывода. 
Эти устройства относятся к быстроразвивающимся средствам мультимедиа. 

Устройства речевого ввода — это различные микрофонные акустические системы, 
"звуковые мыши", например, со сложным программным обеспечением, по-
зволяющим распознавать произносимые человеком буквы и слова, идентифициро-
вать их и закодировать. 

Устройства речевого вывода — это различные синтезаторы звука, выпол-
няющие преобразование цифровых кодов в буквы и слова, воспроизводимые через 
громкоговорители (динамики) или звуковые колонки, подсоединенные к компью-
теру. 

 Средства мультимедиа (multimedia — многосредовость) — это комплект ап-
паратных и программных средств, позволяющих человеку общаться с компьюте-
ром, используя самые разные, естественные для себя среды: звук, видео, графику, 
тексты, анимацию и др. К средствам мультимедиа относятся устройства речевого 
ввода и вывода информации; высококачественные видео- (video-) и, звуковые 
(sound-) платы, платы видеозахвата (videograbber), снимающие изображение с ви-
деомагнитофона или видеокамеры и вводящие его в ПК; высококачественные аку-
стические и видеовоспроизводящие системы с усилителями, звуковыми колонка-
ми, большими видеоэкранами, а так же внешние запоминающие устройства боль-
шой емкости на оптических дисках, часто используемые для записи звуковой и 
видеоинформации. 

Тема. Программное обеспечение ПК. 
Программное обеспечение – совокупность программ обработки данных. 
Программа – упорядоченная последовательность команд (инструкций) ком-

пьютера для решения задачи. 
Программный продукт - комплекс взаимосвязанных программ для решения 

определенной задачи массового спроса, подготовленный к реализации как любой 
вид промышленной продукции. 

 Интегрированное программное обеспечение — набор нескольких программ-
ных продуктов, функционально дополняющих друг друга, поддерживающих еди-
ные информационные технологии, реализованные на общей вычислительной и 
операционной платформе. 

Программное обеспечение можно классифицировать по разным признакам. 
Рассмотрим классификацию по сфере (области) использования программного 
обеспечения: 

 

 

Программное обеспечение (ПО) 

Системное ПО Прикладное ПО Инструментарий технологий про-
граммирования 
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Системное программное обеспечение 

Системное программное обеспечение - совокупность программ и про-
граммных комплексов для обеспечения работы компьютера и компьютерных 
сетей. 

 
Базовое программное обеспечение 

Базовое программное обеспечение - минимальный набор программных 
средств, обеспечивающих работу компьютера. 

1. Операционная система - совокупность программ, предназначенных для 
управления ресурсами ЭВМ, организации диалога пользователя с ЭВМ, испол-
нения программ пользователя. 

Основная функция всех операционных систем - посредническая. Она за-
ключается в обеспечении нескольких видов взаимодействия (интерфейса): 
− интерфейс пользователя (взаимодействие между пользователем и программ-

но-аппаратными средствами компьютера); 
− аппаратно-программный интерфейс (взаимодействие между программным и 

аппаратным обеспечением); 
− программный интерфейс (взаимодействие между разными видами про-

граммного обеспечения). 
Программы, работающие под управлением операционной системы, назы-

вают приложениями.  
Операционные системы для персональных компьютеров можно классифи-

цировать по нескольким признакам: 
1) По реализации интерфейса. 
Различают неграфические (текстовые) и графические операционные сис-

темы. Неграфические операционные системы (MS DOS) реализуют интерфейс 
командной строки. Основным устройством управления в данном случае являет-

Системное программное обеспечение 

Базовое программное обеспечение Сервисное программное обеспечение 

Операционная система 

Операционная оболочка 

Сетевая операционная система 

Программы диагностики работо-
способности компьютера 

Антивирусные программы 

Программы обслуживания 
 дисков 

Программы архивирования данных 

Программы обслуживания сети 
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ся клавиатура. 
Работа в графической ОС основана на взаимодействии активных и пассив-

ных экранных элементов управления. В качестве активного элемента управле-
ния выступает указатель мыши, в качестве пассивных элементов управления 
выступают экранные кнопки, значки, переключатели, флажки, списки,  меню и 
многое другое. 

2) Поддержка многозадачности. 
Однозадачные операционные системы (Ms-Dos) передают все ресурсы вы-

числительной системы одному исполняемому приложению. 
 Многозадачность допускает параллельное выполнение нескольких при-

ложений. Различают вытесняющую и невытесняющую многозадачность. 
При невытесняющей многозадачности (NetWare) активный процесс вы-

полняется до тех пор, пока он сам по собственной инициативе, не отдаст управ-
ление операционной системе для того, чтобы та выбрала из очереди другой го-
товый к выполнению процесс. При вытесняющей многозадачности (Windows 
95/98/2000, Windows NT, OS/2, Unix) решение о переключении процесса с од-
ного на другой принимается операционной системой, а не самим активным 
процессом. 

3) Поддержка многопользовательского режима. 
В зависимости от числа пользователей, одновременно работающих с ОС, 

ОС делятся на однопользовательские (Ms DOS, ранние версии OS/2) и много-
пользовательские (Unix, Windows NT). Многопользовательские ОС позволяют 
нескольким пользователям разделять вычислительные ресурсы одного компью-
тера.  

4) Поддержка переносимости (непереносимые и переносимые на другие 
типы компьютеров); 

5) Поддержка работы в сетях (несетевые и сетевые). 
2. Операционные оболочки - специальные программы, предназначенные 

для облегчения общения пользователя с командами операционной системы.  
3. Сетевые операционные системы – комплекс программ, обеспечивающий 

обработку, передачу и хранение данных в сетях. 
Сервисное программное обеспечение 

Сервисное программное обеспечение (программы-утилиты) — программы и 
программные комплексы, которые расширяют возможности базового программно-
го обеспечения и организуют более удобную среду работы пользователя. 

1. Программы диагностики работоспособности компьютера и обслужива-
ния дисков (служебные программы). 

1) Форматирование диска (Format) – разбиение диска на дорожки и секто-
ра. 

2) Дефрагментация диска (Disk Defragments) – процедура по переносу ин-
формации из одних кластеров в другие, в результате которой доступ к любой 
информации будет более быстрым. 

3) Проверка диска (Scandisk) – программа обнаружения ошибок, связанных 
со сбоями в процессе записи на диск. 

4) Корзина - восстановление удаленных файлов. 
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5) Очистка диска – программа освобождает место на диске путем удаления 
временных файлов (в корзине, из Интернета, для быстрого просмотра). 

6) Сведения о ресурсах (Sistem Information) – параметры аппаратного 
обеспечения; программная среда; программа отображает неполадки компьюте-
ра, но не устраняет их. 

2. Программы архивирования данных. 
Архивный файл – это специальным образом организованный файл, содер-

жащий в себе один или несколько файлов в сжатом или несжатом виде и слу-
жебную информацию об именах файлов, дате и времени их создания или моди-
фикации, размерах и т. п. 

Архивация (упаковка) – помещение (загрузка) исходных файлов в архив-
ный файл в сжатом или несжатом виде. 

Цели сжатия файлов: 
− обеспечение более компактного размещения информации на диске; 
− сокращение времени и стоимости передачи информации по каналам связи в 

сетях; 
− упрощение переноса файлов с одного диска на другой; 
− защита информации от несанкционированного доступа; 
− защита от заражения вирусами. 

Степень сжатия информации характеризуется коэффициентом сжатия: 

%100
0

⋅=
V
V

K c
c , где Vс – объем сжатого файла, V0 – объем исходного файла. 

Хорошо сжимаются графические и текстовые файлы. Слабо сжимаются 
файлы исполняемых программ. 

Разархивация (распаковка) – процесс восстановления файлов из архива 
точно в таком виде, какой они имели до загрузки в архив. При распаковке фай-
лы извлекаются из архива и помещаются на диск или в оперативную память.  

Наиболее распространенные программы – архиваторы: WinRAR и WinZIP. 
3. Антивирусные программы. 

Компьютерным вирусом называется специально написанная программа, 
способная самопроизвольно присоединяться к другим программам, создавая 
свои копии и внедряя их в файлы, системные области компьютера и в вычисли-
тельные сети с целью нарушения работы программ, порчи файлов и каталогов, 
создания всевозможных помех в работе на компьютере. 

Признаки появления вирусов: 
− прекращение работы или неправильная работа программы; 
− невозможность загрузки операционной системы; 
− увеличение размера файлов; 
− исчезновение файлов и каталогов или искажение их содержимого; 
− увеличение размера свободной памяти; 
− подача непредусмотренных звуковых сигналов. 

Классификация вирусов 
1. По среде обитания: сетевые, файловые, загрузочные, файлово-

загрузочные. 
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2. По способу заражения: резидентные, нерезидентные. 
3. По степени воздействия: неопасные, опасные, очень опасные. 
4. По особенности алгоритмов: паразитические, репликаторы, невидимки, 

мутанты, троянские. 
Антивирусная программа – это программа, предназначенная для обнаруже-

ния, удаления и защиты от компьютерных вирусов. 
Классификация антивирусных программ 

1. Детекторы - осуществляют поиск характерной для конкретного вируса после-
довательности байтов в оперативной памяти и в файлах и при обнаружении выда-
ют соответствующее сообщение. 
2. Доктора - находят зараженные вирусами файлы и «лечат» их, т. е. удаляют из 
файла тело программы вируса, возвращая файлы в исходное состояние. 
3. Ревизоры – запоминают исходное состояние программ, каталогов и системных 
областей диска до заражения вирусом, а затем периодически или по желанию 
пользователя сравнивают текущее состояние и исходным 
4. Фильтры - предназначены для обнаружения подозрительных действий при ра-
боте компьютера. 
5. Вакцины – резидентные программы, предотвращающие заражение файлов. 

Прикладное программное обеспечение 
1. Текстовые редакторы. 
Основные функции текстовых редакторов заключаются в автоматизации вво-

да и редактирования текстовых данных. 
В отличие от текстовых редакторов, текстовые процессоры позволяют не 

только вводить и редактировать текст, но и форматировать его, т.е. оформлять. 
Соответственно, к основным средствам текстовых процессоров относятся средства 
обеспечения взаимодействия текста, графики, таблиц и других объектов. 

Назначение настольных издательских систем состоит в автоматизации про-
цесса верстки полиграфических изданий. 

2. Графические редакторы. 
3. Системы управления базами данных (СУБД).  
4. Электронные таблицы. 
5. Системы автоматического проектирования. 
6. Системы автоматизированного управления. 
7. Офисные приложения. 
8. Экспертные системы. 
9. Редакторы HTML (Web- редакторы). 
10. Геоинформационные системы (ГИС) 
11. Автоматизация научно-исследовательских работ. 
12. Программные средства мультимедиа. 
13. Системы видеомонтажа. 
14. Компьютерная обработка звука. Музыкальные редакторы. 
15. Обучающие программы. 

Тема. Операционная система Windows: диалог “человек-компьютер”.  
Основные характеристики и история создания. 

Первая графическая многооконная операционная оболочка Windows фир-
мы Microsoft появилась в 1986 г. После своего возникновения  она пережила 
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ряд модификаций, но не все из них были удачными. Однако в 1991 г. вышла 
версия операционной среды Windows 3.1 и несколько позже сетевой вариант 
Windows 3.11 For WorkGroups, завоевавшие широкое признание миллионов 
пользователей.  Дальнейший ряд Windows-продуктов продолжили высокопро-
изводительные многозадачные, полнофункциональные операционные системы 
с графическим интерфейсом Windows 95, Windows 98, Windows 2000 для ком-
пьютеров платформы IBM PC. 

Основными характеристическими чертами операционной системы 
Windows 95 являются: 
1. Единый графический пользовательский интерфейс, который составляют ра-

бочий стол, окна, панель задач и другие графические объекты (кнопки, пик-
тограммы, списки и т.п.). 

2. Интегрированная операционная система, ядро которой загружается в момент 
включения компьютера, активизирует графический интерфейс пользователя 
и обеспечивает полную совместимость с операционной системой MS-DOS. 

3. Объектно-ориентированная система. 
4. Программная совместимость обеспечение полной независимости программ 

от аппаратной части компьютера. 
5. Вытесняющая многозадачность - свойство операционной системы самостоя-

тельно в зависимости от внутренней ситуации передавать или забирать 
управление у того или иного приложения, не позволяющее одному прило-
жению занять все аппаратные ресурсы. 

6. 32-разрядная операционная система, поддерживающая 16-разрядные прило-
жения без всякой их модификации. 

7. Многопоточность - свойство операционной системы выполнять операции 
одновременно над потоками нескольких 32-битовых приложений. Поток - 
это некоторая часть процесса, который может быть выделено процессорное 
время для одновременного выполнения наряду с другими потоками.  

8. Сетевые возможности. Хотя ОС Windows предназначена для управления ав-
тономным компьютером, но также содержит все необходимые средства для 
создания небольшой локальной одноранговой сети: совместное использова-
ние ресурсов файлового сервера, принтеров, факс-модемов. Windows 95 
имеет средства для интеграции компьютера во всемирную сеть: использова-
ние электронной почты и других средств коммуникации. 

9. Средства обмена данными между приложениями: буфер обмена (Clipboard), 
технологии DDE (Dynamic Data Exchange), OLE (Object Linking and 
Embedding).   

10. Интерфейс мультимедиа, включает в себя лазерный проигрыватель (CD-
плеер), обеспечивает поддержку видеодисков и видеомагнитофонов и т.п. 

11. Поддержка длинных имен файлов и папок (до 255 символов). 
12. Использование технологии Plug and Play ("включи и работай") позволяет 

осуществляет функции распознания новых устройств для их установки и 
настройки, при этом обеспечивает динамическое изменение конфигурации 
системы и автоматического уведомления об этом программных приложе-
ний.  
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13. Реализация принципа WYSIWYG -What You See Is What You Get ("что ви-
дишь, то и получаешь"). Принцип реализуется при выводе на печать ин-
формации, полностью соответствующей изображению на экране. 

14. Технология AutoPlay позволяет автоматически озвучивать работу с Windows 
при установленных средствах мультимедиа. 

15. Режим MouseKeys позволяет все действия с мышью выполнять через кла-
виатуру). 
По сравнению с Windows 95, Windows 98 включает средства, позволяющие 

компьютеру работать быстрее без добавления нового оборудования. В состав 
Windows 98 входит ряд программ, совместное применение которых повышает 
производительность компьютера: 
a) Служебные программы позволяют быстрее выполнять программы, прове-

рять жесткий диск на наличие ошибок и освобождать место на диске, обес-
печивать бесперебойную работу системы. 

b) Проверка диска запускается автоматически после неверного выключения 
ОС. 

c) Новый Web-узел ресурсов Microsoft Windows Update автоматизирует про-
цесс обновления драйверов и системных файлов и обеспечивает новейшие 
возможности технической поддержки. 

d) Обозреватель Интернета Internet Explorer делает ряд функций доступными с 
рабочего стола Windows: каналы Web - узлов на рабочем столе, возможно-
сти поиска в Интернет, панели обозревателя. Приложение Internet Explorer 
объединяет рабочий стол  с Web, благодаря чему рабочий стол и его папки 
будут выглядеть и действовать так же, как при работе с Web. Такой рабочий 
стол называется Active Desktop. 
Главными новыми технологическими решениями, реализованных в 

Windows 2000, являются расширение сетевых возможностей и усовершенство-
вание функций защиту информации в сетях. Windows 2000 оснащена целым ря-
дом свойств управления клиентами и серверами, позволяющих снизить общую 
стоимость эксплуатации операционной системы. 

Основные элементы графического интерфейса Windows. 
Задача интерфейса - сделать компьютер доступнее, понятнее для пользова-

теля.  
По замыслу разработчиков, общий вид монитора ассоциируется с видом 

обычного рабочего стола, на котором располагаются документы (окна, подоб-
ные листам бумаги).    

Рабочий стол (DeskTop) - все  пространство экрана в среде Windows с рас-
положенными на нем графическими объектами. 

Вдоль одной из границ (чаще в нижней части) рабочего стола находится 
панель задач. Панель задач содержит: 
a) кнопку ПУСК - главное системное меню; 
b) доступ ко всем открытым приложениям. При открытии приложения на па-

нели задач появляется соответствующая открытому окну кнопка. Нажатие 
этой кнопки позволяет быстро перейти в выбранное окно.  
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c) пиктограммы специальных "фоновых" приложений: часы, индикатор теку-
щей раскладки клавиатуры и др. 
Главное системное меню предназначено для быстрого запуска программ, 

поиска файлов, обеспечения доступа к справке, вызов панели управления для 
настройки компьютера и др. Меню содержит в себе несколько пунктов, при 
подведении указателя мыши на одном из пунктов автоматически открывается 
подменю для выбора нужной операции. 
1. Пункт Программа позволяет запускать программы. 
2. Пункт Документы содержит ярлыки 15 последних открывавшихся докумен-
тов. 
3. Пункт Избранное характерен для ActiveDesktop и позволяют осуществлять 
доступ к средствам всемирной сети. 
4. Пункт Настройка позволяет настраивать: панель задач, в том числе пункты 
главного меню; панель управления, доступ к которой также можно получить 
через папку Мой Компьютер; свойства папки Принтеры и др. 
5. Пункт Найти позволяет осуществлять поиск папок и файлов на дисках ком-
пьютера, в локальной сети, в Интернет. Поиск можно осуществлять, используя 
маску файлов, дату создания файла, по типу файла, его размеру, поиск по тек-
сту. 
6. Пункт Справка выводит справку по работе с Windows. 
7. Пункт Выполнить позволяет запускать программы на исполнение, при этом 
необходимо указать путь и имя запускаемого файла. 
8. Пункт Завершение работы необходим для корректного завершения работы с 
Windows, перезагрузки компьютера, перезагрузки с выходом в режим MS-DOS.  

На рабочем столе размещено несколько графических объектов - ярлыков. 
Ярлык - маленький файл-указатель, с помощью которого можно быстро 

получить доступ к объекту (файлу, каталогу, диску, программе). 
Ярлык представлен в виде значка (пиктограммы) и названия. Двойной 

щелчок по ярлыку открывает объект, с которым он связан. 
Основными объектами файловой структуры Windows являются файл, ка-

талог, ярлык.  С этими объектами можно проделывать следующие операции: 
создавать, переименовывать, удалять, копировать, перемещать и другие. В 
Windows, по аналогии с обычными терминами, принято называть каталог - пап-
кой, файл - документом. 

Изначально на Рабочем столе расположены значки «Мой компьютер», 
«Сетевое окружение», «Корзина» и «Портфель».   

 Мой компьютер отражает содержание всего компьютера целиком. Папка 
позволяет просмотреть содержимое находящихся на компьютере дисков, дос-
туп к панели управления, сетевому окружению. 

Сетевое Окружение - обеспечивает доступ к ресурсам сети, если к ней под-
ключен компьютер. 

В Портфель, как и в обычный дорожный портфель, в котором носят нуж-
ные документы, помещают файлы и папки, с которыми пользователь работает 
на нескольких компьютерах: дома и на работе, на настольном и переносном 
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компьютере в дороге. Портфель содержит базу данных, позволяющую сопоста-
вить несколько вариантов одного документа и выбрать оптимальный.  

Корзина  - специальная папка, предназначена для временного хранения 
удаленных файлов, папок, ярлыков. Она позволяет восстановить объекты, уда-
ленные по ошибке. Размер корзины устанавливает пользователь. По мере рабо-
ты следует регулярно очищать корзину, особенно когда возникают проблемы 
со свободным дисковым пространством.  

Структура окна в Windows. 
Окно - прямоугольная область экрана, в которой может отображаться при-

ложение, документ или сообщение. 
Окно может быть представлено в виде: свернутое на панель задач (мини-

мизировано), нормальное (окно с обрамление), полноэкранное окно (распахну-
тое на весь экран). 

Любое окно Windows имеет ряд стандартных элементов.  
Системное меню содержит команды для изменения размеров окна, его пе-

ремещения, минимизации, закрытия. 
Заголовок окна является удобным управляющим элементом для переме-

щения окна. В заголовке окно отображается название приложения и документа 
(имя открытого файла). 

Строка меню содержит пункты для открытия ниспадающего меню. 
Контекстное меню (всплывающее меню) появляется при нажатии правой 

кнопки мыши и содержит активные команды для данного объекта.  
Рабочее поле окна представляет собой область для размещения окна доку-

мента, и которая будет пустой, пока ни один документ не открыт. 
Рамка окна - двойная линия, обрамляющая нормальное окно. Она служит 

управляющим элементом для изменения размеров окна.  
Линейки (полосы) прокрутки окаймляют левую и нижнюю стороны окна и 

служат для перемещения (прокрутки) документа по вертикали и горизонтали. 
Панели инструментов представляют собой линейки командных кнопок, 

предназначенных для быстрого вызова той или иной команды мышью. 
Строка состояния  находится у нижнего края окна и содержит информа-

цию о режимах работы приложения. 
Виды окон 

1. Окно приложения представляют собой интерфейсы работающих прило-
жений. Главным свойством окон приложений  является то, что они могут пере-
крывать друг друга и являются независимыми, т.е. не подчинены никакому 
другому окну. 

2. Окно документа  всегда подчинены окнам своих приложений и не выхо-
дят за их пределы. 

3. Диалоговое окно служит для ввода дополнительных параметров, необ-
ходимых для выполнения какой-либо команды. 

Активное окно - окно приложения, реагирующее в данный момент на дей-
ствия пользователя. Заголовок активного окна отличается по цвету и яркости от 
неактивного. 
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Тема. Текстовые редакторы.  
Основные функции текстовых редакторов заключаются в автоматизации 

ввода и редактирования текстовых данных. 
В отличие от текстовых редакторов, текстовые процессоры позволяют не 

только вводить и редактировать текст, но и форматировать его, т.е. оформлять. 
Соответственно, к основным средствам текстовых процессоров относятся сред-
ства обеспечения взаимодействия текста, графики, таблиц и других объектов. 

Назначение настольных издательских систем состоит в автоматизации 
процесса верстки полиграфических изданий. 

Рассмотрим один из текстовых процессоров – Ms Word, который является 
приложением Windows. 

Структура окна Word типична для приложений Windows. После установки 
программы в ней по умолчанию присутствуют две панели инструментов – 
Стандартная и Форматирование. Если в ходе работы возникает необходимость 
в других панелях инструментов, их можно открыть и расположить вдоль любой 
границы окна или отдельно. 

Основные приемы работы в Word: 
1. Форматирование страниц. 

При форматировании страниц задают отступы и ориентацию бумаги. Для 
этого необходимо выбрать Файл → Параметры страницы. В появившемся окне 
Параметры страницы задаются поля (отступы) страницы и ориентация (книж-
ная или альбомная). 

Для введения нумерации страниц в создаваемом документе необходимо 
выбрать Вставка → Номера страниц. В появившемся окне Номера страниц за-
дается формат номеров страниц. Номера страниц проставляются в колонтиту-
лах. 

Колонтитулы представляют собой одну или несколько строк, помещаемых 
в начале или конце каждой страницы документа. Для расстановки колонтиту-
лов необходимо выбрать Вид → Колонтитулы.  

Можно установить колонтитулы для первой страницы, а так же для четных 
и нечетных страниц. Для этого необходимо выбрать Файл → Параметры стра-
ницы. В появившемся окне выбрать вкладку Источник бумаги и задать распо-
ложение колонтитулов. 

2. Форматирование шрифта. 
Для форматирования шрифта необходимо выбрать Формат → Шрифт. 
В появившемся окне Шрифт задаются: размер (14 пт – деловой документ, 

12 пт – документ Internet, 8 пт - газета); название; интервал между буквами (уп-
лотненный, обычный, разреженный); цвет; параметры (жирный, курсив, под-
черкнутый и др.); анимация для вводимого текста. 

3. Форматирование абзаца. 
Для форматирования шрифта необходимо выбрать Формат → Абзац. 
В появившемся окне Абзац задаются отступы слева, справа; отступ для 

первой строки; межстрочный интервал; выравнивание текста (по ширине, по 
центру, по краям). 
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Тема. Электронные таблицы. 
Электронная таблица (ЭТ) – компьютерный эквивалент обычной таблицы, в 

клетках (ячейках) которой записаны данные различных типов: тексты, даты, фор-
мулы, числа. 

Для управления ЭТ используется табличный процессор. 
Рабочая область ЭТ состоит из строк и столбцов, имеющих свои имена. Име-

на строк – это их номера. Нумерация строк начинается с 1 и заканчивается макси-
мальным числом, установленным для данной программы. Имена столбцов – это 
буквы латинского алфавита сначала от А до Z, затем от АА до AZ, BA до BZ и т. д. 

Пересечение строки и столбца образует ячейку таблицы, имеющую свой уни-
кальный адрес. Для указания адресов ячеек в формулах используются ссылки (на-
пример, А2 или С4). 

В ЭТ существует понятие блока (диапазона) ячеек. Блок ячеек – группа по-
следовательных ячеек, может состоять из одной ячейки, строки (или ее части), 
столбца (или его части), а также последовательности строк или столбцов (или их 
частей). Адрес блока ячеек задается указанием ссылок первой и последней его 
ячеек, между которыми ставится разделительный символ – двоеточие <:> или две 
точки подряд <..>. 

Пример. G3, A1:H1, B1:B10, D4:F5. 
Каждая команда ЭТ требует указания блока (диапазона) ячеек, в отношении 

которых она должна быть выполнена. 
Блок используемых ячеек может быть указан двумя путями: либо непосредст-

венным набором с клавиатуры начального и конечного адресов ячеек, формирую-
щих диапазон, либо выделением соответствующей части таблицы при помощи 
клавиш управления курсором. Удобнее задавать диапазон выделением ячеек. 

Текущей (активной) называется ячейка ЭТ, в которой в данный момент нахо-
дится курсор. Адрес и содержимое текущей ячейки выводятся в строке ввода ЭТ. 

Каждый документ представляет собой набор таблиц – рабочую книгу, которая 
состоит из одного или многих рабочих листов. 

В каждую ячейку ЭТ пользователь может ввести данные одного из следую-
щих типов: 

 
Формулы – это выражения, состоящие из числовых величин, адресов ячеек 

и функций, соединенных знаками арифметических операций. Написание фор-
мулы начинается со знака равенства (=). 

Типы данных 

Символьные 
(текстовые) 
данные имеют 
описательный 
характер. Они 
могут включать 
в себя алфавит-
ные, числовые и 
специальные 
символы. 

Числовые данные 
не могут содер-
жать алфавитных и 
специальных сим-
волов, поскольку с 
ними производят 
математические 
операции 

Формулы – могут 
включать ряд 
арифметических, 
логических и про-
чих действий, про-
изводимых с дан-
ными из других 
ячеек. 

Даты Функции представляют 
собой программы с уни-
кальным именем (част-
ный случай формулы). 
Различают статистиче-
ские, логические, финан-
совые и др. функции. 
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Пример. =(А1+В1)/С2. 
При копировании или перемещении формулы необходимо организовать 

управление формированием адресов исходных данных. Для этого при написа-
нии формул используются понятия относительной и абсолютной ссылок. 

Абсолютная ссылка – это не изменяющийся при копировании и перемеще-
нии формулы адрес ячейки, содержащий исходное данное.  

Для указания абсолютной адресации вводится символ $. Различают два ти-
па абсолютной ссылки: полная и частичная. 

Полная абсолютная ссылка указывается, если при копировании или пере-
мещении адрес клетки, содержащий исходное данное, не меняется. Для этого 
символ $ ставится перед наименованием столбца и номером строки. 

Пример. $B$5; $D$12 
Частичная абсолютная ссылка указывается, если при копировании или пе-

ремещении не меняется номер строки или наименование столбца. При этом 
символ $ ставится перед номером строки, а во втором случае – перед наимено-
ванием столбца. 

Пример. B$5; D$12; $B5; $D12 
При абсолютной адресации копируемая формула не изменяется. 
Относительная ссылка – это изменяющийся при копировании и перемеще-

нии формулы адрес ячейки, содержащий исходное данное. Изменение адреса 
происходит по правилу относительной ориентации клетки с исходной форму-
лой и клеток с данными. 

Пример: В ячейку С1 занесена формула =A$1+$B2. Перенести эту фор-
мулу в ячейки D2, E4. 

 
Функция представляет собой программу с уникальным именем, для кото-

рой пользователь должен задать конкретные значения аргументов, стоящих в 
скобках после ее имени. 

Функция имеет синтаксис написания: начинается с указания имени функ-
ции, затем вводится открывающаяся скобка, указываются аргументы, отде-
ляющиеся «;», а затем – закрывающаяся скобка. 

Рассмотрим синтаксис и примеры задания наиболее используемых функций. 
− Логические функции. 

Логические функции предназначены для проверки выполнения условия 
или для проверки нескольких условий. 
3. ЕСЛИ используется для условной проверки значений и формул. Возвращает 

одно значение, если заданное условие при вычислении дает значение ИС-
ТИНА, и другое значение, если ЛОЖЬ. 

Синтаксис: 
ЕСЛИ(лог_выражение;значение_если_истина;значение_если_ложь) 

Пример. ЕСЛИ(А10>В1;В5/В1;10) 
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− Статистические функции. 
Синтаксические функции позволяют выполнять статистический анализ 

диапазонов данных. 
− СРЗНАЧ возвращает среднее арифметическое значение своих аргументов. 

Синтаксис: СРЗНАЧ(число1;число2;…), 
где число1, число2, … - это от 1 до 30 аргументов, для которых вычисляется 
среднее значение. 

Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то 
СРЗНАЧ(А1:А5) равняется 11. 
− СЧЕТ подсчитывает количество чисел в списке аргументов, используется для 

получения количества числовых ячеек в интервалах или массивах ячеек. 
Синтаксис: СЧЕТ(значение1;значение2;…). 

Пример. Если ячейки А1:А7 содержат числа, то СЧЕТ(А1:А7) возвращает 
число 7. 
− МАКС возвращает наибольшее значение из набора значений. 

Синтаксис: МАКС(число1;число2;…). 
Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то МАКС(А1:А5) 

равняется 27. 
− МИН возвращает наименьшее значение из набора значений. 

Синтаксис: МИН(число1;число2;…). 
Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то МИН(А1:А5) 

равняется 2. 
− Арифметические и тригонометрические функции. 
Арифметические и тригонометрические функции позволяют производить 

простые и сложные математические вычисления. 
1. СУММ суммирует все числа в интервале ячеек. 

Синтаксис: СУММ(число1;число2;…). 
Пример. Если ячейки А2:Е5 содержат числа 5, 15, 30, 40 и 50, то 

СУММ(А2:Е5) равняется 50. 
ЭТ располагает рядом команд для построения различных типов диаграмм: 

круговая диаграмма, линейный график и т. д. 
Тема. Электронные презентации. 

Создание новой презентации 
При запуске MS PowerPoint появляется диалоговое окно, которое имеет че-

тыре переключателя, позволяющих:  
− Создать новую презентацию используя мастер автосодержания, шаблон пре-

зентации, пустую презентацию.  
− Открыть имеющуюся презентацию.  

Мастер автосодержания помогает выбрать один из нескольких шаблонов 
содержания и способы его оформления. Шаблон представляет собой презента-
цию с заранее установленными цветами слайда и текстовыми стилями. На каж-
дом шаге мастер автосодержания запрашивает определенную информацию о 
создаваемой презентации. По завершении работы мастера создается презента-
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ция в режиме структуры с титульным слайдом и несколькими слайдами с заго-
ловками, в которые затем можно добавить собственный текст и рисунки.  

При выборе переключателя шаблон оформления открывается диалоговое 
окно Создать презентацию с шаблонами. В диалоговом окне имеются вкладки 
Презентации и Шаблоны оформления для создания презентаций по шаблонам.  

После выбора переключателя Пустая презентация также открывается диа-
логовое окно с 24 макетами разметки слайдов. В новой презентации использу-
ются цветовая схема, стиль заголовка и стили текста презентации, принимае-
мые по умолчанию. 

Переключатель Открыть презентацию позволяет открыть существующую 
презентацию MS PowerPoint. 

Если MS PowerPoint уже запущен, то можно создать новую презентацию: 
− используя мастер автосодержания командой Файл → Создать, выбрать 

вкладку Общие, затем Мастер автосодержания; 
− по шаблону командой Файл → Создать, выбрать вкладку Презентации или 

Шаблоны оформления; 
− без использования шаблона командой Файл → Создать, выбрать вкладку 

Общие, затем Новая презентация или использовать кнопку Создать на Стан-
дартной панели инструментов. 

Создание слайдов по разметке 
При создании нового слайда можно выбрать один из макетов. Каждый из 

них предлагает свою композицию содержимого, соответствующую определен-
ному назначению слайда. Макет предусматривает, что в каждой зоне слайда 
будет располагаться определенный вид информации. Существует макет, вклю-
чающий рамки для заголовка, текста и диаграммы; в другом макете предусмот-
рены места для заголовка и картинки. Рамка с пунктирным контуром изобража-
ется на создаваемом слайде и обозначает место для размещения таких объектов 
как заголовок слайда, текст, диаграмма и т.п. Например, диаграмма будет рас-
полагаться только справа, а текст только слева. Расположение, размер и формат 
рамок допускается изменять. Чтобы изменить макет уже созданного слайда, 
нужно воспользоваться командой Формат → Разметка слайда… или нажать 
кнопку Разметка слайда на панели инструментов Стандартная, затем выбрать 
новую разметку. Отсутствие нужных рамок в новой разметке не приведет к по-
тере данных. 

Режимы PowerPoint 
Режимами называются способы отображения и работы над презентацией. 

Кнопки в нижней части окна презентации позволяют переходить от одного ви-
да режима к другому. Также все эти режимы доступны из меню Вид. 

В Обычном режиме отображаются три области: область структуры, об-
ласть слайда и область заметок. Эти области позволяют одновременно работать 
над всеми аспектами презентации. Размеры областей можно изменять, перетас-
кивая их границы. 

Область структуры служит для организации и развертывания содержимого 
презентации. В ней можно вводить текст презентации и упорядочивать пункты 
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списка, абзацы и слайды. В области слайда отображается текст каждого слайда 
с учетом форматирования. На отдельные слайды можно добавлять рисунки, 
фильмы, звуки, анимацию и гиперссылки. Область заметок служит для добав-
ления заметок докладчика или сведений для аудитории. 

В Режиме структуры презентация изображается в сокращенном виде: толь-
ко заголовки слайдов и содержащийся в них текст. В верхнем правом углу на-
ходится окно для просмотра текущего слайда. Оно позволяет отслеживать ход 
заполнения слайда текстом, чтобы вовремя перейти на новый слайд. 

Перед заголовком каждого слайда стоит номер и значок. Основной текст, 
включающий до пяти уровней отступов, расположен после каждого заголовка. 
Работа со структурой является наилучшим вариантом организации и развития 
презентации, так как в процессе работы на экране отображаются все заголовки 
и основной текст. Можно поменять местами пункты на слайде, переместить 
слайд целиком с одной позиции в другую и изменить заголовки и основной 
текст. Например, чтобы упорядочить слайды или пункты маркированного спи-
ска, нужно выбрать значок слайда или маркер, соответствующий тексту, кото-
рый требуется переместить, и перетащить его в другую позицию. 

В Режиме слайдов создают и редактируют отдельные элементы слайдов: 
текст в метках-заполнителях, объекты (графику, звук и т.п.), дополнительные 
тексты, фигуры, собственные рисунки и т.д. С одного слайда на другой пере-
ключаются при помощи вертикальной полосы прокрутки, а также клавишами 
Page Up и Page Down. 

В Режиме сортировщика слайдов  на экране в миниатюре отображаются 
сразу все слайды презентации в том порядке, в каком их будут показывать во 
время выступления. Это упрощает добавление, удаление (клавиша Delete), ко-
пирование (клавиша Ctrl) и перемещение слайдов, задание времени показа 
слайдов и выбор способов их смены. Кроме того, можно просматривать анима-
цию на нескольких слайдах, выделив требуемые и выполнив команду Показ 
слайдов → Просмотр анимации. Чтобы поменять местами один или несколько 
слайдов, нужно выбрать их и перетащить в новое место. 

В Режиме показа слайдов представляют презентацию во время выступле-
ния. Чтобы выбрать какой-либо способ показа, нужно в Режиме слайдов вы-
полнить команду Показ слайдов → Настройка презентации и установить в со-
ответствующее положение переключатель.  

Существует три разных способа показа слайдов: 
− управляемый докладчиком (полный экран). Это обычный способ проведения 

показа, управляемого докладчиком, когда слайды отображаются в полноэк-
ранном режиме. Ведущий получает полный контроль над презентацией. Он 
может проводить ее вручную (по щелчку мыши) или автоматически (через 
определенное время), останавливать ее для записи замечаний и даже запи-
сывать во время презентации речевое сопровождение; 

− управляемый пользователем (окно). В этом случае показ слайдов будет про-
водиться в стандартном окне со специальными меню и командами, обеспе-
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чивающими возможность самостоятельного просмотра презентации пользо-
вателем; 

− автоматический (полный экран). В этом режиме презентация будет прово-
диться в автоматическом режиме, который возобновляется после 5 минут 
простоя. Это можно использовать на выставочном стенде или собрании. 
Зрители могут менять слайды, переходить по гиперссылкам, но не могут из-
менять презентацию. При выборе этого варианта автоматически устанавли-
вается флажок Непрерывный цикл до нажатия клавиши «Esc». Прервать по-
каз слайдов можно, нажав клавишу Esc. 

Вставка слайдов в PowerPoint 
Вставить слайды можно следующими способами: 

− При помощи команды Вставка → Новый слайд… или с помощью кноп-
ки Новый слайд на Стандартной панели инструментов. Будет создан новый, 
«чистый» слайд с разметкой, выбранной в открывшемся по этой команде диа-
логовом окне. 

− Чтобы добавить новый слайд, который имеет ту же разметку, что и те-
кущий слайд, нужно щелкнуть на кнопке Новый слайд на Стандартной панели 
инструментов, удерживая клавишу Shift. 

− В режиме структуры. Для создания «чистого» слайда нужно поместить 
курсор в конец предыдущего слайда и нажать клавишу Enter. Если прототип 
слайда уже где-то существует (в другой презентации или в текстовом докумен-
те), то можно вставить его в нужное место презентации, используя буфер обме-
на. 

− При помощи команды Вставка → Дублировать слайд. Для этого необ-
ходимо выделить уже имеющийся слайд презентации и выбрать эту команду. 
Копия слайда будет расположена сразу после его прототипа. 

− При помощи команды Вставка → Слайды из файлов… Эта команда по-
зволяет копировать слайды из одной презентации в другую. Если воспользо-
ваться ею, откроется диалоговое окно Поиск слайдов. Щелчок по кнопке Обзор 
позволяет выбрать презентацию, в которой содержится нужный слайд. Чтобы 
найти слайд, нужно щелкнуть по кнопке Показать, затем отметить нужные 
слайды и щелкнуть по кнопке Вставить. Искать слайды в этом окне можно в 
двух режимах: с показом уменьшенных копий слайдов и с показом заголовков 
слайдов. Для переключения этих режимов используются кнопки в правой части 
окна. 

− При помощи команды Вставка → Слайды из структуры… Под структу-
рой в данном случае подразумевается любой текстовый файл, абзацы которого 
MS PowerPoint преобразует в слайды презентации. 

Способы вставки рисунков в презентацию 
В комплект MS PowerPoint входит стандартный набор рисунков в виде 

коллекции. Эта коллекция включает множество картинок, выполненных на 
профессиональном уровне и позволяющих придать презентации более красоч-
ный вид. Выбор рисунков самый широкий — карты, изображения людей, зда-
ний, пейзажей и т.д. 
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Для выбора рисунка нужно выполнить команду Вставка → Рисунок или 
нажать кнопку Добавить картинку на Стандартной панели инструментов  и пе-
рейти на вкладку Графика или Картинки. В коллекции предусмотрено удобное 
средство поиска, помогающее найти нужные изображения для презентации. 
Кроме того, здесь имеется своя система справки, где можно узнать, как встав-
лять в коллекцию свои рисунки, как обновлять и как настроить ее для своих це-
лей. 

Чтобы воспользоваться средством поиска или системой справки, необхо-
димо нажать кнопку Поиск или Справка соответственно. 

Для вставки рисунка необходимо сначала выбрать нужный раздел, затем 
подходящий рисунок и нажать кнопку Вставить или выполнить двойной щел-
чок по рисунку. 

Анимация и способы перехода слайдов 
Анимацией называется звуковое и визуальное оформление, которое можно 

добавить к тексту или другому объекту, например, к диаграмме или рисунку. Пе-
реходом называется специальный эффект, используемый для отображения очеред-
ного слайда в ходе показа презентации. Например, можно обеспечить появление 
слайда из затемнения или наплывом. Также можно выбрать вид и скорость пере-
хода. При создании слайдов презентации основное внимание необходимо уделять 
их содержанию. Анимация, способы смены слайдов и другие средства использу-
ются для подчеркивания определенных аспектов сообщаемых сведений, а также 
делает презентацию более привлекательной. Для каждого объекта слайда также 
можно установить способ его появления на экране, например, «влетание» с левой 
или с правой стороны, потускнение или изменение в цвете. 

Добавление управляющих кнопок в презентацию 
В MS PowerPoint включены некоторые готовые к использованию управляю-

щие кнопки, которые можно добавить в презентацию, назначив соответствующую 
гиперссылку. На управляющих кнопках изображены значки, которые служат для 
создания интуитивно понятных обозначений для перехода к следующему, преды-
дущему, первому и последнему слайдам. В MS PowerPoint также имеются управ-
ляющие кнопки для воспроизведения фильмов и звуков. 

Для добавления управляющих кнопок в слайд нужно выполнить команду  По-
каз слайдов → Управляющие кнопки и выбрать требуемую кнопку. Например, на-
зад, далее, в начало или в конец. 

Чтобы изменить размер кнопки, необходимо перетащить указатель до тре-
буемого размера. Для сохранения пропорций фигуры при перетаскивании удержи-
вать нажатой клавишу Shift. 

Когда появится окно Настройка действия, на вкладке По щелчку мыши или 
По наведении указателя мыши установить переключатель Перейти по гиперссыл-
ке, из списка выбрать нужный элемент, затем ОК. 

Запуск показа слайдов 
Для запуска презентации нужно выполнить любое из приведенных ниже дей-

ствий: 
− Перейти в режим Показ слайдов. 
− Выполнить команду Показ слайдов → Показ. 
− Выполнить команду Вид → Показ слайдов. 
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Форматы сохраненных файлов 
Презентацию (новую или сохранявшуюся ранее) можно сохранить в ходе ра-

боты над ней командой Файл → Сохранить или использовать кнопку Сохранить на 
панели инструментов Стандартная. Также можно сохранить копию презентации 
под другим именем или в другом месте командой Файл → Сохранить как… Мож-
но выбрать различные форматы сохраняемых файлов: 
− расширение файла обычной презентации ppt; 
− презентация, которая всегда будет открываться в режиме Показ слайдов, имеет 

расширение pps. Открыв такой файл (в MS PowerPoint или на основном экране), 
автоматически запустится показ слайдов. Если показ запускается из основного 
экрана, по его завершении MS PowerPoint закроется. Если показ слайдов запус-
кается из MS PowerPoint, по его завершении презентация останется открытой и 
доступной для редактирования; 

− презентация, сохраненная в виде шаблона, имеет расширение pot. 
Тема. Компьютерная графика. 
Компьютерная графика – раздел информатики, предметом которого является 

работа на компьютере с графическими изображениями (рисунками, чертежами, 
фотографиями и т. д ). 

Графический редактор – прикладная программа, предназначена для создания 
и обработки графических изображений на компьютере. 

Типы компьютерной графики 
1. Растровая графика – графика, состоящая из прямоугольной сетки точек, на-

зываемой растром. 
Каждая точка растра (пиксель) представлена единственным параметром – 

цветом. Пиксель - это цветное пятно, которое может принимать различные оттен-
ки. Любое изображение вне зависимости от его сложности - это всего лишь сово-
купность пикселей. Редактирование растровых изображений – изменение цветов 
их отдельных пикселей. 

Характеристики растровых изображений 
1. Получаются с помощью сканеров из фотографических изображений, с помо-

щью цифровых камер. 
2. Обеспечивают максимальную реалистичность изображения. 
3. Занимают много памяти. 
4. Качество зависит от размера. 

Основные параметры растровых изображений: 
− Количество цветов 
− Разрешение – количество пикселей на единицу длины (как правило на дюйм) 

2. Векторная графика состоит из  контуров. Контуры представляют собой 
кривые, имеющие точное математическое описание. 

Характеристики векторного изображения 
− Векторные изображения требуют ручного ввода (построения и рисования). Мо-
гут быть получены из растровых с помощью программ трассировки. 
− Не обеспечивают близкую к оригиналу реалистичность. 
− Компактны, так как хранят только математическое описание объектов. 
− Качество изображения не зависит от размера. 
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− Легко редактировать. 
3. Фрактальная графика – предназначена для автоматической генерации 

изображений путем математических расчетов. Создание фрактальной художест-
венной композиции состоит не в рисовании или оформлении, а в программирова-
нии. Изображение строится по уравнению. 

Простейшим фрактальным объектом является фрактальный треугольник. 
Данный вид графики часто используют в развлекательных программах. 

Теория цвета 
Основные - это три цвета, смешением которых в разных пропорциях можно 

получить любой цвет.  
Дополнительные цвета при смешении дают в глазу ощущение белого цвета, 

например сине-зеленый и красный, оранжевый и синий, зелено-желтый и фиоле-
товый цвета. 

Для описания цвета используются математические модели, работа которых 
основана на смешения основных цветов для получения всех других цветов: 

1. RGB (Red-красный, Green-зеленый, Blue -синий). В этой модели отображает 
экран монитора, кодирует изображение сканер. 

2. CMYK (Cyan-голубой, Magenta-пурпурный, Yellow-желтый, BlacK). Ис-
пользуется для создания изображений, предназначенных для печати. 
Тема. Базы данных.  
База данных (БД) – это поименованная совокупность структурированных 

данных, относящихся к определенной предметной области (БД по металлургии, 
БД в деканате о студентах, БД в библиотеке по книгам). 

Система управления базами данных (СУБД)– это комплекс программных и 
языковых средств, необходимых для создания баз данных, поддержания их в акту-
альном состоянии и организации поиска в них необходимой информации. 

Основными функциями системы управления базами данных являются: 
1. создание структуры базы данных; 
2. предоставление средств для ее заполнения или импорта данных из другой базы; 
3. обеспечение возможности доступа к данным; 
4. предоставление средств поиска, фильтрации, запросов данных. 

Классификация БД: 

 

Базы данных 

По технологии обработки данных По способу доступа к данным 

Централизованная база данных хра-
нится в памяти одной вычислительной 
системы 

Распределенная база данных состоит из 
нескольких, возможно пересекающихся 
или даже дублирующих друг друга час-
тей, хранимых в различных ЭВМ вы-
числительной сети 

С локальным доступом 

С удаленным (сетевым) доступом 

Файл-сервер 

Клиент-сервер 
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Структурные элементы базы данных: 
1. Поле – элементарная единица логической организации данных, которая 

соответствует неделимой единице информации – реквизиту. Для описания поля 
используются следующие характеристики: 
1. Имя, например, Фамилия, Имя, отчество, Дата рождения; 
2. Тип, например, символьный, числовой, календарный; 
3. Размер – определяет предельную длину, например, 15 байт; 
4. Формат – определяет способ форматирования данных; 
5. Маска ввода – определяет форму, в которой вводятся данные в поле; 
6. Подпись – определяет заголовок столбца таблицы; 
7. Точность для числовых данных, например для десятичного знака для отобра-

жения дробной части числа. 
2. Запись – совокупность логически связанных полей. Экземпляр записи - 

отдельная реализация записи, содержащая конкретные значения ее полей. 
Запись содержит данные о конкретном экземпляре сущности. База, не имею-

щая записей, является пустой, но все равно полноценной. Простейший «некомпь-
ютерный вариант» БД – ежедневник, в котором каждому календарному дню выде-
лено по странице. Даже если он пустой, он не перестает быть ежедневником, по-
скольку имеет структуру. 

Файл (таблица) – совокупность экземпляров записей одной структуры. 
Типы данных 

1. Текстовый – используется для хранения обычного неформатированного текста 
ограниченного размера (до 255 символов). 
2. Поле Memo – для хранения больших текстов (до 64000 символов). 
3. Числовой. 
4. Дата и время. 
5. Денежный – для хранения денежных сумм. 
6. Счетчик – для уникальных (не повторяющихся) натуральных чисел с автомати-
ческим наращиванием. Используется для порядковой нумерации записей. 
7. Логический – для хранения логических данных, которые могут принимать толь-
ко два значения, например Да или Нет. 

Объекты базы данных 
1. Таблицы. 
2. Запросы. Служат для извлечения данных из таблицы и предоставления их 

пользователю в удобном виде. С помощью запроса выполняют отбор данных, их 
сортировку и фильтрацию, создают новые таблицы. 

3. Формы. Являются основным средством создания диалогового интерфейса 
приложения пользователя. Форма может создаваться для ввода и просмотра взаи-
мосвязанных данных базы на экране в удобном виде. 

4. Отчеты. Предназначены для формирования выходных документов вывода 
данных на принтер. В отчетах приняты меры для группирования выводимых дан-
ных и для вывода элементов оформления, характерных для печатных документов. 

В структуре записи файла указываются поля, значения которых являются 
ключами: первичными (ПК), которые идентифицируют экземпляр записи, и вто-
ричными (ВК), которые выполняют роль поисковых или группировочных призна-
ков (по значению вторичного ключа можно найти несколько записей). 
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Виды моделей данных. 
Модель данных – совокупность структур данных и операций их обработки. 
1. Иерархическая модель данных. 
Представляет собой совокупность элементов, связанных между собой по оп-

ределенным правилам. Объекты, связанные иерархическими отношениями, обра-
зуют ориентированный граф (перевернутое дерево). 

 
К основным понятиям иерархической структуры относятся: уровень, элемент 

(узел), связь. 
Узел – это совокупность атрибутов данных, описывающих некоторый объект 

(на схеме – вершины графа). Каждый узел на более низком уровне может быть 
связан  только с одним узлом, находящемся на более высоком уровне. 

Примером иерархической структуры БД являются сведения о студентах обу-
чающихся в группе. Можно сказать, что каждый студент учится в определенной 
(только одной) группе, которая относится к определенному (только одному) ин-
ституту. 

2. Сетевая модель данных. 
Объекты в сетевой модели связаны разнородно, т. е. при тех же основных 

понятиях (уровень, узел, связь) каждый элемент может быть связан с любым дру-
гим элементом. 

 
Примером сетевой структуры БД может служить структура базы данных, со-

держащая сведения о студентах, участвующих в научно-исследовательских рабо-
тах (НИРС). Возможно участие одного студента в нескольких НИРС, а также уча-
стие нескольких студентов в разработке одной НИРС. 

3. Реляционная модель данных. 
Эта модель ориентированна на организацию данных в виде двумерных таб-

лиц. Каждая реляционная таблица представляет собой двумерный массив и обла-
дает следующими свойствами: 
− каждый элемент таблицы – один элемент данных; 
− все столбцы в таблице однородные, т. е. все элементы в столбце имеют одина-

ковый тип (числовой, символьный и т.д.) и длину; 
− каждый столбец имеет уникальное имя; 
− одинаковые строки в столбце отсутствуют; 
− порядок следования строк и столбцов может быть произвольным. 

А В
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А 

В1 В2 В3 В4 В5 

Уровень 1 

Уровень 2 
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Реляционной таблицей можно представить информацию о студентах, обу-
чающихся в вузе. 

Поле, каждое значение которого однозначно определяет соответствующую 
запись, называется простым ключом (ключевым полем). Если записи однозначно 
определяются значениями нескольких полей, то такая таблица базы данных имеет 
составной ключ. В примере ключевым полем таблицы является «№ личного дела». 

Чтобы связать две реляционные таблицы, необходимо ключ первой таблицы 
ввести в состав ключа второй таблицы (возможно совпадение ключей); в против-
ном случае нужно ввести в структуру первой таблицы внешний ключ – ключ вто-
рой таблицы. 

 
К реляционной модели данных относится Ms-Access.  

Тема. Алгоритмизация и программирование. 
Алгоритм – точное предписание, определяющее процесс перехода от ис-

ходных данных к результату. 
Свойства алгоритма: 

1. Дискретность – алгоритм должен быть разбит на отдельные действия. 
2. Понятность – точное понятие команды. 
3. Определенность – исполнитель алгоритма не должен сомневаться в сле-

дующем шаге. 
4. Результативность – по завершению выполнения алгоритма должен быть 

получен результат. 
5. Массовость – алгоритм должен быть написан для решения ряда подоб-

ных задач. 
Способы представления алгоритма: 

− Словесный; 
− Математическая формула; 
− Табличный; 
− Графический (блок - схема) 

Основные элементы блок – схемы: 
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Основные базовые структуры алгоритма  
1. Линейная структура. 

Разработка программы проводится без проверки условий и повторений. 
2. Разветвляющая структура (ветвление). 

Ветвление - это алгоритмическая структура, в которой проверяется некоторое 
условие и в зависимости от результатов проверки выполняется то или иное дейст-
вие. Для программирования проверки условия и выбора действия в зависимости от 
этого условия используются условные операторы. 

Условие в языке программирования может принимать два значения: истина 
(True) и ложь (False). Условие записывается с помощью операций отношений и ло-
гических операций. 

Существует две формы условного оператора: 
Полное ветвление (развилка) 
Синтаксис: 
  If условие 
    Then оператор1 
      Else оператор2; 
 
После оператора1 ";" не ставится. 

Действия: Проверяется условие, если оно истинно, т. е. принимает значение 
True, то выполняется оператор1, иначе, если условие ложно, т. е. принимает зна-
чение False, то выполняется оператор2.  
2. Неполное ветвление 
Синтаксис: 
  If условие 
    Then оператор; 
 

 Действия: Если условие принимает значение True, то выполняется опера-
тор, иначе никаких действий не происходит. 
3. Циклическая структура (цикл).  

При решении многих задач некоторая последовательность действий прихо-
дится выполнять несколько раз. Такие повторяющиеся действия называются цик-
лами. 

 1. Оператор цикла с параметром. 
Данный оператор используется, если надо выполнить некоторую последова-

тельность действий несколько раз, причем число повторений заранее известно. 
Синтаксис: 
For параметр цикла:=мл. знач. to ст. знач. do 
For параметр цикла:=ст.. знач. downto мл. знач. do 

 
Здесь For, to, do – зарезервированные слова (для, до, делать). 
Если параметр возрастает, то между границами его значений ставится to, если 

убывает, то downto. 
Действия: параметру цикла присваивается начальное значение и выполняется 

тело цикла, затем параметру цикла присваивается следующее значение и вновь 
выполняется тело цикла и так до тех пор, пока не будет перебраны все значения 
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параметра цикла. 
Замечание1. Счетчик цикла увеличивается автоматически на единицу.  
Замечание 2. Если в цикле используется более одного оператора, то необхо-

димо использовать операторные скобки (составной оператор). 
Оператор цикла с постусловием. 
Данный оператор используется в программе, если надо провести некоторые 

повторяющиеся вычисления, однако число повторов заранее не известно и опреде-
ляется самим ходом вычисления. 

Синтаксис:  
 
Repeat тело цикла  
Until условие; 

 
Здесь Repeat,Until – зарезервированные слова (повторять до тех пор, пока не 

будет выполнено условие). 
Действия: сначала выполняются операторы, потом проверяется условие. Если 

оно ложно, то снова выполняются операторы, и так до тех пор, при проверке усло-
вие не примет значение True. 

Замечание 1. Тело цикла будет выполняться хотя бы один раз. 
Замечание 2. Если в теле цикла используется несколько операторов, то со-

ставной оператор не нужен. 
Замечание 3. Параметр цикла может быть вещественного типа и задается в 

теле цикла. 
Оператор цикла с предусловием. 
Данный оператор, как и оператор Repeat,  используется в программе, если на-

до провести некоторые повторяющиеся вычисления, однако число повторов зара-
нее не известно и определяется самим ходом вычисления. 

Синтаксис:  
 
While условие Do оператор; 
 

 
Здесь While, Do – зарезервированные слова (пока выполняется условие де-

лать). 
Действия: сначала проверяется условие, если оно истинно, то выполняется 

тело цикла. Затем снова проверяется условие и т. д. Если условие ложно, то цикл 
завершается и выполняется оператор, стоящий непосредственно после цикла. 

Замечание 1. Если в теле цикла используется несколько операторов, то необ-
ходим составной оператор. 

Замечание 2. Параметр цикла может быть вещественного типа, задается и 
увеличивается пользователем в теле цикла. 

Программирование  - это процесс создания программы, который может быть 
представлен как последовательность следующих шагов: 

• Определение требований к программе; 
• Разработка или выбор алгоритма решения поставленной задачи; 
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• Написание команд; 
• Отладка; 
• Тестирование. 
Язык программирования - формальный язык для описания алгоритма реше-

ния задачи на компьютере.  
Уровни языков программирования 

Языки программирования бывают двух уровней: низкого и высокого уровня.  
Языки программирования низкого уровня близки к машинному коду и ориен-

тированы на конкретные команды процессора.  
Языком самого низкого уровня является язык ассемблера, который просто 

представляет каждую команду машинного кода, но не в виде чисел, а с помощью 
символьных условных обозначений, называемых мнемоникой. Каждой модели 
процессора соответствует свой язык ассемблера.  

С помощью языков низкого уровня создаются очень эффективные и компакт-
ные программы, так как разработчик получает доступ ко всем возможностям про-
цессора. С другой стороны, для этого требуется очень хорошо понимать устройст-
во компьютера (отладка больших приложений  затруднена, а результирующая 
программа не может быть перенесена на компьютер с другим типом процессора). 
Подобные языки обычно применяются для написания небольших системных при-
ложений, драйверов устройств, когда важнейшими требованиями становятся ком-
пактность, быстродействие и возможность прямого доступа к аппаратным ресур-
сам.  

Языки программирования высокого уровня значительно ближе и понятнее 
человеку, для описания алгоритма используется привычная для него форма. Осо-
бенности конкретных компьютерных архитектур (аппаратных средств) в них не 
учитываются, поэтому создаваемые тексты программ легко переносимы на другие 
платформы, имеющие программу перевода данного языка в машинный код.  

Интерпретаторы и компиляторы  
С помощью языка программирования создается не готовая программа, а 

только ее текст, описывающий ранее разработанный алгоритм. Чтобы получить 
работающую программу, надо этот текст перевести в машинный код. Для этого 
используются программы-трансляторы, которые бывают двух видов: компиляторы 
и интерпретаторы.  

Программа-компилятор переводит исходный текст программы в машинный 
код и записывает его на диске в виде отдельного бинарного файла (информация в 
машинном коде). При запуске программы исполняется бинарный файл. Почти все 
системы программирования работают с компилятором.  

Программа–интерпретатор работает совместно с исходным текстом. Каждая 
команда интерпретируется в машинный код и немедленно исполняется. Файл на 
машинном языке не создается. Программа, написанная в системе программирова-
ния, включающая интерпретатор, работает медленно. Поэтому интерпретаторы не 
нашли широкого применения.  

В настоящее время с интерпретатором работают в основном языки програм-
мирования для Интернета. Например, с интерпретатором работает Java, Perl.  

 Поколения языков программирования  
1-е поколение составляют языки, созданные в начале 50-х ггов, когда первые 
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компьютеры только появились на свет. Это был первый язык ассемблера, создан-
ный по принципу «одна инструкция – одна строка».  

2-е поколение составляют языки программирования конца 50-х – начала 60-х 
гг. Тогда появился символический ассемблер, в котором существовало понятие 
переменой. Он стал полноправным языком программирования.  

3-е поколение языков программирования относится к 60-м гг. В это время ро-
дились универсальные языки высокого уровня, с помощью которых появилась 
возможность решать задачи из любых областей. Такие качества языков програм-
мирования высокого уровня как относительная простота, независимость от кон-
кретного компьютера и возможность использования алгоритмических конструк-
ций позволили резко повысить производительность труда программистов. Подав-
ляющее большинство языков программирования этого поколения успешно приме-
няется и сегодня.  

4-е поколение языков программирования предназначено для реализации 
крупных проектов, повышена их надежность и скорость создания. 4-е поколение 
началось в 70-х гг. и продолжается до настоящего времени. Как правило, языки 4-
го поколения имеют мощные функции (операторы, команды), для реализации ко-
торых  на языках поколения младшего уровня потребовалось бы тысячи строк.  

5-е поколение языков программирования появилось в середине 90-х гг. К ним 
относятся системы автоматического создания прикладных программ с помощью 
визуальных средств разработки, без знания программирования. Инструкции вво-
дятся в компьютер в максимально наглядном виде с помощью методов, наиболее 
удобных для человека, не знакомого с программированием.  

Обзор языков программирования высокого уровня 
Fortran (Фортран) – это компилируемый язык, созданный в 50-е гг. Этот язык 

появился первым после языка ассемблера, поэтому удобство создания программы 
не так хорошо реализовано, как возможность получения эффективного машинного 
кода. В 2000 г. выпущен Фортран F2k.  

Cobol (Кобол) – компилируемый язык, разработанный в начале 60-х гг. для 
применения в экономической области и решения бизнес-задач. Отличается боль-
шой «многословностью»  его операторы иногда выглядят как обычные англий-
ские фразы. Очень распространен среди программистов США.  

 Algol (Алгол) – компилируемый язык, созданный в 1960 г. Он был призван 
заменить Фортран, но из-за более сложной структуры не получил широкого рас-
пространения.  

Pascal (Паскаль) – создан  в конце 70-х гг. Во многом напоминает Алгол, но в 
нем ужесточены требования к структуре программы, за счет чего структура стала 
более наглядной и простой. Паскаль удобен для получения азов программирова-
ния, но также успешно применяется при создании крупных проектов.  

Basic (Бейсик) – создавался в 60-х гг. в качестве учебного языка и очень прост 
в изучении. Для него имеются интерпретаторы и компиляторы.  

C (Си) – создан в лаборатории Bell и первоначально планировался для замены 
ассемблера. Имеет возможность создавать эффективные и компактные программы, 
в то же время не зависеть от конкретного типа процессора. Си во многом похож на 
Паскаль и имеет дополнительные средства для прямой работы с памятью. В 1980 
г. создано объектно–ориентированное расширение языка Си – С++(Си++).  
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Java (Джава, Ява) – язык, созданный компанией Sun в начале 90-х гг. на осно-
ве Си++. Главная особенность этого языка – компиляция не в машинный код, а в 
платформенно-независимый байт-код (каждая команда занимает 1 байт). Этот 
байт-код выполняется с помощью интерпретатора – визуальной Java–машины, 
версии которой существуют сегодня для любой платформы.   Благодаря наличию 
множества Java–машин, программы легко переносятся на уровне двоичного байт-
кода. Сегодня язык Ява очень популярен. Пока основной его недостаток – невысо-
кое быстродействие, так как язык Ява интерпретируемый.  

Языки программирования баз данных – язык структурированных запросов 
SQL. Основан на мощной математической теории и позволяет выполнять эффек-
тивную работу, манипулируя не отдельными, а группами записей. Для управления 
большими базами данных используются СУБД. Практически в каждой СУБД, по-
мимо поддержки языка SQL, имеется свой уникальный язык, ориентированный на 
особенности этой СУБД: Microsoft, IBM, Oracle, Software.  

Языки программирования для Интернет отличаются характерными особенно-
стями: являются интерпретируемыми, интерпретаторы для них распространяются 
бесплатно, а сами программы в исходных текстах. Такие языки называются 
скрипт-языками. Примерами языков программирования для Интернет являются 
НТМL, Perl, Tcl/Tk, VRML.  

Логические языки программирования используются в области создания ис-
кусственного интеллекта. Наиболее распространены Пролог, Ада.  

Системы программирования 
Для написания программы на языке программирования необходимо иметь на 

компьютере установленную соответствующую систему программирования.  
Системы программирования  хорошо интегрированная система, включаю-

щая как минимум:  
− специализированный текстовый редактор (для написания текста программы);  
− компилятор для перевода текста программы в машинный код (в редких случаях 

 интерпретатор);  
− библиотека функций (подключенные модули);  
− редактор связей для связывания модулей (файлов с исходными текстами) и 

стандартных функций, находящихся в библиотеках;  
− исполнимый код - законченную программу с расширением .COM или .EXE, ко-

торую можно запустить  на любом компьютере, где установлена операционная 
система, для которой эта программа  создавалась;  

− справочную систему;  
− отладчик, позволяющий анализировать работу программы во время ее выпол-

нения по шагам.  
В последние несколько лет в программировании (особенно в программирова-

нии для операционной системы Windows) наметился так называемый визуальный 
подход. Он облегчает создание графических приложений, в таких системах имеет-
ся множество стандартных элементов управления и контроль за их работой. По-
добные системы программирования называются средами быстрого проектирова-
ния RAD-среды.   

Наиболее популярны следующие визуальные среды быстрого проектирова-
ния программ для Windows: Basic: Microsoft Visual Basic, Pascal: Borland Delphi, 
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C++: Borland C++ Bulider, Java: Symantec Café.  
Человечество в своей деятельности (научной, образовательной, технологи-

ческой, художественной) постоянно создает и использует модели окружающего 
мира. Строгие правила построения моделей сформулировать невозможно, однако 
человечество накопило богатый опыт моделирования различных объектов и про-
цессов. 

Модели позволяют представить в наглядной форме объекты и процессы, не-
доступные для непосредственного восприятия (очень большие или очень ма-
ленькие объекты, очень быстрые или очень медленные процессы и др.). Нагляд-
ные модели часто используются в процессе обучения. Модели играют чрезвы-
чайно важную роль в проектировании и создании различных технических уст-
ройств, машин и механизмов, зданий, электрических цепей и т. д. Развитие науки 
невозможно без создания теоретических моделей (теорий, законов, гипотез и 
пр.),отражающих строение, свойства и поведение реальных объектов. Создание 
новых теоретических моделей иногда коренным образом меняет представление 
человечества об окружающем мире (гелиоцентрическая система мира Коперника, 
модель атома Резерфорда-Бора, модель расширяющейся Вселенной, модель ге-
нома человека и пр.). Адекватность теоретических моделей законам реального 
мира проверяется с помощью опытов и экспериментов. 

Моделирование – это метод познания, состоящий в создании и исследова-
нии моделей. 

Модель – это некий новый объект, который отражает существенные особен-
ности изучаемого объекта, явления или процесса. 

Один и тот же объект может иметь множество моделей, а разные объекты 
могут описываться одной моделью. 

Все модели можно разбить на два больших класса: модели предметные 
(материальные) и модели информационные. Предметные модели воспроизводят 
геометрические, физические и другие свойства объектов в материальной форме 
(глобус, анатомические муляжи, модели кристаллических решеток, макеты зда-
ний и сооружений и др.). Информационные модели представляют объекты и 
процессы в образной или знаковой форме. 

Классификация моделей 
При построении математических моделей процессов функционирования сис-

тем существуют следующие основные подходы: 
− непрерывно-детерминированный (например, дифференциальные уравне-

ния, уравнения состояния); 
− дискретно-детерминированный (конечные автоматы); 
− дискретно-стохастический (вероятностные автоматы); 
− непрерывно-стохастический (системы массового обслуживания); 
− обобщенный или универсальный (агрегативные системы).  
Классификация моделей и видов моделирования объектов и систем в соот-

ветствии с теорией подобия должна выделить в них наиболее общие признаки и 
свойства реальных систем. Ниже приведена одна из возможных классификаций:  
− Принадлежность к иерархическому уровню (модели микроуровня, модели мак-

роуровня, модели метауровня). 
− Характер взаимоотношений со средой (открытые, закрытые). 
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− Характер отображаемых свойств объекта (структурные, функциональные). 
− Способ представления свойств объекта (аналитические, алгоритмические, ими-

тационные). 
− Способ получения модели (теоретические, эмпирические). 
− Причинная обусловленность (детерминированные, вероятностные). 
− По отношению к времени (динамические, статические). 
− По типу уравнений (линейные, нелинейные). 
− По множеству значений переменных (непрерывные, дискретные, дискретно-

непрерывные). 
− По назначению (технические, экономические, социальные и т.д). 

Моделирование в целом включает в себя ряд этапов:  
1. Содержательная постановка задачи. Необходимо выработать общий подход 

к исследуемой проблеме, определить подзадачи, сформулировать основную цель и 
наметить пути ее достижения. На этом этапе требуется глубокое понимание суще-
ства протекающих процессов в рассматриваемой системе, чтобы корректно поста-
вить задачу.  

2. Изучение и сбор информации об объекте-оригинале. На этом этапе анализи-
руются или подбираются подходящие гипотезы, аналогии, теории, учитываются 
опытные данные, наблюдения и т.д. Определяются входные и выходные перемен-
ные, связи, принимаются упрощающие предположения.  

3. Формализация. Принимаются условные обозначения и с их помощью опи-
сываются связи между элементами объекта в виде математических выражений.  

4. Выбор метода решения. Для поставленной математической задачи обосно-
вывается метод ее решения с учетом знаний и предпочтений пользователя и разра-
ботчика.  

5. Реализация модели. Принимается критерий оценки эффективности модели, 
разрабатывается алгоритм, пишется и отлаживается программа, чтобы осущест-
вить системный анализ и синтез.  

6. Анализ полученных результатов. Сопоставляется предполагаемое и полу-
ченное решение, проводится оценка адекватности и погрешности моделирования. 
Уточнение модели происходит до тех пор, пока не будут получены приемлемые 
результаты.  

Таким образом, после прохождения этих этапов наиболее полно могут быть 
выполнены требования, предъявляемые к моделям:  
− Универсальность – характеризует полноту отображения моделью изучаемых 

свойств реального объекта;  
− Адекватность – способность отражать нужные свойства объекта с погрешно-

стью не выше допустимой;  
− Точность – оценивается степенью совпадения значений характеристик реаль-

ного объекта со значениями этих характеристик, полученных с помощью моде-
лей;  

− Экономичность – определяется затратами ресурсов ЭВМ (памяти и времени на 
ее реализацию и эксплуатацию).  
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IV. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ 
ЛАБОРАТОРНЫХ РАБОТ 

Задачей преподавателя при проведении лабораторных работ является грамот-
ное и доступное разъяснение принципов и правил проведения работ, побуждение 
студентов к самостоятельной работе, определения места информатики в дальней-
шей профессиональной работе будущего специалиста. 

Цель лабораторной работы – научить студентов самостоятельно производить  
необходимые  действия для достижения необходимого результата. 

 Прежде чем приступить к выполнению лабораторной работы, студенту необ-
ходимо ознакомиться с теоретическим материалом, соответствующим данной те-
ме. 

Выполнение лабораторной работы целесообразно разделить на  несколько 
этапов: 

• Формулировка и обоснование цели работы; 
• Определение теоретического аппарата, применительного к данной теме; 
• Выполнение заданий; 
• Анализ результата; 
• Выводы. 

 
V. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ 

ДОМАШНИХ ЗАДАНИЙ 
В последние годы отмечается тенденция снижения аудиторной нагрузки и 

увеличения доли самостоятельной подготовки студентов. Самостоятельная работа 
студентов отражает степень познания материала, глубины знаний, освоение уме-
ний и способность применения усвоенного материала. Студент учится, когда ра-
ботает сам – решает задачи, самостоятельно составляет математическую модель 
объекта или явления, применяет известный теоретический материал, использует 
аппарат математики.  

Развить творческие способности помогут задания, требующие нестандартных 
решений, постановки новых проблем и поиск путей их выполнения, то есть когда 
студент сталкивается с задачами, на которые у него нет готовых ответов. В такой 
ситуации он вынужден сам искать пути решения, размышлять, самостоятельно до-
бывать знания.  

Педагогическая эффективность самостоятельной работы зависит от качества 
руководства ею преподавателем, четкости и сложности заданий, которые он раз-
рабатывает, рациональных приемов интеллектуального труда, который надо вло-
жить в их выполнение. Большую роль играет четкое и полное изложение препода-
вателем теоретического материала, необходимого для каждого конкретного зада-
ния, наблюдение за ходом выполнения работы, своевременной помощи в преодо-
лении трудностей, исправлении ошибок, подведении итогов, анализе  общей оцен-
ки результатов. 

В случае домашней работы, роль преподавателя ограничивается общими 
разъяснениями, возможно, демонстрацией похожих заданий, предостережения от 
типичных ошибок. Для успешной домашней работы студент должен быть обеспе-
чен методическим материалом. 
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     Если правильно разделить материал на небольшие модули, охватывающие 
отдельные темы, по каждому разделу предложить отдельное методическое посо-
бие, то выполнение домашней работы существенно упроститься, а значит,  увели-
чится и эффективность усвоения знаний. 

     Можно рекомендовать следующую схему подготовки и выполнения до-
машнего задания: 

• Проанализировать все задания в целом, определить раздел (или разделы) к 
которым относится материал; 

• Выделить теоретический материал, относящийся к этим разделам. Прове-
рить наличие лекций по данному разделу, убедиться, что имеются в наличии учеб-
ники или методические указания по вопросам, не охваченным в лекциях; 

• Выполняя задания, следует сопровождать их подробным описанием, вы-
кладками, чертежами, ссылками на соответствующие теоремы и формулами; 

• В конце решения необходимо написать ответ, в соответствии с формулиров-
кой задания. 

Внеаудиторная работа по информатике включает в себя: 
• Совершенствование и закрепление теоретических знаний, полученных на 

лекционных и лабораторных занятиях. Каждая тема курса включает вопросы 
входного контроля знаний (минимальный теоретический уровень), освоение кото-
рых необходимо для решения учебных задач, формирования умений и навыков 
темы. 

• Формирование навыков практической работы  - доведение умений до авто-
матизма путем решения упражнений - заданий, требующее повторного выполне-
ния действий с целью его усвоения. 

• Выполнение творческих работ, предусмотренных рабочей программой (см. 
пункт самостоятельная работа студентов). 

При выполнении домашней работы студенты могут использовать различные 
источники приобретения информации: конспекты лекций, учебно-методические 
материалы курса, ссылки на научную литературу в информационном пространстве 
Интернета и др.  

VI. ПЕРЕЧЕНЬ ПРОГРАММНЫХ ПРОДУКТОВ, ИСПОЛЬЗУЕМЫХ 
ПРИ ПРЕПОДАВАНИИ ДИСЦИПЛИНЫ 

 
Наименование Год выпуска, разработчик Примечание 

Total Commander 2004 Файловый менеджер (для windows) 
Far Manager 2006, Eugene Roshal and Far 

Group. 
Файловый менеджер (для DOS) 

Microsoft Office   2000, Microsoft Пакет прикладных программ 
Internet Explorer  2001, Microsoft Обозреватель Internet 
MathCad  2001, MathSoft, inc Математический пакет 
WinZip 2004 Архиватор 
WinRAR 3.2 2004 Архиватор 
Delphi for Object 
Pascal 

2000, Borland Delphi Система объектно-ориентированного  про-
граммирования  

CorelDraw 2003, Corel inc  Графический пакет 
PhotoShop 2001, Adobe   Графический пакет 
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VII. КОМПЛЕКТ ЗАДАНИЙ ДЛЯ ЛАБОРАТОРНЫХ РАБОТ 
Тема: Компьютерная графика. 
Тема №1: Создание простейших изображений в графическом редакторе 

CorelDraw. 
Задания к лабораторной работе: 
В качестве отчетной работы требуется создать визитку с учетом основных 

правил подготовки изображений к печати в типографии и вывести на лист А4 
при помощи автоматического расположения на листе. 

1. Создание визитки 
− Устанавливаем размер листа под размер визитки (90х50) 
− Заполняем документ содержимым (в данном случае это несколько надписей 

и растровая картинка) 
− Важно! Видимую рамку к визитке делать нельзя, т.к. из-за погрешностей при 

обрезке рамка будет иметь неодинаковую толщину или с каких-то сторон ее 
не будет вообще. 

− Сохраняем документ. 
В результате получаем: 

 
2. Подготовка к печати 

− Входим в «print preview» 
− В режиме «Imposition layout tool» выбираем нужное число копий по верти-

кали и горизонтали. 
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− В режиме «Marks placement tool» устанавливаем метки для обрезки 

 
− Теперь, если нужно, такой стиль оформления можно сохранить (file => save 

frint style as…). Документ готов к печати. 
Тема №2: Создание простейших изображений в графическом редакторе 

PhotoShop. 
Задания к лабораторной работе: 
1. Создание контурного и обведенного текста. 
Инструмент Type (Текст) обладает незначительными возможностями соз-

дания контуров. Невозможно задать толщину обводки, нельзя выбрать режим 
наложения или установить величину непрозрачности. Обычно для ввода и об-
водки текста перед импортом в Photoshop используют программу типа 
Illustrator. Если это невозможно, то для создания контуров воспользуйтесь ко-
мандой Stroke (Выполнить обводку) меню Edit (Редактирование). 

Прозрачный текст с цветным контуром можно создать, выполнив следую-
щие действия: 

1. Выберите инструмент Type Mask (Текст-маска) и щелкните на открытом 
изображении или на новом слое, в котором хотите поместить текст. 

2. Введите текст. Оставьте выделенную область ак-
тивной для выполнения последующих действий. 

3. Задайте желаемый цвет контура. 
4. В меню Edit (Редактирование) выберите команду 

Stroke (Выполнить обводку) и введите необходимые зна-
чения. 

Для создания окрашенного текста, контур которого 
имеет другой цвет, выполните следующие действия: 

1. Задайте основной цвет, соответствующий цвету 
текста. 

2. Выберите инструмент Type (Текст), щелкните на 
новом слое и введите требуемый текст. 
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3. Выполните Select → Load Selection, чтобы выделить текст по контуру и 
склейте слои (Ctrl + E). 

4. Задайте основной цвет, соответствующий цвету об-
водки. 

5. В меню Edit (Редактирование) выберите команду 
Stroke (Выполнить обводку) и введите необходимые значения. 

2. Пламя. 
Нам потребуется однослойное изображение - белая надпись на черном фо-

не. Удобнее всего использовать режим серых полутонов. 
Эффект пламени более выразителен на широком светлом 
шрифте без засечек. Можно применить и массивный 
шрифт, обведя буквы по контуру. 

Первый этап состоит в применении фильтра Wind, вызываемого через ме-
ню Filter → Stylize. Перед вызовом эффекта ветра надо 
повернуть изображение на 90o по часовой стрелке (коман-
да Image → Rotate Canvas → 90o CW), поскольку в фильт-
ре Wind нет вертикального направления ветра. Мы вклю-
чим направление From the right, а силу ветра оставим минимальную - Wind. 
Чтобы следы ветра получились более мощными, можно применить фильтр не-
сколько раз подряд, нажав клавиши Crtl + F. После чего возвращаем изображе-
ние в нормальное положение командой меню Image → Rotate Canvas → 90o 
CCW. 

Придадим надписи и языкам ветра рваную форму, более соответствующую 
пламени. Для этого воспользуемся фильтром Diffuse, вызвав его через то же 
меню Filter → Stylize и установив режим Normal. 

Далее применим фильтр Gaussian Blur при небольшом радиусе. В данном 
случае он составил 1.3 пиксела. Усилим дрожание с помощью фильтра Ripple 
(рябь), который вызывается через меню Filter → Distort. 
Зададим амплитуду (Amount) порядка 80 - 100, да и длина 
волны пусть будет небольшой, выберем Small или 
Medium. 

На последнем этапе надо перевести изображение из черно-белого полуто-
нового в индексированный цвет Image → Mode → Indexed Color. Изменить па-
литру изображения с индексированным цветом можно с помощью команды ме-
ню Image → Mode → Color Table. Редактор Photoshop 
предлагает несколько заранее подготовленных палитр, из 
которых выберем Black Body. 

3. Лед. 
Создадим новое изображение и напишем на нем текст черным цветом. За-

тем выполним Select → Load Selection и Layer → Flatten Image. 
Выполним команду Select → Inverse, и применим фильтр Filter → Pixelate 

→ Crystallize с коэффициентом кристаллизации равным 8. 
Опять выполняем команду Select → Inverse, и приме-

няем фильтр Filter → Noise → Add Noise с коэффициентом 
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шума около 70 (включите Distribution: Gaussian). 
Размываем избражение фильтром Filter → Blur → Gaussian Blur с коэффи-

циентом размывки около 2. Затем отменяем выделение Select → None и исполь-
зуем фильтр Filter → Blur → Blur. 

Выполняем команду Image → Adjust → Invert (Ctrl + I). 
Повернем изображение Image → Rotate Canvas → 90 

CW. Затем применяем фильтр Filter → Stylize → Wind 
(Method: Wind, Direction: From the left) и возвращаем картинку в горизонталь-
ное положение Image → Rotate Canvas → 90 CCW. 

Придадим изображению цвет льда с помощью команды Image → Adjust → 
HueSaturation (Включите Colorize, установите параметр Hue в положение - 181, 
а Saturation - 80). 

Добавим искрящиеся блики с помощью дополнительных кистей. В меню 
Brushes (Кисти) выберите команду Load Brushes (Загрузить Кисти) и откройте 
файл assorted.abr из подкаталога Brushes. Установите теку-
щим белый цвет и нанесите искорки на некоторые высту-
пающие льдинки. 

4. Золотая надпись. 
Создаем новый белый лист. Переходим в палитру каналов и, нажав на 

кнопку внизу этой палитры, создаем канал #4. Его фон должен быть черным, а 
текст белым. Пишем текст. Этот эффект наиболее выразителен при использова-
нии крупных символов. 

Активизируем единственный слой Background он дол-
жен быть белым. Маску из канала #4 загружаем в окно ре-
дактора комбинацией клавиш [Ctrl]+[Alt]+[4]. Закрашиваем 
ее черным. Залить маску основным цветом можно клавишами [Alt]+[Del]. Вы-
ключаем маску, нажав [Ctrl]+[D]. 

Надпись на слое Background надо растушевать с помощью гауссового 
фильтра (Filters → Blur → Gaussian Blur). Радиус в 3 пиксела. 

Переименуем этот слой. Щелкните дважды мышкой по пиктограмме слоя 
Background в палитре слоев. Затем необходимо продублировать слой. Для этого 
перетащите мышкой в палитре слоев дублируемый слой на кнопку создания 
нового. 

Слои надо сдвинуть друг относительно друга (Filter → Other → Offset). 
Для одного из слоев набираем два положительных смещения на 4 пиксела, а 
для другого - два отрицательных по 4 пиксела. 

Для верхнего из слоев (Layer 0 copy) режим наложе-
ния заменяем с Normal на Difference (разница). Теперь 
слои объединяем в один [Ctrl]+[Е].  

Нажав комбинацию клавиш [Ctrl]+[М], Вам надо по-
пытаться воспроизвести кривую, подобную той, что на ил-
люстрации. 

Загружаем маску #4 командой меню Select → Load 
Selection, затем маску инвертируем [Ctrl]+[Shift]+[I]. Убе-
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дившись, что маска включает в себя не надпись, а фон вокруг нее (об этом сви-
детельствует бегущая штриховая линия по краю окна редактора), нажмите кла-
вишу [Del]. 

Нажимаем [Ctrl]+[D] и [Ctrl]+[I] - инвертирование. 
Создаем новый слой (цветной) Слой1. Подбираем ему из 
каталога золотистый цвет. Делаем заливку [Ctrl]+[Del]. Де-
лаем для Слой0 цветность. 

Надо объединить слои в срезаемую группу. Получаем ее, щелкнув мышкой 
при нажатой клавише [Alt] по линии, разделяющей слои в палитре Layers. 

Создаем новый слой Слой2, делаем его цветным. В ката-
логе выбираем черный цвет и нажав [Ctrl]+[Del] заливаем. 
Расположите слои в такой последовательности: слой1, слой2, 
слой0. 

5. Эффект «X-Files». 
Создайте новое изображение RGB с чёрным фоном. Напишите ваш текст. 

Далее необходимо объединить слои (Ctrl + E). Теперь, откройте палитру Кана-
лы (Window → Show Channels); переместите любой из каналов к значку новый 
канал. Это создаст новый канал. Откройте двойным щелчком мыши свойства 
этого канала и переименуйте его в «оригинал». 

Перетащите канал «оригинал» к значку нового канала и сделайте дубликат. 
Дважды щелкните на новом канале, и переименуйте его в «белый». Затем нажав 
Ctrl + щелчок мыши на канале, загрузите его в выделение. Теперь мы немного 
расширим его. Используйте Select → Modify → Expand со значением 1 пиксела. 
Далее выполните Edit → Fill use: white. Снимите выделение 
Select → Deselect и выполните размывку Filter → Blur → 
Gaussian Blur с радиусом равным 2. 

Перетащите канал «белый» к значку новый канал, чтобы у 
нас получился ещё один канал. Дважды щёлкните на образовавшемся канале, и 
переименуйте его в «жёлтый». Ctrl + щелчок, чтобы загрузить в 
выделение. Опять, Select → Modify → Expand со значением 2. За-
полните белым цветом, снимите выделение и примените фильтр 
Filter → Blur → Gaussian Blur с радиусом 3. 

Последний канал мы получим следующим образом - перетащите канал 
«желтый» к значку новый канал. Переименуйте его в «зелёный», Ctrl + щелчок; 
расширьте на 4. Заполните белым, снимите выделение, размойте 
с радиусом 7 пикселов. 

Переключитесь на канал RGB. Выполните Select → Load 
Selection и выберите там канал «зелёный». Теперь выберите под-
ходящий зеленый цвет, например R:0 G:255 B:0. И выполните за-
ливку Edit → Fill use: Foreground Color. 

Сделайте тоже самое для канала «жёлтый», но с использова-
нием цвета R:128 G:255 B:0. Теперь тоже самое сделайте для ка-
нала «белый», используя белый цвет. Загрузите «оригинал», вы-
полните Select → Modify → Contract установка - 1 пиксел и за-
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лейте черным Edit → Fill use: black. 
Тема: Операционная оболочка Total Commander. 
Задания к лабораторной работе: 

1. На диске С: создать два каталога DOG и GRAND. 
2. В каталог DOG создайте файл dogovor.txt, содержащий текст: 

ДОГОВОР №1 
Данный договор составлен 10.10.2000 год. 

3. Скопируйте файл dogovor.txt в каталог GRAND. 
4. Переименовать в каталоге GRAND файл dogovor.txt на dogovor1.txt. 
5. В файле dogovor1.txt исправить число 10.10.2000 на 10.12.2002. 
6. Перенести файл dogovor1.txt в каталог DOG с именем itog.txt. 
7. Просмотреть содержимое файла itog.txt. 
8. Переименовать каталог DOG в DATA. 
9. В корневом каталоге диска C: создать каталог с именем BLANK. 
10. В каталоге BLANK создать файл doc1.txt, содержащий текст: Программа-

оболочка – это программа, один из модулей которой, называемый резидент-
ным, постоянно находится в оперативной памяти компьютера.  

11. Скопировать файл doc1.txt в файл doc2.txt каталога BLANK. 
12. Переименовать в каталоге BLANK файл doc2.txt в файл otchet.txt. 
13. Добавить в файл otchet.txt следующий текст: Оболочки позволяет эффектив-

но работать с файловой системой  дисков, а также запускать программы на 
исполнение. 

14. В корневом каталоге диска С: создать каталог KONTORA. 
15. Перенести каталог BLANK в каталог KONTORA. 
16. Скопировать одновременно все файлы из каталога DOG в BLANK. 
17. В каталоге BLANK поместить файлы в архивный файл paper.rar одновре-

менно уничтожив исходные файлы. 
18. Извлечь файлы из архива paper.rar в каталог DATA. 
19. Осуществить поиск файлов doc2.txt и dogovor1.txt.  

Тема: Операционная система Windows. 
Тема №1: Рабочий стол Windows. Работа с окнами 
Задания к лабораторной работе: 
1. Познакомьтесь с элементами Рабочего стола: значками объектов Win-

dows и Панелью задач. 
2. Отработка приемов работы с мышью: 

− Выделить значок Мой компьютер. 
− Переместить значок в новое место Рабочего стола (Если перетаскивание не 

удается, то вызвать контекстное меню Рабочего стола отменить режим 
«Упорядочивать» – «Автоматически»). 

− Вернуть значок на место. 
− Снять выделение со значка Мой компьютер. 
− Открыть Главное меню кнопкой Пуск. 
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− Определить текущую дату, применив прием зависания к индикатору часов на 
Панели задач. 

− Определить установленную раскладку клавиатуры, вызвав контекстное меню 
индикатора языка на Панели задач и выбрав в меню пункт Свойства. 

3. На Рабочем столе создать с помощью мастера ярлыки для приложений 
MS Word и MS Excel.  

4. Знакомство с элементами окна: 
− Открыть окно папки «Мой компьютер» и познакомиться с элементами окна. 
− Развернуть окно на весь экран; восстановить размер окна; свернуть окно; 

развернуть окно; закрыть окно. 
− Открыть окна папок «Мой компьютер» и «Корзина». 
− Изменить размеры окон таким образом, чтобы они не перекрывали друг дру-

га. 
− Закрыть окна. 

5. Установить шлейф для мыши. 
6. Включить заставку: ОБЪЕМНЫЙ ТЕКСТ, текст «Безопасность», пара-

метры: стиль движения «Волны», шрифт – Arial. 
7. Просмотреть предлагаемые рисунки и узоры Рабочего стола и устано-

вить наиболее понравившийся. 
8.  Установить новые свойства у Панели задач: 

− раскрыть окно свойств Панели задач вызвав ее контекстное меню и выбрав в 
меню пункт Свойства; 

− снять флажок отображения часов; 
− установить флажок Автоматически убирать с экрана; 
− проверить установленные свойства; 
− восстановить прежнее значение измененных свойств. 

9. Изучить свойства клавиатуры: 
− в Панели управления открыть окно Клавиатура; 
− установить комбинацию клавиш Ctrl+Shift для переключения между рус-

ским и английским языками; 
− отключить индикатор раскладки клавиатуры; 
− проверить установленные свойства;  
− восстановить прежние значения свойств. 

10.  Изучить свойства Корзины: 
− раскрыть окно Свойства корзины; 
− выбрать закладку Глобальные; 
− изменить значения свойства Уничтожать файлы  сразу, не помещая их в кор-

зину; 
− изменить значения свойства Запрашивать подтверждение на удаления; 
− проверить установленные свойства; 
− восстановить прежнее значение измененных свойств. 

11. Очистить список документов в Главном меню. 
12. Создать в Главном меню новый пункт, запускающий программу Блокнот. 
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13. Удалить из Главного меню пункт Блокнот. 
Тема №2: Стандартные программы. Работа с папками и файлами 
Задания к лабораторной работе: 
1. Записать в тетради перечень стандартных программ Windows. 
2. Записать в тетради назначение программы «Блокнот». 
3. Запустить программу «Блокнот». 
4. Ввести текст: «Текст вводится с помощью буквенно-цифровых клавиш. 

Для ввода прописных букв используется  одновременное нажатие клавиши 
Shift для ввода длинной последовательности прописных букв клавиатуру мож-
но переключить с помощью клавиши Caps Lock. Для переключения между рус-
скими и английскими символами используется индикатор языка на Панели за-
дач, или специальная комбинация клавиш, установленная на Вашем компьюте-
ре. Обычно это комбинация клавиш Alt+Shift или Ctrl+Shift.» 

5. Свернуть окно программы «Блокнот» на Панель задач. 
6. Записать в тетради назначение программы WordPad. 
7. Запустить программу WordPad. 
8. Ввести текст: «Для выделения фрагмента текста необходимо нажать ле-

вую кнопку мыши на начале фрагмента и, удерживая ее, переместить указатель 
мыши в конец выделяемого фрагмента. Необходимый фрагмент выделится 
черным цветом». 

9. С набранным текстом проделать следующую работу: 
− Вставить набранный текст в конец документа два раза; 
− Выделить первый абзац и задать для него следующие параметры: шрифт – 

Arial, размер шрифта – 16, цвет шрифта – зеленый, тип шрифта – полужир-
ный курсив; 

− Выровнять первый абзац по левому краю, второй абзац – по центру, третий 
абзац – по правому краю. 

10. Свернуть окно программы WordPad на Панель задач. 
11. Записать в тетради назначение программы Paint. 
12. Запустить программу Paint. 
13.  Нарисовать следующий рисунок 

 
14. Свернуть окно программы Paint на Панель задач. 
15. Открыть папку «Мой компьютер» и перечислить находящиеся в ней 

объекты. 
16. Изменить несколько раз размеры и расположение значков файлов и па-

пок. 
17. На диске С: создать папки Филолог, Литература, Все . 
18. В папке Филолог создать папки Повесть, Рассказ, Роман. 
19. Развернуть программу «Блокнот» и сохранить текст с именем Записки 

в папке Повесть. 
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20. Развернуть программу «WordPad» и сохранить текст с именем Тезис в 
папке Рассказ. 

21. Развернуть программу «Paint» и сохранить рисунок с именем Разбор в 
папке Роман. 

22. Скопировать папку Филолог в папку Литература. 
23. Скопировать папку Литература на диск А:. 
24. Переместить на диске С: папку Литература в папку Филолог. 
25.  Переименовать на диске С: папку Литература на Все. 
26.  Удалить папку Все. 
27.  Восстановить папку Все. 
28.  Выделить папку Все и посмотреть, сколько места на диске она занима-

ет. Заархивировать папку Все в архив Общие.rar. 
29.  Сравнить занимаемое место на диске архивом Общие.rar с первона-

чальным объемом папки Все. На сколько уменьшился объем занимаемого места 
на диске? 

30.  Разархивировать архив Общие.rar. 
Тема №3: Программа «Поиск». Программа «Проводник» 
Задания к лабораторной работе: 
1. Организовать поиск файлов по Имени и размещению: 

− найти на диске С: все файлы с расширением .tmp (*.tmp); 
− найти на диске С: все файлы с расширением .bmp (*.bmp); 
− найти все файлы с однобуквенными именами и расширениями (?.?); 

2. Организовать поиск файлов по Дате изменения: 
− найти на диске С: файлы, созданные с 1.10.2000 по сегодняшний день; 
− найти на диске С: файлы, созданные с 1.10.2004 по 15.07.2005; 
− найти на диске С: файлы, созданные за последний месяц; за последние два 

месяца; за последний день; за последние три дня; 
3. Используя вкладку Дополнительно найти файлы типа Точечный рисунок 

BMP. На каком диске вы провели поиск? Полученный список файлов предста-
вить в виде таблицы и отсортировать его по размеру. Просмотреть самый 
большой рисунок. 

4. Найти на диске С: все текстовые файлы, содержащие слово «Windows». 
5. Найти на диске С: все Текстовые документы, содержащие слово 

«windows», но не  «Windows». Для этого необходимо отменить режим Пара-
метры → С учетом регистра. Открыть один из найденных файлов и найти в 
нем указанное слово. 

6. Запустить программу «Проводник». 
7. Измените Вид правой панели с помощью меню. 
8. Свернуть все папки, щелкая по значкам « – » на дереве папок в левой 

панели программы. 
9. Показать в правой части содержимое диска С: и при помощи контекст-

ного меню создать на диске С: папку Европа. 
10. Развернуть в правой части диск С: чтобы увидеть созданную папку. 
11. Открыть папку Европа в правой части Проводника. 
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12. Создать в папке Европа папку Россия. 
13. В папке Россия создать текстовый документ Записки1 и точечный рисунок 

Записки2. 
14. Правой кнопкой мыши переместить их в папку Европа. 
15. Скопировать файл Записки2 в папку Россия. 
Тема: Текстовый процессор Word. 
Тема №1: Создание текстового документа. 
Задания к лабораторной работе: 
1. Запустить текстовый процессор MS Word. 
2. Изучить структуру окна редактора и назначение его основных элементов 

(строка заголовка; кнопки управления окном Свернуть, Развер-
нуть/Восстановить, Закрыть; строка меню; панели инструментов; линейка; ра-
бочая область; полосы прокрутки; строка состояния; рамка). 

3. Набрать следующий текст с соблюдением вышеуказанных правил: 
Морфема – это самая маленькая значимая часть слова. Самая главная морфе-

ма – это корень, несущий основной смысл слова. Остальные морфемы, несущие 
«смыслиночки», — приставка, суффикс, окончание – называются аффиксами. 

Слово морфема ввел в науку ученый-лингвист Бодуэн де Куртенэ. Вы, конеч-
но, помните, что он же дал звуку-смыслоразличителю имя – фонема. 

От слова морфема образовалось слово морфология. Это раздел грамматики, 
изучающий, как изменяется слово.  

В России каждый человек имеет имя, отчество и фамилию. А в других стра-
нах у людей нет отчества, зато иногда бывает по два имени (и даже больше). На-
пример, великого австрийского композитора Моцарта звали Вольфганг Амадей, а 
известного комического актера кино Чаплина — Чарльзом Спенсером. 

А теперь вспомните сами, какие имена носил всеми любимый сказочник Ан-
дерсен (Ганс Христиан). Как у людей бывают вторые имена, так у некоторых мор-
фем бывают вторые названия. 

4. Сохранить документ с именем «Морфема». 
5. Завершить работу с MS Word. 
Тема №2: Форматирование текстов. 
Задания к лабораторной работе: 
1. Загрузить MS Word. 
2. Установить поля станицы: верхнее – 2 см, нижнее – 2 см, левое – 3 см, 

правое – 1 см. 
3. Напечатать следующий текст без форматирования символов: 
Тема – объективная основа произведения 
В «бесконечном лабиринте сцеплений», в многоуровневом поэтическом кос-

мосе художественного целого все образующие его элементы подчинены друг дру-
гу, иерархически упорядочены. Как и любая система, литературное произведение 
имеет свой центр (один или несколько) и свою периферию. Ядром художествен-
ной системы, ее признанным «руководящим центром» принято считать так назы-
ваемое идейно-тематическое содержание. Неразрывное единство темы и идеи со-
ставляет экстракт объекта и субъекта творчества, предмета искусства и его автор-
ского осознания, распространяющий свое влияние на все остальные элементы сис-
темы. 
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Художественный космос литературного произведения сродни государствен-
ному устройству. Он может напоминать и монархию (чаще всего), как абсолют-
ную, так и конституционную, и олигархию, и демократию, и партократию, и охло-
кратию, и федерацию, и конфедерацию… Наверное, только не анархию, ибо ос-
новным цементирующим принципом построения произведения является принцип 
художественной целесообразности, т.е. строгий порядок. 

Обрусевшее древнегреческое слово thema обозначает буквально «то, что по-
ложено» (в основу чего-либо). Тема – объективная основа произведения, понятие, 
указывающее самых общих чертах на преимущественное внимание писателя к оп-
ределенной стороне действительности и отвечающее на вопрос «Что изображе-
но?». Внешним образом тема – это то, о чем произведение, чему оно посвящено, 
что прежде всего бросается нам в глаза. 

Писатель не может и не должен замахиваться на отображение всей реальной 
действительности, которая его окружает. Он сосредоточивается на некой ее части, 
совершив первый этап своего творческого акта – художественный отбор. Катего-
рия темы, следовательно, помогает определить то, что непосредственно изображе-
но в произведении, сориентироваться в его содержании, очертить круг жизненных 
явлений, отобранных, отображенных и воспроизведенных автором. 

Иногда приходится сталкиваться с весьма распространенным отождествлени-
ем темы и проблемы, вернее – с подменой одного понятия другим. Именно так 
трактовал тему в своем популярном учебнике по введению в литературоведение 
Г.Л. Абрамович. Предложенное им определение «Тема – проблема, поставленная 
писателем в произведении» вызывает сомнение по крайней мере в двух аспектах. 

Во-первых, тема и проблема совпадают только частично. Понятие темы зна-
чительно шире понятия проблемы. Та или иная проблема (нравственная, социаль-
но-политическая, философская, религиозная) может стать темой лишь в произве-
дениях соответствующего масштаба и предназначения (в романах, повестях, тра-
гедиях, комедиях, драмах, поэмах). 

Во-вторых, понятие проблемы не должно подменять собой понятие темы, по-
скольку в нем нередко содержится, кроме объективной констатации того или ино-
го жизненного факта, и субъективно, личностно окрашенное отношение к нему 
писателя, т.е. некоторый отблеск идеи. 

Итак, тема есть проблема, явление или предмет, отобранный, осмысленный, 
домысленный и воспроизведенный определенными художественными средствами; 
часть действительности или ее аналог, уже преображенные в перл создания. 

4. Отформатировать 1 абзац: шрифт – Arial, размер – 24, видоизменение слов 
«идейно-тематическое содержание» – К, интервал после – 16 пт, межстрочный ин-
тервал – одинарный, выравнивание – по центру, цвет шрифта – красный, перед аб-
зацем вставить символ - . 

5. Отформатировать 2 абзац: шрифт – Book Antiqua, размер – 15, видоизме-
нение слов «государственному устройству» – подчеркнутый, отступ слева – 1,5 см, 
отступ справа – 1 см, отступ первой строки – 1,25 см, интервал перед – 3 пт, ин-
тервал после – 8 пт, межстрочный интервал – полуторный, выравнивание – по ле-
вому краю, цвет шрифта – зеленый. 

6. Отформатировать 3 абзац: шрифт – Monotype Corsiva, размер - 20, видоиз-
менение слов «thema», «то, что положено», «в основу чего-либо», «то, о чем», 



 102

«чему оно посвящено» – К, отступ слева – 1 см, отступ справа – 1 см, отступ пер-
вой строки – 1,27 см, межстрочный интервал – двойной, выравнивание – по пра-
вому краю, цвет шрифта – синий, разбить на две колонки. 

7. Отформатировать 4 и 5 абзацы: видоизменение слов «тема и проблема 
совпадают только частично», «понятие проблемы не должно подменять собой по-
нятие темы» – К. 

8. Отформатировать 8 абзац: шрифт – Times New Roman, размер – 16, видо-
изменение слов «тема», «проблема», «явление», «предмет» – Ж, отступ слева – 0 
см, отступ справа – 0 см, отступ первой строки – 1,5 см, межстрочный интервал – 
двойной, выравнивание – по ширине, цвет шрифта – синий. 

9. Отформатировать заголовок документа: начертание – ЖК, отступ перед – 
Авто, отступ после – Авто, размер – 30, цвет – желтый. 

10. Скопировать первые два абзаца в конец документа и разбить скопирован-
ный текст следующим образом: одно предложение – один абзац. 

11. Автоматически пронумеровать страницы документа: номер на первой 
странице не ставить, выравнивание от центра, внизу. 

12. Вставить в документ колонтитул: верхний колонтитул – ФИО, выравнива-
ние – по правому краю, нижний – автоматическая вставка даты создания докумен-
та, выравнивание – по центру. 

13. Проверить документ на наличие орфографических ошибок. 
14. Установить автоматическую расстановку переносов. 
15. Вставить из Коллекции картинок любую из понравившихся. 
16. Изобразить следующий заголовок с помощью инструмента Word Art: 

 
17. Изобразить следующую надпись к заголовку: 

 
18. Отредактировать рисунок следующим образом: 

 
19. Набрать следующий текст: 
Слово, как известно, является основной единицей языка, самым заметным 

элементом его художественных средств. И выразительность речи связана прежде 

 
Заголовок 

 Заголовок текста 
изменен 
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всего со словом. Многие слова обладают способностью употребляться в несколь-
ких значениях. Это их свойство называется многозначностью, или полисемией. 
Писатели находят в многозначности источник яркой эмоциональности, живости 
речи. Например, в тексте может быть повторено многозначное слово, которое, од-
нако, выступает в разных значениях: Поэт издалека заводит речь, поэта далеко за-
водит речь (М. Цветаева). 

20. Установить для первой буквы первого слова абзаца буквицу: шрифт – 
Arial, положение – в тексте, высота в строках – 5. 

21.  Вставить перед текстом (задание 7) заголовок «Лексические средства 
выразительности речи» и установить для него эффект «Мигающий фон». 

22. Сохранить документ с именем «Тема». 
Тема №3: Создание таблиц и схем. 
Задания к лабораторной работе: 
1. Вставить таблицу любым из перечисленных способов, содержащую 10 

строк и 9 столбцов. 
2. Объединить ячейки следующим образом: 

 
3. Вставить перед таблицей заголовок «Согласные звуки русского языка»: 

шрифт – Monotype Corsiva, размер – 16, начертание - Полужирный курсив. 
4. Заполнить таблицу следующим образом. Обратите внимание на выравни-

вание текста в ячейках таблицы. 
Место образования 

губные переднеязычные средне-
язычные 

задненебные Способ образо-
вания губно-

губные 
губно-
зубные

зубные передне-
небные 

средне-
небные 

средне-
небные 

задне-
небные 

ф в 
Ф’ в’ 

c з 
с’ з’ 

ш ж 
ш’ ж’ 

 х’ у’ х у 
срединные 

   jָ j   

Щ
ел
ев
ы
е 

боковые 
лָ л 
лָ’ л’ 

 

носовые мָ м 
мָ’ м’ 

нָ н 
нָ’ н’ 

 нг 

дрожащие рָ р 
рָ’ р’  

 

взрывные п б 
п’ б’ 

т д 
т’ д’ 

 к’ г’ к г 

С
мы

чн
ы
е 

аффрикаты ц дз 
ц’ д’з’ 

ч дж 
ч’ д’ж’ 

 

5. Оформить таблицу следующим образом. 
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6. Изобразить следующий объект. Самостоятельно задать цветовую гамму 

его элементам. 

 
 

Тема №4: Списки, стили, оглавления. 
Задания к лабораторной работе: 
1. Набрать следующий перечень (каждое слово на новой строке): сущест-

вительное, прилагательное, наречие, глагол. Выделить текст и оформить его в 
виде Нумерованного списка с помощью кнопки . 

2. Набрать следующий перечень (каждое слово на новой строке): Пушкин, 
Лермонтов, Некрасов, Толстой. Выделить текст и оформите его в виде Марки-
рованного списка с помощью кнопки . 

3. Изменить нумерованный список: нумерация начинается с 5,  нумерация 
– один, два, ….  

4. Изменить маркированный список: знак маркера – . 
5. Набрать следующий текст без соблюдения начертания (каждая фраза с 

новой строки): Введение в информатику, Краткая история развития инфор-

 

Зеленый 

Желтый 

Серый 
Оранжевый 

Цвет внутренней линии и рамки - синий 

Речь 

1 предложение 3 предложение 
2 предложение 

слово 

слово

слово

слово слово 

слово

слово 

слово 

слово
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мационных технологий, Введение, Информация, Понятие информации, Ин-
формационные системы, Системы счисления, Понятие системы счисления, Не-
позиционные системы счисления, Позиционные системы счисления, Представ-
ление информации в компьютере, Общие сведения, Формы и коды представле-
ния данных в памяти ЭВМ, Технические средства информационных техно-
логий, Компьютер, Базовая структура персонального компьютера, Устройства 
ввода-вывода, Программное обеспечение компьютера, Компьютерные сети, 
Локальные компьютерные сети, Глобальные компьютерные сети. 

6. Создать следующий многоуровневый список: 
− Уровень 1: Формат номера – Глава, нумерация – 1, 2, 3 ..., начать с – 1; По-

ложение номера: Выравнивание – по левому краю; Отступ – 0,5 см; От но-
мера до текста – 0 см. Шрифт – Полужирный. 

− Уровень 2: Формат номера – 1.1., нумерация – 1, 2, 3 ..., начать с – 1; Поло-
жение номера: Выравнивание – по левому краю; Отступ – 1 см; Шрифт – 
Обычный. 

− Уровень 3: Формат номера – 1.1.1., нумерация – 1, 2, 3 ..., начать с – 1; По-
ложение номера: Выравнивание – по левому краю; Отступ – 1,5 см; Шрифт – 
Курсив.  

7. Применить к набранному тексту созданный список следующим образом: 
первая трока – заголовок текста (выравнивание – От центра, начертание – По-
лужирный курсив); текст, выделенный жирным шрифтом – Уровень 1; под-
черкнутый текст – Уровень 2; текст, выделенный курсивом – Уровень 3.  

8. Набрать следующий текст: 
А. Пушкин  
Тиха украинская ночь. Прозрачно небо,  
Звезды блещут. 
Своей дремоты превозмочь 
Не хочет воздух. 
Я. Некрасов 
Быстро лечу я по рельсам чугунным, 
Думаю думу свою. 
Б. Пастернак 
Мело, мело по всей земле во все пределы. 
Свеча горела на столе, свеча горела. 
М. Лермонтов 
Горные вершины спят во тьме ночной. 
Тихие долины полны свежей мглой. 
С. Маршак 
Вокруг белеющих прудов 
Кусты в пушистых полушубках, 
И проволока проводов 
Таится в белоснежных трубках. 
9. Применить стиль Заголовок1 к фамилиям А. Пушкин, Я. Некрасов, Б. 

Пастернак. 
10. Создать новый стиль: имя – Поэт, основа на стиле – Заголовок1, стиль 
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следующего абзаца – обычный. Форматирование: шрифт – Monotype Corsiva, 
размер – 14, начертание - Полужирный курсив, выравнивание – От центра, 
межстрочный интервал – двойной. 

11. Применить стиль Поэт к фамилиям М. Лермонтов, С. Маршак. 
12. Разбить текст на страницы таким образом, чтобы каждый автор начи-

нался на новой странице. 
13. На последней странице вставить оглавление. 
14. Сохранить документ с именем «Стили». 
Тема №5: Язык и статистика: редактирование формул. 
Задания к лабораторной работе: 
1. Вставить в документ формулы согласно варианту, указанному препода-

вателем. 
Вариант 1. 
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Вариант 5. 
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Тема: Электронная таблица Excel. 
Тема №1: Знакомство с электронной таблицей   
Задания к лабораторной работе: 
1. Запустить табличный процессор MS Excel.  
2. Выделить: 

− Строки 5, 6, 9, 13. Снять выделение. 
− Столбцы В, C, F, G, K. Снять выделение. 
− Совокупность строк 1, 3, 6, 7, 10, 11 и столбцов B, D, G, H, I.  Снять выделение.  
− Блок ячеек B5: F10. 
− Совокупность блоков A1:C4, B6:E12, G8:H10. 

3. Вставьте два новых листа перед рабочим листом Лист3, используя оба 
способа.  

4. Переименовать Лист1 в Глагол; Лист2 в Наречие. 
5. Поменять местами листы Глагол и Наречие.  
6. Создать копии рабочих листов Глагол и Наречие.  
7. Удалить копии листов Глагол и Наречие.  
8. Сохранить рабочую книгу с именем «Части речи». 
Тема №2: Создание простейшей таблицы. Ввод и редактирование данных. 

Формат данных.  
Задания к лабораторной работе: 
1. В ячейку А1 внести слово Литература. 
2. Создайте ниже приведенную таблицу. 

№ п/п ФИО Дата рождения Век 
 Пушкин А.С. 6.06.1799  
 Гоголь Н.Ф. 1.04.1809  
 Лермонтов М.Ю. 3.10.1814  
 Толстой Л.Н. 28.08.1828  
 Блок А.А. 28.11.1880  
 Маяковский В.В. 7.07.1893  
 Чернышевский Н.Г. 24.07.1829  
 Горький А.М.  16.03.1868  
 Достоевский Ф.М. 11.11.1821  
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3. С помощью автозаполнения заполнить первый столбец таблицы таким об-
разом: 1 автор, 2 автор, 3 автор и т.д.  

4. Самостоятельно определить век, в котором родился каждый автор, и запол-
нить соответствующий столбец. 

5. Отредактировать в ячейке А1 слово Литература на Русская литература.  
6. После четвертой строки вставить пустую строку и заполнить ее таким об-

разом: ФИО – Цветаева М.И., Дата рождения – 26.09.1892. 
7. Вставить между столбцами ФИО и Год рождения новый столбец – Произ-

ведение и заполнить его самостоятельно. 
8. В столбце Дата рождения изменить формат представления информации на 

Дата, обозначение – 6 марта 1982 г (пример).  
9. Сохранить документ с именем «Таблица». 
Тема №3: Адресация. Вычисления в таблицах. 
Задания к лабораторной работе: 
1. В одном из опытов изучались частоты частей речи в прозе К. Федина. Бы-

ло взято 10 выборок по 500 знаменательных слов каждая. В выборки включалась 
только авторская художественная речь. Были получены следующие выборочные 
частоты имен существительных и имен прилагательных: 

Проза К.Федина 
Частоты выборок (xi) Части речи 1 2 3 4 5 6 7 8 9 10 

Ср. 
частота

Существительное 182 187 218 173 158 201 222 233 213 194  
Прилагательное 69 71 83 60 43 73 72 59 69 71  
Глагол 95 87 94 104 100 112 83 91 105 108  

− На Листе1 создать приведенную выше таблицу. 
− Переименовать Лист1 в Средняя. 

− Найти среднюю частоту выборки для каждой части речи по формуле 
n

x
x

n

i
i∑

== 1 , 

где n – количество выборок (наблюдений). Сделать вывод. 
2. Переименовать Лист2 в Отклонение. 
3. На листе Отклонение создать приведенную ниже таблицу и найти откло-

нение выборочных частот от средней частоты σ для каждой части речи по форму-

ле 
n

a
n

i
i∑

== 1

2

σ , где xxa ii −= . 

Выборочные частоты, их отклонение от средней частоты и квадраты этих 
отклонений 

Существительное Прилагательное Глагол Выборки 

ix  ia  2
ia  ix  ia  2

ia  ix  ia  2
ia  

1-ая          
2-ая          
…          
Сумма          
x     
σ    
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4. Переименовать Лист3 в Предложения. 
5. На листе Предложения создать таблицу сравнения количества предло-

жений текста некоторого объема у различных авторов.  
Автор Количество предложений Сравнение 

Толстой Л.Н. 358  
Чернышевский Н.Г. 226  
Макаренко А.С. 345  
Новиков Н.И. 289  
Одоевский В.Ф. 456  
Горький А.М. 384  
Общее количество   
Среднее количество   
Максимальное количество   
Минимальное количество   

− Найти общее количество предложений. 
− Найти минимальное количество предложений по всем авторам. 
− Найти максимальное количество предложений по всем авторам. 
− Найти среднее количество предложений по всем авторам. 
− Используя функцию ЕСЛИ определить «выше» или «ниже» среднего находится 

количество предложений текста каждого автора. 
6. Сохранить документ с именем «Язык и статистика». 
Тема №4: Сортировка данных и форматирование таблиц.  
Задания к лабораторной работе: 

1. Запустить MS Excel. 
2. Открыть файл Язык и статистика.xls. 
3. К таблице на листе Средняя применить следующие атрибуты форматирования: 
− выравнивание; 
− шрифты; 
− цвет фона; 
− ширина столбцов и высота строк; 
− рамка. 
5. К таблице на листе Отклонение применить стиль автоформатирования – Клас-
сический 2. 

6. На листе Предложения создать три копии таблицы (на этом же листе). 
7. К каждой таблице на листе Предложения применить стили автоформатирова-

ния – Цветной 1, Цветной 2, Цветной 3. 
8. На листе Предложения отсортировать первую таблицу – столбцу Количество 

предложений, вторую таблицу – по столбцу Автор. 
9. Сохранить рабочую книгу с именем «Язык и статистика (формат)». 

Тема №5: Графический анализ данных.  
Задания к лабораторной работе: 
1. По имеющимся данным: «за» – 7 чел., «против» – 11 чел., «воздержа-

лось» – 2 чел., построить круговую объемную диаграмму, отражающую про-
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центное соотношение результатов голосования. Цвета секторов – красный, си-
ний и зеленый соответственно.  

2. По данным таблицы построить различные типы диаграмм, отображаю-
щих: 
− долю каждого наименования в первом предложении; 
− динамику изменения количество подлежащих во всех предложениях; 
− сравнение общего числа наименований для всех предложений; 
− сравнение количества сказуемых в первом, третьем и пятом предложениях. 
Наименование 1 предло-

жение 
2 предло-
жение 

3 предло-
жение 

4 предло-
жение 

5 предло-
жение 

6 предло-
жение 

Подлежащее 11 12 12 15 17 19 
Сказуемое 15 21 20 20 17 19 
Деепричастие 23 29 32 34 30 33 
Итого       

3. Создать следующую таблицу и выполнить к ней задания. 
Факультет 
Группа 

1 курс 2 курс 3 курс 4 курс 5 курс Макс. 
кол-во 

Миним. 
кол-во 

Среднее 

ФПИ 75 68 68 62 56    
ФМО 60 58 55 57 49    
ФФ 100 91 92 85 69    

− вычислить максимальное, минимальное и среднее количество студентов по 
отдельным факультетам; 

− построить диаграмму, отображающую сравнение количества студентов на 
разных курсах по факультету ФФ (круговая или кольцевая); разместить диа-
грамму на текущем листе; на диаграмме должен быть отображен заголовок, 
подписи данных, легенда. 
Тема: Электронные презентации PowerPoint. 
Задания к лабораторной работе: 

1. Вставить любым способом пять пустых слайдов. 
2. Применить ко всем слайдам способ заливки – 

текстура (любую понравившуюся). 
3. Для первого слайда выбрать автомакет – ти-

тульный слайд. Применить к нему следующее оформле-
ние: 
− Текст заголовка – РУССКИЙ ЯЗЫК, шрифт – Mono-

type Corsiva размер – 80, цвет – синий, начертание – 
жирный. 

− Текст подзаголовка – ИМЯ СУЩЕСТВИТЕЛЬ-НОЕ, шрифт – Arial, размер – 
0, цвет – красный, начертание – полужирный курсив, тень. 

4. Для второго слайда выбрать автомакет – только 
заголовок и набрать приведенный текст (см. 
слайд). Применить к нему следующее оформление: 
шрифт – Arial. размер – 46, цвет: слово «существи-
тельное» – красный, остальной текст – черный; на-
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чертание: слово «существительное» – жирный, ос-
тальной текст – обычный. Весь текст находится 
внутри рамки (см. слайд), цвет заливки рамки – 
светло голубой.  

5. Для третьего слайда автомакет – схема и 
оформить его следующим образом (см. слайд). 
Цвет заливки элементов схемы – светло зеленый, 
цвет шрифта для «имя существительное» - темно 
синий, остальной текст - черный. Обратите внима-
ние на начертание некоторых слов. 

 
6. Для четвертого слайда выбрать 

автомакет – заголовок и маркированный 
текст и набрать приведенный текст (см. 
слайд). Цвет заголовка – синий, «ь» в за-
головке и по тексту маркированного 
списка выделен красным цветом. Обра-
тите внимание на начертание некоторых 
слов. 

 
7. Для пятого слайда выбрать авто-

макет – заголовок и таблица и набрать 
приведенный текст (см. слайд). Цвет за-
головка – красный. Обратите внимание 
на начертание некоторых слов. 

 

8. Вставить на первом слайде в верхний левый угол следую-
щую картинку (если таковой не окажется в списке картинок, то 
можно вставить любую другую). 

9. Задать для созданных слайдов различную анимацию и смену слайдов. 
10. Установить для слайдов следующие управляющие кнопки: 

− первый слайд:  – далее и  – в конец; 
− последний слайд:  – в начало; 
− остальные слайды:  – далее. 

10. Осуществить показ созданной презентации. 
11. Сохранить презентацию с именем слайды.pps. 
Тема: СУБД Access. 
Тема №1: Создание таблиц базы данных. 
Задания к лабораторной работе: 

1. Загрузите Access, в открывшемся окне Microsoft Access щелкните селектор-
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ную кнопку Новая база данных, затем - кнопку OK. 
2. В открывшемся окне Файл новой базы данных в поле Имя файла: введите 
имя Кафедра, в раскрывающемся списке поля Папка: выделите свою папку на 
диске С:, затем закройте окно, щелкнув кнопку Создать. Создаваемая база дан-
ных будет находиться в вашей папке на диска D:. 
3. В основном окне базы данных Кафедра: база данных выберите вкладку Таб-
лицы и щелкните кнопку Создать. 
4. В открывшемся окне Новая таблица выберите пункт Конструктор и щелк-
ните кнопку OK. В результате откроется окно Таблица1: таблица в режиме 
Конструктор, в котором определите поля таблицы согласно Таблице 3.  
Для этого: 
− введите в строку столбца Имя поля имя Код преподавателя, 
− поместите курсор в строку столбца Тип данных, раскройте список и выберите 

в нем слово Счетчик. В строку столбца Описание можно ничего не вводить, 
− аналогично определите другие имена и тип данных полей таблицы, 
− в нижней части таблицы Свойства поля во вкладке Общие установите ука-

занные в Таблице 1 размеры полей, предварительно поместив курсор на со-
ответствующую запись (строку) в верхней части таблицы. 

Таблица 1. Структура таблицы данных Преподаватели 
Имя поля Тип данных Размер поля 

Код преподавателя Счетчик  
Фамилия Текстовый 15 
Имя Текстовый 15 
Отчество Текстовый 15 
Должность Текстовый 9 
Дисциплина Текстовый 11 
Зарплата Денежный  

5. Сохраните созданную таблицу под именем Преподаватели. 
6. На запрос о задании ключевых полей ответьте Нет. 
7. Вернемся к таблице Преподаватели в режиме Конструктор. Если ее нет на 
экране, то активизируйте вкладку Таблицы и откройте ее. 
8. В верхней части таблицы щелкните по записи Должность. 
9. В нижней части окна Свойства поля во вкладке Общие щелкните по строке 
параметра Условие на значение и установите ограничения на данные, которые 
будут вводиться в поле Должность: должны вводиться только слова Профессор, 
Доцент или Ассистент. Для этого: 
− щелкните по кнопке , чтобы открыть окно Построитель выражений, 
− в открывшемся окне введите слово Профессор, щелкните по кнопке , до-

бавьте Доцент, снова щелкните по кнопке , затем добавьте Ассистент и 
закройте окно, щелкнув кнопку ОК. 

− в строке параметра Сообщение об ошибке введите сообщение: Такой долж-
ности нет, 

− в строке параметра Значение по умолчанию введите Доцент.  
10. Введите ограничения на данные в поле Код преподавателя. С одной сторо-
ны эти данные не должны повторяться, а с другой - должна быть обеспечена 
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возможность их изменения. Поэтому в этом поле нельзя использовать тип дан-
ных Счетчик, т.к. значения таких полей обновлять нельзя. Для выполнения 
второго условия задайте тип данных Числовой. А для выполнения первого ус-
ловия выполните следующее: 
− щелкните по строке параметра Индексированное поле, 
− раскройте список и выберите пункт Да (совпадения не допускаются), 
− перейдите в режим Таблица, щелкнув кнопку  слева на панели инстру-

ментов и при запросе на сохранение щелкните кнопку Да. 
11. В режиме Таблица заполните таблицу данными о преподавателях в соответ-
ствии с Таблицей 2 и проверьте реакцию системы на ввод неправильных дан-
ных в поле Должность, введя, например, слово Лаборант. 

Таблица 2. Таблица данных Преподаватели 
Код Фамилия Имя Отчество Должность Дисциплина Зарплата 
1 Куклев Федор Петрович Доцент Информатика 9800 р. 
2 Максимов Никита Юрьевич Профессор Экономика 14500 р. 
3 Андреев Борис Сергеевич Доцент Статистика 7600 р. 
4 Лидский Виктор Борисович Профессор Математика 12500 р. 
5 Колосов Алексей Ивановна Доцент Математика 8900 р. 
6 Беляев Виктор Павлович Ассистент Информатика 3900 р. 
7 Максимов Иван Николаевич Доцент Информатика 8900 р. 

12. Измените ширину поля Дисциплина в соответствии с шириной данных, 
предварительно переведя курсор в любую строку данного поля и используя ко-
манду Формат/Ширина столбца... - кнопка По ширине данных. 
13. Произведите поиск преподавателя Максимова, для чего поместите курсор в 
первую строку под именем поля Фамилия и выберите команду Правка/Найти.... 
14. В открывшемся диалоговом окне Поиск в поле: Фамилия в поле Образец: 
введите Максимов, в поле Просмотр: выберите Все, в поле Совпадения: выбе-
рите С любой частью поля, у опции Только в текущем поле установите флажок 
и щелкните кнопку Найти. Чтобы найти следующую запись, щелкните кнопку 
Найти далее. Затем щелкните кнопку Закрыть. 
15. Измените заработную плату ассистенту Беляеву с 3900руб. на 4300руб., для 
чего поместите курсор в первую строку поля Зарплата и выберите команду 
Правка/Заменить.... 
16. В открывшемся диалоговом окне Замена в поле: Зарплата в поле Образец: 
введите 3 900р., в поле Заменить на: введите 4 300р., в поле Просмотр: выбери-
те Все, у опции Только в текущем поле установите флажок и щелкните кнопку 
Найти далее. Когда запись будет найдена, щелкните кнопку Заменить. Затем 
щелкните кнопку Закрыть. 
17. Произведите сортировку данных в поле Зарплата по убыванию, используя 
команду Записи/Сортировка/Сортировка по убыванию (предварительно помес-
тив курсор на любую запись данного поля). 
18. Произведите фильтрацию данных сначала по полю Должность (например, 
профессор), затем – Дисциплина (например, математика), используя команду 
Записи/Фильтр/Фильтр по выделенному (предварительно поместив курсор на 
соответствующую запись данного поля). После выполнения окончательной 
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фильтрации удалите фильтр командой Записи/Удалить фильтр. 
19. Просмотрите, как созданная таблица будет выглядеть на листе бумаги при 
печати, используя команду Файл/Предварительный просмотр. 
20. Закройте таблицу Преподаватели, щелкнув кнопку . 
21. Создайте в базе данных Кафедра таблицу Студенты. Для этого: 
− в окне базы данных выберите вкладку Таблицы и щелкните по кнопке Соз-

дать; 
− в открывшемся окне Новая таблица выберите пункт Конструктор и щелк-

ните по кнопке ОК; 
− создайте структуру таблицы Студенты: определите ее имена полей, тип 

данных и свойства полей в соответствии с Таблицей 3; 
− в качестве ключевого поля определите поле Код студента, для чего активи-

зируйте это поле и щелкните по кнопке ; 
− закройте таблицу, задав ей имя Студенты. 

Таблица 3. Структура таблицы данных Студенты 
Имя поля Тип данных Размер поля 

Код студента Числовой Целое 
Фамилия Текстовый 15 
Имя Текстовый 15 
Отчество Текстовый 15 
Номер группы Числовой Целое 
Телефон Текстовый 9 
Стипендия Логический Да/Нет 

22. Аналогично создайте структуру таблицы Дисциплины, определив ее имена 
полей, тип данных и свойства полей в соответствии с Таблицей 4, а ключевым 
выбрав поле Код дисциплины. 

Таблица 4. Структура таблицы данных Дисциплины 
Имя поля Тип данных Размер поля 

Код дисциплины Числовой Целое 
Название дисциплины Текстовый 30 

23. Создайте в базе данных Кафедра структуру таблицы Оценки, определив ее 
имена полей, тип данных и свойства полей в соответствии с Таблицей 5. На во-
прос о создании ключевого поля ответьте Нет. 

Таблица 5. Структура таблицы Оценки 
Имя поля Тип данных Размер поля 

Код студента Числовой Целое 
Код дисциплины Числовой Целое 
Оценки Числовой Байт 

24. В базе данных Кафедра измените структуру таблицы Преподаватели, доба-
вив в нее поле Код дисциплины и определив его тип данных и размер в соот-
ветствии с данными Таблицей 4. 
25. Закройте таблицы Преподаватели, Дисциплины, Оценки и Студенты, если 
они открыты. 

26. Щелкните по кнопке  на панели инструментов (или выполните команду 
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Сервис/Схема данных). На экране откроется окно Добавление таблицы. 
27. В открывшемся окне будет выделено название одной таблицы. Щелкните по 
кнопке Добавить. 
28. Переведите выделение на имя следующей таблицы и щелкните по кнопке 
Добавить. Аналогично добавьте оставшиеся две таблицы. 
29. Закройте окно, щелкнув по кнопке . 
30. Создайте связь между таблицами Дисциплины и Оценки. Для этого подведи-
те курсор мыши к полю Код дисциплины в таблице Дисциплины, щелкните ле-
вой кнопкой мыши и, не отпуская ее, перетащите курсор на поле Код дисцип-
лины в таблицу Оценки, а затем отпустите кнопку мыши. На экране откроется 
окно Связи. 
31. Установите флажок («галочку») в свойстве Обеспечение целостности дан-
ных, щелкнув по нему. 
32. Установите флажок в свойстве Каскадное обновление связанных полей и 
Каскадное удаление связанных полей. 
33. Щелкните по кнопке Создать. Связь будет создана. 
34. Аналогично создайте связи между полями Код дисциплины в таблице Дис-
циплины и полем Код дисциплины в таблице Преподаватели, а также между 
полем Код студента в таблице Студенты и полем Код студента в таблице 
Оценки. 
35. Закройте окно схемы данных, ответив Да на вопрос о сохранении макета. 

Тема №2: Работа с формами. 
Задания к лабораторной работе: 

1. В окне базы данных Кафедра: база данных активизируйте вкладку Формы и 
щелкните кнопку Создать. 

2. В открывшемся окне Новая форма выберите Мастер форм, а в нижней части 
окна раскройте список и выберите таблицу Преподаватели, затем нажмите 
кнопку OK. 

3. В открывшемся окне Создание форм из поля списка Доступные поля пере-
ведите в поле списка Выбранные поля те, которые будут присутствовать в 
форме. В данном случае это все поля, поэтому щелкните по кнопке  и 
нажмите кнопку Далее. 

4. В следующих окнах Мастера форм выберите соответственно внешний вид 
формы в один столбец, затем требуемый стиль оформления и далее задайте имя 
форме Состав преподавателей. 

5. После нажатия кнопки Готово откроется форма в один столбец. 
6. Найдите запись о доценте Максимове, для чего сначала переведите курсор в 

первую строку поля Фамилия, затем выполните команду Правка/Найти. 
7. Переведите курсор в первую строку поля Зарплата и, используя команду Прав-

ка/Заменить..., повысьте зарплату ассистенту с 4300руб. на 4500руб.  
8. Произведите сортировку поля Фамилия по убыванию командой Запись/ Сорти-

ровка/Сортировка по убыванию, предварительно поместив курсор в любую за-
пись данного поля. 

9. Поместив курсор на запись Доцент поля Должность командой Запись/ 
Фильтр/Фильтр по выделенному, оставьте в таблице только записи о препода-
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вателях - доцентах. 
10. Аналогичной процедурой оставьте в таблице только записи о преподавателях – 

доцентах по дисциплине информатика. 
11. Удалите фильтр командой Записи/Удалить фильтр. 
12. Теперь измените название поля Дисциплина на Преподаваемая дисциплина. 

Для этого: 
− перейдите в режим Конструктор, щелкнув кнопку  слева на панели инст-

рументов, 
− щелкните правой кнопкой мыши в поле Дисциплина (оно слева), 
− в контекстном меню выберите пункт Свойства, 
− в открывшемся окне свойств поля Дисциплина в строке Подпись вместо Дисци-
плина введите Преподаваемая дисциплина, 

− для просмотра результата перейдите в режим Форма. 
13. Просмотрите, как данная форма будет выглядеть на листе бумаги. 
14. Закройте форму Состав преподавателей, щелкнув кнопку . 

Тема №3: Формирование запросов и отчетов для отдельных таблиц базы дан-
ных. 

Задания к лабораторной работе: 
1. На основе таблицы Преподаватели создайте простой запрос на выборку, в кото-
ром должны отображаться фамилии, имена, отчества преподавателей и их долж-
ность. Для этого: 
− откройте вкладку Запросы и в открывшемся окне щелкните по кнопке Создать, 
− в окне Новый запрос выберите пункт Простой запрос и нажмите кнопку ОК, 
− в открывшемся окне Создание новых запросов в строке Таблицы/запросы выбе-

рите таблицу Преподаватели, а в поле списка Доступные поля выделите слово 
Фамилии и щелкните по кнопке  для перевода его в поле Выбранные поля, 

− аналогично переведите туда поля Имя, Отчество, Должность и щелкните по 
кнопке Далее, 

− в строке параметра Задайте имя запроса введите имя Должности преподава-
телей и щелкните по кнопке Готово. 

2. В открывшейся таблице с результатами запроса отсортируйте по убыванию 
данные по полю Должность. 
3. Сохраните запрос. 
4. Создайте новый запрос под именем Преподаваемые дисциплины на выборку с 
параметром, в котором должны отображаться фамилии, имена, отчества препода-
вателей и преподаваемые ими дисциплины, а в качестве параметра задайте фами-
лию преподавателя и выполните этот запрос для преподавателя Лидского. Для это-
го: 
− создав аналогично предыдущему пункту запрос под именем Преподаваемые 
дисциплины, перейдите в режим Конструктор, 

− в строке параметра Условия отбора для поля Фамилия введите фразу: [Введите 
фамилию преподавателя], 

− выполните запрос командой Запрос/Запуск, 
− в открывшемся окне введите фамилию Лидский и щелкните по кнопке ОК. 
5. Сохраните запрос и закройте окно запроса. 



 117

VIII. КОМПЛЕКТ ЗАДАНИЙ ДЛЯ ПРАКТИЧЕСКИХ ЗАНЯТИЙ 
Тема. Множества. Числовые множества. 

1. Какие из вышеприведенных высказываний истинны, а какие ложны? 
1.1. Если  множество М={ }012:),( =−− yxyx , то:  
a) (1;1)∈ М; b) (2;-1)∉ М;  c) (2;3)∉ М;   d) (-1;2)∈ М.  

1.2.  Если  множество М=
⎭
⎬
⎫

⎩
⎨
⎧ ≤ 2:),(

x
yyx , то:  

a) (-1;1) ∉ М; b) (0;1) ∈ М;  c) (6;3) ∈ М;   d) (-1;-2)∈ М.  
1.3. Если  множество М={ }22 11:),( xyxyx −≤≤− , то:  
a) (-2;1)∈ М; b) (1;-1) ∈ М;  c) (2;1)∉ М;   d) (0;0)∈ М.  
2. Решите задачи: 
a) Из 220 школьников 163 играют в футбол, 175 – в баскетбол, 24 не игра-

ют в эти игры. Сколько человек одновременно играют в баскетбол и футбол? 
b) Среди 35 туристов английским языком владеют 11 человек, английским 

и франзуским – 5 человек. 9 человек не владеют ни английским, ни француз-
ским. Сколько человек владеют только франзуским языком? 

c) Проведенное среди школьников анкетирование показало, что в шахматы 
умеют играть 35 школьников, в шашки – 40 человек, причем в обе игры умеют 
играть 21 человек. Сколько человек не умеют играть ни в шахматы, ни в шаш-
ки, если всего опросили 60 школьников?    

3. Верно ли, что: 
1) {1;2}⊂{{1;2;3},{1;3}, 1, 2}; 2) {1;2}∈{{1;2;3},{1;3}, 1, 2};  
3) {1;3}∈{{1;2;3},{1;3}, 1, 2}; 4) {1;3}⊂{{1;2;3},{1;3}, 1, 2};  
4. Даны множества: A={0;1;2;3;4;5;6;7}, B={3;4;5;6;7;8;9},  
    C={-3;-2;-1;0;1;2;3;4}, D={2;3;4;5;6}. 
Найти: 1) A∪B∪C∪D; 2) A∩B∩C∩D; 3) (A∩B)∪ (C∩D); 
4) (A∪B)∩ (C∪D); 5) (A\B)∪ (B\A).    
 5. Найти множества значений функций: 
a) f(x)=x2+4x+1; 
b) f(x)=

x
1 +4 

c) f(x)=x2-8x+20; 
d) f(x)=2sin(x)-7; 

e) f(x)=3-5cos(x); 
f) f(x)= 25 +− x  

Тема. Элементы линейной алгебры. 

1. Найти произведения матриц AB  и BA (если они существуют): 

a) ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
=⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
−
−

=
52
43

,
45
23

BA  

b) ( )

⎟
⎟
⎟
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜
⎜
⎜
⎜

⎝

⎛

−=−=

2
5
1

1
3

,13204 BA  
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c) 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−=

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−

−
=

214
723
104

,
523
420
621

BA  d) 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−

−−
=⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
−

=
247

702
651

,
625
013

BA  

2. Найти значение матричного многочлена )(Af : 

a) если ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

=++=
30

51
,23)( 23 Axxxf   b) если  

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−=+−=
412
120

021
,253)( 2 Axxxf

3. Найти: 

a) 

⎟
⎟
⎟
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜
⎜
⎜
⎜

⎝

⎛

−

−⋅
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−
−−

⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

−

−
⋅
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−−

26
30
45
12
83

86143
55422
04701

74
55
32

21

3822
2251

1103
 

b) ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

−
⋅

⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

−

−

+
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

−−
⋅

⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

−

−
−

2301
1562

31
05
42
13

3210
1102
4321

164
220
141
415

 

4. Решить уравнения: 

a) 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−
−

⋅=
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−

−
+

601
854
321

5
653
742
401

X

 

b) 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−−⋅=

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−
−−⋅−

509
7147

14124
4

518
232

441
7X

5. Решить систему уравнений по формулам Крамера: 

a) 
⎪
⎩

⎪
⎨

⎧

−=+
=++
=++

687
9654

632

yx
zyx

zyx
 

b) 
⎪
⎩

⎪
⎨

⎧

=+
=++
=++

187
19654

832

yx
zyx

zyx
 

c) 
⎪
⎩

⎪
⎨

⎧

−=++
−=++
−=++

132
332
823

zyx
zyx
zyx

 

d) 
⎪
⎩

⎪
⎨

⎧

−=−+
=−+

−=−+

12
032

3254

zyx
zyx

zyx

6. Решить систему уравнений  методом Гаусса: 

a) 
⎪
⎩

⎪
⎨

⎧

−=++
=++−

=−+

1825
8233

103

zyx
zyx

zyx
 

b) 
⎪
⎩

⎪
⎨

⎧

−=+−−
−=++−

−=−+

2834
11962

332

zyx
zyx

zyx
 

c) 
⎪
⎩

⎪
⎨

⎧

=−+
=+−
=−+

84
3332

222

zyx
zyx

zyx
 

d) 
⎪
⎩

⎪
⎨

⎧

=−+
=−+
=++

043
432
632

zyx
zyx
zyx

 

7. Вычислить определители: 

a) 
631
321
111

 b) 
132

242
031

−−
 c) 

423
244
015

−−

−
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d) 
35
82−  

e) 
134

211
926

−−−
 f) 

455
712
924

−−
−  

8. Даны следующие матрицы: 

⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛

−
−

−−
−

=

32023
24220
13141

04293

A ;      
⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛ −

=

4130
8076
0512
3321

B ;           
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−=

312
543
120

C ;  

      
⎟⎟
⎟
⎟
⎟

⎠

⎞

⎜⎜
⎜
⎜
⎜

⎝

⎛
−

−

=

522
107
412
300

D ;     
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−=
42
33

81
E ;       

⎟
⎟
⎟
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜
⎜
⎜
⎜

⎝

⎛ −

=

60
53
04
21
12

F ;        
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−=

311
312
031

G . 

Найти:  
a) все произведения матриц,  которые имеют смысл; 
b) соответствующие транспонированные матрицы; 
c) матрицу 22 CG − . 

Тема. Аналитическая геометрия на плоскости. 

1. Дан треугольник с вершинами А(2;-2), В(3;5), С(6;1).  
Найти:  
a) площадь треугольника,  
b) длины сторон треугольника, 
c) общее уравнение сторон треуголь-

ника, 
d) уравнения сторон с угловым коэф-

фициентом, 
e) уравнения медиан, проведенных из 

каждой вершины, 

f) длины этих медиан, 
g) уравнения высот, опущенных из 

каждой вершины, 
h) длины этих высот, 
i) углы между сторонами треуголь-

ника. 

2. Записать уравнения с угловым коэффициентом, в отрезках для заданных 
прямых и определить на каком расстоянии от начала координат они нахо-
дятся: 

a) 2x-3y+6=0; 
b) x+2,5=0; 

c) y=x-1; 
d) x+5y=0. 

 3. Найти угол между прямыми: 

a) y=2x-3 и y=
2
1 x+5 

b) 2x-3y+10=0 и 5x-y+4=0 
c) y=

4
3 x-2 и 8x+6y+5=0 

d) y=5x+1 и y=5x-2 
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4. Найти координаты центра и радиус окружности. Построить окружности: 
a) 0168422 =−+−+ yxyx  
b) 095544299 22 =−−++ yxyx  

5. Дано уравнение эллипса 11764924 22 =+ yx . Найти:  
a) длины его полуосей, 
b) координаты фокусов, 
c) эксцентриситет эллипса, 
d) уравнения директрис и расстояние между ними. 

6. Дано уравнение гиперболы 2045 22 =− yx .Найти:  
a) длины его полуосей, 
b) координаты фокусов, 
c) эксцентриситет гиперболы, 
d) уравнения асимптот и директрис, 
e) фокальные радиусы точки М(3;2,5). 

7. Определить вид линии и построить ее: 
a) 16x2+25y2-400=0 
b) 4(x-1)2+9y2=72 
c) 9x2+25(y+1)2=450 

d) 9x2-4y2=125 
e) 16x2-9y2=-144 
f) 5(x-2)2-(y+1)2=25 

Тема. Начала математического анализа. 

Вычислить пределы: 

9. 
52
3lim
+
+

∞→ x
x

x
                                                  

10. 
65

4lim 2

2

0 ++
−

→ xx
x

x
 

11. 2

2

431
562lim

xx
xx

x −−
−+

∞→
 

12. 
x

x
x

24lim
0

−+
→

 

13. 
63
52lim

1 +
−

−→ x
x

x
 

14. 97

36

2
34lim

xx
xxx

x +
++

∞→
 

15. 
1572

152lim 2

2

5 −+
−+

−→ xx
xx

x
 

16. 
x

x
x 2sin

sinlim
0→

 

17. 
x

xtg
x

2lim
0→

 

18. 
x

x x

5

1
11lim ⎟

⎠
⎞

⎜
⎝
⎛

+
+

∞→
 

19. 
1

23lim
2

1 −
+−

→ x
xx

x
 

20. 
23

293lim 2

22

2 +−
+−−++

→ xx
xxxx

x

 

Тема. Дифференциальное исчисление функции одного действительно-
го переменного. 

1. Вычислить производную: 
a) xxy cos3sin5 +=  
b) )5cos(75 2 xxy ++=  

c) 
1

1
+

= xe
y  

d) 3 2xy =  
e) ( )xtgxy −= 5  
f) 2

2 xy =  
g) xexy 2=  

h) arctgxxy 4=  

i) 
x

xy arcsin
=  

j) ( )53 45 += xy  

k) 
5

sin 6 xy =  

l) ( )65ln 2 −+= xxy  
m) 231 xy −=  
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n) 3

7
x

y =  

o) ( ) xexxy −++= 222  
p) xxarctgxxy 2arccos5ln2 −+=  

q) 
4

1
1
⎟
⎠
⎞

⎜
⎝
⎛

+
−

=
x
xy  

2. Составить уравнение касательной и нормали к кривым в указанных точках: 
a) 2,3542 0

23 =−−−= xxxxy  

b) 0,
12
32

0 =−
+

= x
x
xy  

c) ( ) 0,1ln 0 =+= xxy  
3. Найти угол между кривыми: 

a) 415 22 +=−+= xyиxxy  

b) 2
3 1

x
yиxy ==  

Тема. Основы теории вероятности. 
1. Ученик должен выполнить практическую работу по математике. Ему  
предложили на выбор 17 тем по алгебре и 13 тем по геометрии. Сколькими 
способами он может выбрать одну тему для практической работы? 
2. В группе 15 студентов  - 5  из них, выйдя из аудитории на перерыв, стоят 
вместе и беседуют. Порядок, в котором они стоят несуществен. Сколько  в дан-
ном случае возможно комбинаций? 
3. Сколько 3-значных чисел можно составить из цифр 1,2,3,4  если каждая циф-
ра входит в изображение числа только один раз. 
4. Имеется 5 билетов денежно-вещевой лотереи, 6 билетов спортлото и 10 
билетов автомотолотереи. Сколькими способами можно выбрать один би-
лет из спортлото или автомотолотереи? 
5. Сколько можно составить сигналов из 6 флажков различного цвета, взятых 
по 2? 
6. В группе 25 студентов, 7 из них на перерыве отправились в буфет. Сколько 
всевозможных способов можно составить из 25 по 7? 
7. Сколькими способами можно выбрать один цветок из корзины, в которой 
имеется 12  гвоздик, 15 роз и  7 хризантем. 
8. Из 10 мальчиков и 10 девочек спортивно класса для участия в эстафете надо 
составить три команды, каждая их которых состоит из  мальчика  и  девочки. 
Сколькими способами это можно сделать? 
9.  На 5 карточках разрезной азбуки изображены буквы Е, Е, Л, П, П. Ребенок 
случайным образом выкладывает их в ряд. Какова вероятность того, что у    не-
го получится слово «ПЕПЕЛ»?  
10. В урне 2 белых и 7 черных шаров. Из нее наудачу вынимают (без возврата) 
2 шара. Какова вероятность того, что они оба будут разных цветов. 
11. Из колоды карт (36) вытаскивают наудачу 5 карт. Какова вероятность того, 
что будут вытащены 2 туза и 3 шестерки. 
12. Вероятность попадания в мишень при каждом выстреле для первого стрелка 
равна 0,7, а для второго – 0,8. Оба они делают по одному выстрелу по мишени, 
а затем каждый из стрелков стреляет еще раз, если при первом сделанном вы-
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стреле он промахнулся. Найти вероятность того, что в мишени ровно 2 пробои-
ны. 
13.  На  складе имеется 15 кинескопов, причем 10 из них изготовлены Львов-
ским заводом. Найти вероятность того, что  среди 5 взятых наудачу кинескопов 
окажутся  3 кинескопа  Львовского завода. 
14.  В урне 6 белых, 5 черных и 4 красных шара. Найти вероятность того, что 
при первом испытании появится красный шар, при втором белый, при третьем 
черный шар. 
15.   Какова вероятность того, что из колоды будут вынимать подряд 3 туза?  
16.  Из колоды в 52 карты вынимается одна карта. Какова вероятность того, что 
будет вынута карта  черви  или шестерка? 
17.   Брошена игральная кость. Найти вероятность того, что выпадет  нечетное 
или кратное двум  число очков? 
18. В торговую фирму поставляют телевизоры тремя фирмами в соотношении  
3:2:3. Телевизоры, поступающие от этих фирм, не требуют ремонта в течение 
гарантийного срока  96%; 92%; 94%. Найти вероятность того, что купленный 
наудачу телевизор не потребует ремонта в течение гарантийного срока.  
19. Вероятность изготовления стандартной детали равна 0,9. Чему равна веро-
ятность того, что из пяти наудачу взятых деталей три окажутся стандартными. 
20. Три стрелка произвели залп по цели. Вероятность поражения цели для каж-
дого стрелка равна соответственно 0,7; 0,8; 0,9. Найти вероятность того, что: 
a) только один стрелок поразит цель; 
b) только два стрелка поразят цель; 
c) все три стрелка поразят цель; 
d) хотя бы один стрелок поразит цель. 
21. В среднем 20% пакетов акций на аукционах продаются по первоначально 
заявленной цене. Найти вероятность того, что из 9 пакетов акций в результате 
торгов по первоначально заявленной цене: 
a) будет продано менее 2-х пакетов; 
b) будет продано не более  2-х пакетов; 
c) будет продано хотя бы   два  пакета; 
d) ровно два пакета. 
22. На елочный базар поступают елки с трех лесхозов, причем первый лесхоз 
поставил  50% елок, 2-й- 30%; 3-й- 20%. Среди елок 1-го лесхоза 10% голубых, 
2-го – 20%, 3-го – 30%. Куплена одна елка. Она оказалась голубой. Какова ве-
роятность, что она поставлена 2-м лесхозом?   
23. Имеются две одинаковые урны с шарами. В первой находится  3 белых и 4 
черных шара, во второй-2 белых и 3 черных.  Из наудачу выбранной урны вы-
нимают один шар. Какова вероятность того, что  этот шар белый? 
Тема. Случайные величины. 

1. Дискретная случайная величина задана рядом распределения:   
X -2 1 2 3 
P 0,08 0,40 0,32 0,2 

Найти: )(XM , )(XD , ( )Xσ . 



 123

2. Из 30 вопросов студент знает 3. Составить закон распределения случайной 
величины X-числа вопросов, которые он знает из 4 предложенных. Найти 

)(XM , )(XD , ( )Xσ . Составить функцию  F(x), построить ее график. 
3. В доме 3 лифта. Вероятность выхода из строя каждого их них равна 0,7. Со-
ставить закон распределения случайной величины X-числа вышедших из строя 
лифтов в течение дня.  Найти )(XM , )(XD , ( )Xσ . Составить функцию  F(x), по-
строить ее график. 
4. Игральная кость брошена 4 раза. Составить закон   распределения случайной 
величины X – числа появлений пятерки. 
Тема. Основы математической статистики. 

5. Дискретная случайная величина задана рядом распределения:   
X 30 35 38 40 
P 0,08 0,4 0,32 0,2 

Найти: 
a) )(XM , )(XD , ( )Xσ  
b) построить многоугольник распределения 
2. УВД города Дрюкова опубликовало сводку о числе правонарушений, со-
вершенных подростками   за первые 20 дней  сентября: 

ix~  4 6 7 8 9 12 13 14 17 
im  1 3 2 2 1 5 4 1 1 

Найти среднее число правонарушений за один день. 
3. Управление сельского  хозяйства Дрюковского района представило сводку 
по 50  хозяйствам. Согласно этой сводке, урожайность ржи в них составила (в 
центнерах с гектара): 17,5     17,8     18,6     18,3     19,1     19,9     20,6     20,1     22     
21,4     17,5     18,5 19        20     22     20,6     19,1     18,6     17,9     19,1     22     19     
17,5     22     22,6     21     21,4     19     17,8     18,3     19,9     20,1     21,4     18,5     
20     20,6     18,6     21,4     21     20     20     18     18     18         17,5     18,6     19,1     
20,6     17,5     18,6  
Построить: 

a) сгруппированный статистический ряд; 
b) гистограмму; 
c) полигон относительных частот. 
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IX. ИНДИВИДУАЛЬНЫЕ ЗАДАНИЯ ДЛЯ ДОМАШНЕЙ РАБОТЫ 
 

Задание 1 
Решить систему методом Гаусса и по формулам Крамера: 

1. 
⎪
⎩

⎪
⎨

⎧

=++
=++
=++

1132
132
523

zyx
zyx
zyx

 

2. 
⎪
⎩

⎪
⎨

⎧

=−−
=−+
=+−

6523
20432
632

zyx
zyx
zyx

 

3. 
⎪
⎩

⎪
⎨

⎧

=−+
=−+
=+−

18265
4352
9234

zyx
zyx
zyx

 

4. 
⎪
⎩

⎪
⎨

⎧

=+−
=−+
=−−

11423
11243
42

zyx
zyx

zyx
 

5. 
⎪
⎩

⎪
⎨

⎧

=−+
=−+

=−+

334
2638

1

zyx
zyx

zyx
 

6. 
⎪
⎩

⎪
⎨

⎧

−=++
−=+

=−

20432
43114

3157

zyx
zx
yx

 

7. 
⎪
⎩

⎪
⎨

⎧

−=++
−=+−
−=++

244
422
12

zyx
zyx
zyx

  

8. 
⎪
⎩

⎪
⎨

⎧

=++
−=−−
=++

05
432
8243

zyx
zyx

zyx
 

9. 
⎪
⎩

⎪
⎨

⎧

−=−−
=++
−=−−

9653
53

324

zyx
zyx
zyx

 

10. 
⎪
⎩

⎪
⎨

⎧

=+−
=++
=++

93
2025
3142

zyx
zyx
zyx

           

Задание 2 
Вычислить  АВ-3Е: 

1. 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
=

103
412
013

А ,  
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−=

102
112
103

В  

2. 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−−=
120
110

112
А ,   

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−−=
111
123

100
В  

3. 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛ −−
=

010
034
111

А ,  
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

−
=

122
101

105
В  

4. 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
=

122
100
113

А ,     
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
=

211
100
111

В  

5. 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−

−−
=

022
210
133

А ,   
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

−−
=

110
221
053

В  

6. 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−
=

112
201
103

А ,   
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−

−
=

102
200
533

В  

7. 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−−
=

211
122
003

А ,   
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
=

541
100
011

В  

8. А=
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛ −

112
015
120

,    В=
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−

−

222
111

022
 

9.   А= 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

122
110
103

,  В=
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛ −−

312
200
111

 

10. А=
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−

−

301
211
155

,    В=
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

011
120
013

 

Задание  3 

Построить кривую: 
3)1( 2 +=− yx  

2. 4)1( 22 =++ yx  
3. 9)1( 22 =−+ yx  
4. 1)1( 2 −=+ yx  

5. 2)1(5 +=− yx  
6.  122 =− yx  
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7. 1
14

)1( 22

=+
− yx  

8. 1
9

)1(
2

2 =+−
yx  

9. 1
9

)1(
4

22

=
+

−
yx  

10. 1
49

)1( 22

=−
+ yx  

Задание 4 
Решить задачу. Построить  чертеж.  Дан треугольник АВС: 

1. А(1;0),   В(3;2),   С(3;1). Найти уравнение медианы АМ. 
2. А(2;1),   В(-1;-4),  С(3;2). Найти  тангенс угла А. 
3. А(0;6),   В(0;10),  С(11;3). Найти уравнение высоты СН. 
4. А(3;1),   В(2;3),  С(4;3). Найти площадь треугольника. 
5. А(0;4),   В(9;0),  С(0;0). Найти площадь треугольника. 
6. А(3;5),   В(2;4),  С(0;1). Найти уравнение стороны АВ. 
7. А(2;4),   В(0;0),  С(4;6). Найти величину угла В. 
8. А(-1;0),  В(0;4),  С(3;0). Найти длину высоты ВН. 
9. А(3;1),   В(0;4),  С(6;0). Найти уравнение медианы АМ. 
10. А(3;1),   В(3;3),  С(1;1). Найти площадь треугольника. 

Задание 5 
Вычислить пределы: 

1. ( )86lim 2

2
++

−→
xx

x
 ;               

65
4lim 2

2

2 +−
−

→ xx
x

x
;                 

322
543lim 23

32

−+
+−

∞→ xx
xxx

x
.                                        

2.  ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

+−
→ 1

23lim
2

1 x
xx

x
;             

2
3lim 2

24

−
++

∞→ x
xxx

x
;                

52
13lim

2 +
−

→ x
x

x
.                      

3.  ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ −+
→ x

xxx
x 7

32lim
23

0
;          

36
21lim

2

2

3 −+

−+
→ x

x
x

;                
253
24lim 47

23

−+
−+

∞→ xx
xx

x
.                     

4.  
x

x
x

2sinlim
0→

;                       
521

1253lim 23

2

++
++

∞→ xx
xx

x
;               

1
38lim

1 −
−+

→ x
x

x
.                                           

5.  
xx

xx
x 2

13lim 4

3

+
++

∞→
;                 

x

x x
⎟
⎠
⎞

⎜
⎝
⎛ +

∞→ 2
11lim ;                      

x
x

x

5sinlim
0→

. 

6.  
x
x

x

11lim
0

−+
→

;                  
xxx

xx
x ++

++
∞→ 23

3

7
126lim ;                 )105(lim 3

5
+−

→
xx

x
. 

7. 
1

345lim 2

345

−
−+

∞→ x
xxx

x
;         

x
x

x 4
2sinlim

0→
;                         

25
56lim 2

2

5 −
+−

→ x
xx

x
. 

8. 23

3

2
13lim

xx
xx

x +
++

∞→
;                24

235

0 2
3lim

xx
xxx

x +
++

→
;                

3
332lim

3 −
−+

→ x
x

x
. 

9. 
x

x x
⎟
⎠
⎞

⎜
⎝
⎛ −

∞→

11lim ;                    
92

33lim 23

25

++
++

∞→ xx
xxx

x
;                

52
43lim

2

2 +
+−

→ x
xx

x
. 

10. 
x
x

x 5
131lim

0

−+
→

;                
423
254lim 3

3

++
++

∞→ xx
xx

x
;                  

t

t t
⎟
⎠
⎞

⎜
⎝
⎛ +

∞→ 3
11lim . 

Задание 6 
Составить уравнение касательной и нормали к кривым в указанных точках: 
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1.    1,3452 0
23 =+−+= xxxxy  

2.    
3

,sin 0
π

== xxy  

3.    2,
2

34
0

2

=
+

−+
= x

x
xxy  

4.    22 xxy −=  в точках пересечения с осью Оx 

5.    2xy =  в точке M  ⎟
⎠
⎞

⎜
⎝
⎛ 1 ;

2
1  

6.    xy ln=  в точке пересечения с осью Оx 
7.    xеy 2=  в точке пересечения с осью Оy 
8.    2,3245 0

23 =+−−= xxxxy  

9.    3,
12

5
0

2

=
+
+

= x
x

xxy  

10. 
4

,cos 0
π

== xxy  

Задание 7 
Найти производную данной функции в точке 0x : 

1. 1,
1

)( 03

2

=
+

= x
x

xxf  

2. 8,64)( 0
3 =⋅+= xxxxf  

3. 
2

,sin3)( 0
2 ππ =−+= xxxxxf  

4. π=⋅+= 0
2 ,cos2)( xxxxtgxf  

5. 
4

,23)( 0
2 π

=⋅+⋅= xxctgxxxf  

6. 3,)( 02

2

== x
x
exf

x

 

7. 8,arccos3)( 0
3 =+= − xxxf x  

8. 1,61)( 0 =+= xxarctg
x

xf  

9. ( ) 4,2)( 0
5 =−+= xxxxxf  

10. 2),5ln()( 0
3 =−= xxxxf . 

Задание 8 
Исследовать кривую  средствами дифференциального исчисления. Постро-

ить график по характерным точкам: 
1. 23 6xxy −=  
2. 23 36 xxy +−=  
3. 23 84 xxy −=  
4. 23 24 xxy +=  
5. 23 48 xxy −=  

6. 23 2xxy −=  
7. 43 23 +−= xxy  
8. 24 8xxy −=  
9. 168 24 −+−= xxy  
10. xxy 33 −=  

Задание  9 
Решить задачу: 
1. Найти вероятность того, что подброшенная игральная кость упадет, по-

казав на верхней грани четное или кратное трем число очков. 
2. Сколько различных «слов» можно получить, переставляя буквы в слове 

«СОЛНЦЕ»?  
3. В вазе стоят 10 красных и 7 розовых гвоздик. Сколькими способами 

можно выбрать из нее 4 красных и 3 розовых  гвоздики? 
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4. Студент знает 30 из 56 вопросов программы. Какова вероятность сдать 
зачет, если нужно ответить на 3 вопроса? 

5. Два стрелка стреляют по мишени. Вероятность попадания для обоих 0,7. 
Какова вероятность, что оба попадут в цель? 

6. В урне 15 белых и 6 черных шара. Какова вероятность двукратного из-
влечения белого шара, если а) шар возвращается в урну; б) шар не возвращает-
ся в урну. 

7. В урне 12 красных и 5 черных шаров. Какова вероятность того, что при 
втором испытании вынимаем красный шар, а при первом – черный. 

8. Из колоды в 52 карты вынимается одна карта. Какова вероятность того, 
что будет вынута карта черви или король? 

9. На 4 карточках разрезной азбуки изображены буквы Р, К, Е, А. Ребенок 
случайным образом выкладывает их в ряд. Какова вероятность того, что у него 
получится слово «РАК»?  

10.  Группа туристов из 12 юношей и 7 девушек выбирает по жребию 5 че-
ловек для приготовления ужина. Сколько существует способов, при которых в 
эту «пятерку» попадут 5 юношей? 

Задание 10 
Решите задачу: 
1. Экзамен по математике сдавали 250 абитуриентов, оценку ниже «5» по-

лучили 180 человек, а выдержали этот экзамен 210 абитуриентов. Сколько че-
ловек получили оценки «3» и «4»?  

2. В школе 1400 учеников. Из них 1250 умеют кататься на лыжах, 952 – на 
коньках. Ни на лыжах, ни на коньках не умеют кататься 60 учащихся. Сколько 
учащихся умеют кататься и на лыжах и на коньках? 

3. В группе из 100 туристов 70 человек знают английский язык, 45 фран-
цузский язык и 23 человека знают оба языка. Сколько туристов в группе не 
знают ни английского, ни французского языка? 

4. В штучном отделе магазина посетители обычно покупают либо 1 торт, 
либо 1 коробку конфет, либо 1 торт и 1 коробку конфет. В один из дней было 
продано 57 тортов и 36 коробок конфет. Сколько было покупателей, если 12 
человек купили и торт, и коробку конфет?  

5. Каждый из учеников класса в зимние каникулы ровно 2 раза был в теат-
ре, при этом спектакли А, В и С видели соответственно 25, 12 и 23 ученика. 
Сколько учеников в классе?  

6. В отряде из 40 ребят 30 умеют плавать, 27 умеют играть в шахматы и 
только 5 не умеют ни того, ни другого. Сколько ребят умеют плавать и играть в 
шахматы? 

7. В спортивном лагере 65% ребят умеют играть в футбол, 70? – в волей-
бол и 75% - в баскетбол. Каково наименьшее число ребят, умеющих играть и в 
футбол, и в волейбол, и в баскетбол? 

8. В течение недели в кинотеатре демонстрировались фильмы А, В и С. Из 
40 школьников, каждый из которых просмотрел либо все 3 фильма, либо 1 из 3, 
фильм А видели 13, фильм В- 16, фильм С- 19 школьников. Найти, сколько 
учеников просмотрели все 3 фильма? 
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9. Среди абитуриентов, выдержавших приемные экзамены в ВУЗ, оценку 
«5» получили: по математике – 48 абитуриентов, по физике – 37, по русскому 
языку – 42, по математике или физике – 75, по математике или русскому языку 
– 76, по физике или русскому языку – 66, по всем трем предметам – 4. Сколько 
среди них получили только одну «5»? 

10. На уроке литературы учитель решил узнать, кто из из 40 учеников клас-
са читал книги А, В и С. Результаты опроса оказались таковы: книгу А читало 
25 учащихся, книгу В – 22, книгу С – 22. Книги А или В читали 33 ученика, А 
или С – 32, В или С – 31., все три книги прочитали 10 учащихся. Сколько уче-
ников прочли только по одной книге?         

Задание 11 

Дан ряд распределения дискретной случайной величины. Найти математи-
ческое ожидание, дисперсию и среднеквадратическое отклонение: 
Вариант 1  

Х 
13 16 17 22 

Р 0,2 0,3 0,2 0,3 
 Вариант  2  

Х 
0,3 0,6 1,7 2 

Р 0,1 0,5 0,2 0,2 
Вариант  3  

Х 
23 25 29 32 

Р 0,1 0,5 0,2 0,2 
Вариант  4 

Х 
5,5 5,8 6,1 6,4 

Р 0,2 0,3 0,1 0,4 
Вариант  5  

Х 
6,6 6,8 7,0 7,6 

Р 0,2 0,3 0,1 0,4 
Вариант  6  

Х 
16 18 21 22 

Р 0,2 0,3 0,2 0,3 
Вариант  7 

Х 13 16 17 25 

Р 0,4 0,3 0,2 0,1 
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Вариант  8 

Х 
1,3 1,6 1,8 2,2 

Р 0,2 0,3 0,4 0,1 
Вариант  9  

Х 
16 19 20 25 

Р 0,2 0,3 0,2 0,3 
Вариант  10 

Х 
13 16 17 22 

Р 0,4 0,1 0,1 0,4 
Задание 12 

В результате проведенной серии испытаний (наблюдений), установлена 
частота попарных совпадений значений признака X и Y. Данные приведены в 
таблице.  По данным корреляционной таблицы установить наличие и силу кор-
реляционной связи.  Найти уравнение регрессии X на Y  и Y на X. Построить их 
графики в одной системе координат. Вычислить значение признака  при задан-
ном значении X0. Охарактеризовать полученные результаты: 
Вариант 1 980 =Х  
Y\X 20 30 40 50 60 70 80 90 100 yn  

12 4         4 
18 6 10 2       18 
24  8 13 1 1     23 
30  4 7 9 3 4 2   29 
36  1 2 3 12 4 8   30 
42    1 3 18 24 1  47 
48       7 12 3 22 
54        9 18 27 

xn  10 23 24 14 19 26 41 22 21 200 

Вариант 2 280 =Х  
Y\X 25-35 35-45 45-55 55-65 65-75 yn  

50-80 5 4    9 
80-110  12 8 1  21 
110-140   5 5  10 
140-170   4 7  11 
170-200    2 1 3 
200-230     1 1 

xn  5 16 17 15 2 55 
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Вариант 3 420 =Х  
Y\X 40-50 50-60 60-70 70-80 80-90 90-100 yn  

0-6     4 6 10 
6-12   6 6 8  20 
12-18 1 2 14 3   20 
18-24 6 18 2    26 
24-30 4 10 2    16 
30-36 6 2     8 

xn  17 32 24 9 12 6 100 

 Вариант 4 210 =Х  

Y\X 10 15 20 25 30 35 40 45 yn  

15 2 4       6 
20 1 6 5 8  3   23 
25  3 13 4 2 1   23 
30   4 11 5 7   27 
35    2 1 4 3 1 11 
40    1 2 5 1 1 10 

xn  3 13 22 26 10 20 4 2 100 

Вариант 5 950 =Х  
Y\X 80 90 100 110 120 yn  

100 2 3 5   10 
110 2 6 20 7  35 
120 1 3 10 9 5 28 
130 1 2 5 4 7 19 
140   2 3 3 8 

xn  6 14 42 23 15 100 

Вариант 6 800 =Х  

Y\X 15-30 30-45 45-60 60-75 75-90 yn  

16-24   1 4 1 6 
24-32   7 7 2 16 
32-40  4 12 2  18 
40-48  8 6   14 
48-56 2 4    6 

xn  2 16 26 13 3 60 

 



 131

Вариант 7 550 =Х  
Y\X 30 40 50 60 70 yn  

12 8 8    20 
18 7 16 7   30 
24  15 10 1  26 
30  4 9 5 3 21 
36    2 1 3 

xn  15 43 26 8 8 100 

Вариант 8 310 =Х  
Y\X 8 13 18 23 30 35 40 45 yn  

15 2 4       6 
20 1 6 5 8     23 
25  3 13 4 2 4   23 
30   4 10 6 7   27 
35    2 1 4 3 1 11 
40    1 2 5 1 1 10 

xn  3 13 22 26 10 20 4 2 100 

Вариант 9 150 =Х  
Y\X 8 13 18 23 28 yn  

1,25    2 6 8 
1,5   4 7 4 15 
1,75 1 1 7 5  14 

2 2 4 1   7 
2,25 3 3    6 

xn  6 8 12 14 10 50 

    Вариант 10 37830 =Х  
Y\X 1500 2500 3500 4500 5500 yn  

2    1 6 7 
2,5   4 6 3 13 
3  3 6 4  13 

3,5 2 6 3 1  12 
4 3 2    5 

xn  5 11 13 12 9 50 
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X. КОМПЛЕКТ ЗАДАНИЙ ДЛЯ КОНТРОЛЬНЫХ РАБОТ 
1 семестр – раздел «Математика» 

Тема. Множества. 
1. Дано множество А={1;2;3;4;5;6;7;8;9}. Задайте подмножества В-числа 

кратные трём; Д-числа меньше пяти. 
2. Даны множества А={5;6;7;8;9;10}, К={6;7;8}, Р={9;10;11}. Найти: а) 

АUКU Р; б) КI Р;  в) ( КU Р)IА; г) А\Р 
3. Какие из высказываний истинны, а какие ложны? 

   а) Если множество А={(х;у): 2х-у-1=0}, то: 1) (1;1)∈А; 2) (2;-1)∉А. 
   б) Если множество А={(х;у): х²-1≤ у ≤ 1-х²}, то: 1) (2;1)∉А; 2) (0;0)∈А. 

4. Из 220 школьников 163 играют в футбол, 175 играют в баскетбол, 24 не 
играют в эти игры. Сколько человек одновременно играют в баскетбол и фут-
бол?  

5. Используя рисунок найдите: 
а) Объединение множеств М и Е                                                                     
б) Пересечение множеств М и Е 
в) Разность множеств М и Е 
г) Пересечение множеств С и Е                            

6.Определите, чем являются данные высказывания (определением, аксио-
мой, теоремой): 

 а) Высоты треугольника пересекаются в одной точке. 
 б) Вектор это направленный отрезок. 
 в) На любом луче от его начала можно отложить отрезок, равный данному, и 

притом только один. 
Тема. Линейная алгебра. 

1. Даны матрицы ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

=
15
12

А , 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
−=

103
213
571

В . Вычислить: 1) детерминанты 

матриц А, В; 2) rang B. 

2. Даны матрицы 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−

−
=

813
542
320

А , 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−=

2439
6851
1032

В , 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
=

70
48
03

С , 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−−

=
2412

0439
Д . Найти: 1) АВ + СД; 2) 2А – Е; 3) А 1− .  

3. Решить систему уравнений 
⎪
⎩

⎪
⎨

⎧

=++
−=−−

=−+

123
4232

12

zyx
zyx

zyx
: 1) методом Гаусса; 2) по фор-

мулам Крамера; 3) с помощью обратной матрицы. 
Тема. Аналитическая геометрия на плоскости. 
1. Дано число в декартовой системе координат (4;-4). Преобразовать его в 

полярную систему координат. 



 133

2. Дано число в полярной системе координат (5; )
4

7π
− . Преобразовать его в 

декартову систему. 
3. Даны координаты вершин треугольника АВС: А(1;0), В(3;2), С(3;1). 

Найти уравнение и длину медианы. 
4. Найти геометрическое место точек равноудаленных от точек А(1;1) и 

В(8;4). 
5. Привести к каноническому виду уравнения кривых. Построить чертежи. 

          а) 4x 2  - y 2  + 8x – 2y + 3 = 0; 
    б) y = 162 −х . 

Тема. Математический анализ. 
1. Найти область определения функций:   
а) ( )

x
xxf 14 2 +−= ; б) ( )

x
xxf

2cos
2−

= . 

2. Установить четность или нечетность функций: 
а) ( ) xxxf 7sin4= ; б) ( ) 2+= xxf . 
3. Найти пределы: 

а) 
9

65lim 2

2

3 −
+−

→ x
xx

x
; б) 

х
xx

x 4
cossinlim

4
−
−

→ ππ
; в) х

х

x е−
−

∞→ 1
51lim ; 

г) 
1
1lim 23

23

1 −−+
+−−

→ ххх
ххх

x
; д) 

х
х

x

24lim
0

−+
→

; е) 30

sinlim
x

xх
x

−
→

. 

 4. Найти производные функций: 

 а) 3

7
х

y = ; б) xxy cos210 3 += ; в) ctgxey x= ; г) 65х
хy = . 

5. Построить график функции ( )xfy = , используя общую схему исследова-

ния функций: 
1

2

−
=
х
хy . 

Тема. Элементы теории вероятностей. 
1. В урне 10 белых, 15 чёрных, 20 синих и 25 красных шаров. Вынули 

один шар. Найти вероятность того, что вынутый шар: а) синий; б) белый или    
чёрный. 

2. Три стрелка независимо друг от друга стреляют по цели. Вероятность    
попадания в цель для первого стрелка равна 0,75, для второго-0,8, для    третье-
го-0,9. Определить вероятность того, что все три стрелка    одновременно попа-
дут в цель. 

3. Сколько существует семизначных чисел, состоящих из цифр 4,5,6, в    
которых цифра 4 повторяется 3 раза, цифра 5 повторяется 2 раза, цифра 6    по-
вторяется 2 раза? 

4. Из пяти букв разрезной азбуки составлено слово «КНИГА». Ребёнок, не    
умеющий читать, рассыпал эти буквы и затем собрал в произвольном порядке. 
Какова вероятность того, что у него снова получилось слово «КНИГА»? 

5. Сколько можно составить сигналов из 6 флажков различного цвета, взя-
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тых по 2? 
6. По каналу связи передаются 7 сообщений, каждое из которых, незави-

симо от других, может быть искажено с вероятностью 0,15. Найти вероятность    
того, что будет правильно принято не менее двух сообщений. 

7. 52 игральные карты раздаются 4 игрокам. Найти вероятность того, что: 
а) все тузы будут у одного игрока; б) каждый игрок получил один туз. 

8. Студент знает 30 из 40 вопросов программы. Экзаменатор задаёт ему    
вопросы до тех пор, пока не обнаруживает пробел в знаниях студента. Найти 
вероятность того, что будут заданы менее пяти вопросов. 

9. В ящике находятся 20 лампочек, среди которых 3 перегоревшие. Найти    
вероятность того, что 10 лампочек, взятых наудачу из ящика, будут гореть. 

10. Какова вероятность того, что среди 730 пассажиров поезда: а) двое      
родилось 1 марта; б) четверо родилось 23 февраля (Считать, что в году 365      
дней). 

Тема. Основы математической статистики. 
1. Найти математическое ожидание числа лотерейных билетов, на которые 

выпадут выигрыши, если приобретено 20 билетов, причём вероятность выиг-
рыша по одному билету равна 0,3. 

2. Определить математическое ожидание и дисперсию, если известен за-
кон    распределения случайной величины 

    х        0       1        2       3       4 
    р      0,2    0,4     0,3    0,08    0,02 

Чему равно среднее квадратичное отклонение этой случайной величины? 
3. Найти М(Х+У), М(ХУ), если даны законы распределения случайной ве-

личины: 
х 1  2 3 
р 0,3 0,5 0,2  

у -2 -1 
р 0,4 0,6  

4.Задано распределение частот выборки объёма n=20э 
          х              2             6           12 
          n              3            10            7 

Написать распределение относительных частот. 
5.Построить полигон частот и относительных частот распределения 

     х        1         3          5        7       9 
     n       10       15         30       33      12 
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2 семестр – раздел «Информатика» 
Тема: Единицы измерения информации. 

1. В документе 60 строк по 60 символов. Каков размер данного текстового 
файла? 

2. Какое количество страниц неформатированного текста можно поместить на 
дискету емкостью 1,44 Мбайт? 

3. Сколько «весит» фраза «Мороз и солнце – день чудесный», если сохранить 
ее в текстовом файле? 

4. Сколько составляет размер текстового файла, содержащего только слово 
«информатика»? 

5. Разрешающая способность дисплея равна 640×200 пикселей. Для размеще-
ния одного символа в текстовом режиме используется матрица 8×8 пиксе-
лей. Какое максимальное количество текстовых строк может быть размеще-
но на экране? 

6. Решите систему уравнений (найти x, y). В ответе необходимо указать еди-
ницы измерения. 

⎩
⎨
⎧

=

=−

байт24
Кбайт725

14x
xy

. 

7. Одна страница книги содержит 25 строк по 80 символов. В книге 300 стра-
ниц. Каков объем информации необходим для хранения книги? 

8. Один музыкальный файл занимает 6 Кб на диске. Сколько файлов можно за-
писать на CD-диск объемом 600 Мб.  
Тема: Системы счисления. 

1) Перевести двоичное число вовсе известные вам системы счисления: 
а) 1001011101 
б) 10110001111 
в) 1111011010 
г) 1111100001 
д) 100011100011 

е) 10001101001 
ж) 111100000111111 
з)10101100110101 
и) 1111000111110101 
к) 10101101011010101 

2) Перевести восьмеричное число вовсе известные вам системы счисления: 
а) 526 
б) 457 
в) 562 
г) 125 
д) 443 

е) 361 
ж) 777 
з) 1267 
и) 6375 
к) 774527 

3) Перевести десятичное число вовсе известные вам системы счисления: 
а) 58 
б) 96 
в) 129 
г) 345 
д) 789 

е) 953 
ж) 1283 
з)  1892 
и) 5638 
к) 105896 

4) Перевести шестнадцатеричное число вовсе известные вам системы счисле-
ния: 
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а) 1А 
б) 26 
в) 3AF 
г) C45 
д) D56 

е) AFD 
ж) 4A5F 
з)  9E6CA 
и) ABC5F 
к) 48FF56A 

Тема: Компьютерная графика. 
Создать иллюстрированный материал по одной из тем: 

− рекламный проспект; 
− билет в театр (цирк, кинотеатр, музей); 
− визитная карточка некоторой организации. 

Тема: Операционная оболочка Total Commander. 
1. В корневом каталоге диска С: создать каталог ORBITA. 
2. В каталоге ORBITA создать каталог KOSMOS. 
3. В каталоге ORBITA создать текстовый файл paloma.txt. 
4. Скопировать в каталоге ORBITA файл paloma.txt в файл stih.txt. 
5. Файлы каталога ORBITA скопировать в каталог KOSMOS. 
6. На диске А: создать каталог NEBO. 
7. Скопировать каталог KOSMOS в каталог NEBO. 
8. Переименовать в каталоге NEBO каталог  KOSMOS на LUNA. 
9. Осуществить на диске С: поиск файлов, начинающихся на букву «t», имеющих 

в расширении два символа. 
Тема: Операционная система Windows. 

1.  На диске С: создайте текстовый файл Сервис, содержащий следующий текст: 
«Сжатие информации — это процесс преобразования информации, хранящейся 
в файле, к виду, при котором уменьшается избыточность в ее представлении и 
соответственно требуется меньший объем памяти для хранения». 

2.  На диске С: создайте папку ТУРИСТЫ. 
3.  В этой папке создайте текстовой файл Отдых, содержащий следующий текст: 

«Архивный файл — это специальным образом организованный файл, содержа-
щий в себе один или несколько файлов в сжатом или несжатом виде и служеб-
ную информацию об именах файлов, дате и времени их создания или модифи-
кации, размерах и т.п.» 

4. В папке ТУРИСТЫ создать папку ОТЕЛЬ. 
5. В папке ОТЕЛЬ создайте текстовый документ Люкс, содержащий следующий 
текст: «Архивация (упаковка) — помещение (загрузка) исходных файлов в ар-
хивный файл в сжатом или несжатом виде». 

6. Для папки ТУРИСТЫ создать ярлык на Рабочем столе. 
7. Открыть документ Сервис и добавить в него следующий текст: «Разархивация 

(распаковка) — процесс восстановления файлов из архива точно в таком виде, 
какой они имели до загрузки в архив. При распаковке файлы извлекаются из ар-
хива и помещаются на диск или в  оперативную память». 

8. Скопируйте документ Сервис в папку ОТЕЛЬ и переименовать его в файл Рек-
лама. 
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Тема: Табличный процессорWord. 

− Все задания делать на отдельной странице.  
− Каждая страница должна начинаться с заголовка «Задание № …», оформленно-

го стилем Заголовок2. 
− Проставить номера страниц: вверху страницы, справа, номер на первой страни-

це не ставить. Расставить колонтитулы: на первой странице – Контрольная ра-
бота, на четной странице – ваша фамилия, на нечетной странице – «Документ 
Word».  

− В конце документа вставить оглавление. 
1. Напечатать приведенный ниже текст, выполняя задания: 

ЛЕКСИЧЕСКИЕ СРЕДСТВА ВЫРАЗИТЕЛЬНОСТИ РЕЧИ 
Лексика, несомненно, занимает центральное место в системе образных 

средств языка. 
Слово, как известно, является основной единицей языка, самым заметным 

элементом его художественных средств. Выразительность речи связана прежде 
всего со словом. Многие слова обладают способностью употребляться в несколь-
ких значениях. Это их свойство называется многозначностью, или полисемией. 

Писатели находят в многозначности источник яркой эмоциональности, жи-
вости речи. Например, в тексте может быть повторено многозначное слово, кото-
рое, однако, выступает в разных значениях: Поэт издалека заводит речь, поэта да-
леко заводит речь (М. Цветаева). 

Задание: 
 Заголовок выровнен по центру, шрифт – Monotype Corsiva, размер – 14, на-
чертание – Полужирный. Все буквы прописные. 

 Основной текст выровнен по ширине, шрифт – Arial, размер – 12. 
 Разбить второй абзац на шесть колонок, а третий – на восемь. 

2. Создать приведенный ниже многоуровневый список, соблюдая все элементы 
форматирования: 
Программирование на Visual Basic. 

Урок 1. Основные элементы языка 
I.1.   Первая программа 
I.2.   Типы данных 
  ♥ Константы 
  ♥ Переменные величины 
I.3.   Операции и выражения 
  ♥ Оператор присваивания 
  ♥ Арифметические операции и выражения 

Урок 2. Управляющие операторы 
II.1.  Логические операторы 
II.2.  Операторы цикла 

 ♥ Оператор For…Next 
 ♥ Оператор While 
 ♥ Оператор Do 

Урок 3. Массивы и пользовательские типы данных. 
3. Создать следующую таблицу, выполнить задания: 
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Примерный план предмета «Логика» 
Количество учебных часов Код 

темы Наименование тем 
Всего Практических 

занятий 
1 2 3 4 
1 Предмет и назначение логики. Логика и язык 2 
2 Основные логические законы 2 нет 

3 Понятие. Логические операции с понятиями 6 2 
4 Суждение. Модальность суждений 4 нет 
5 Дедуктивные умозаключения 6 2 
7 Аналогия и гипотеза 2  
8 Логические основы аргументации 6 2 

Задание: 
 Для заголовка таблицы создать стиль ЛОГИКА с параметрами: Имя – 
ЛОГИКА, Стиль – Абзаца, Основан на стиле – Обычный, Стиль следую-
щего абзаца – Обычный; Формат: Шрифт – Arial, курсив, размер – 14, 
цвет – зеленый, подчеркивание – пунктирное. Абзац: выравнивание по 
центру, выступ – 3 см, межстрочный интервал – одинарный, перед – 12, 
после – 12. 

 Текст таблицы – шрифт №16. 
 Заливка первой строки – серый 30%, второй – голубой. Цвет заливки яче-
ек с порядковыми номерами – желтый. 

4. Создать приведенные ниже формулы: 

( )
⎪⎩

⎪
⎨
⎧

<∞+

>
=−−== −

+∞→

∞+
−∫

0    ,

0    ,1
1lim1

0 α

α
α

α если

если
edxeI b

b

ax
; ( ) abxf

n

i
ii −=∆∑

=1
ξ . 

5. Создать следующую надпись, используя объекты рисования и WordArt: 

 
Тема: Электронная таблица Excel. 
1. Переименовать Лист1 на Магазин. 
2. Создать ниже приведенную таблицу: 

Прейскурант цен на книги в книжном магазине 
№ Автор Название книги Цена за одну книгу Количество Общая сумма 
1      
2      
3      
…      
10      

Сумма     
Среднее    
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− Первый столбец заполнить с помощью автозаполнения. 
− Столбцы Автор, Наименование книги и Цена за одну книгу заполнить само-

стоятельно. 
− Посчитать общую стоимость покупки. 
− Найти сумму и среднее значение по каждому столбцу. 
− Применить к таблице следующее форматирование: цвет заголовков столбцов 

– красный; цвет заливки – серый; внешняя рамка – сплошная; внутренняя 
рамка – пунктирная. 

− Отсортировать таблицу по столбцу Автор. 
− Построить диаграмму, отражающую название книги и общую сумму за каж-

дую книгу. Дать заглавие диаграмме (цвет шрифта названия диаграммы – 
синий). На диаграмме указать подписи данных. 

3. Переименовать Лист2 на Прейскурант. 
4. Создать ниже приведенную таблицу: 

Цена книги в долларах 
Курс доллара …  

   
Наименование книги Цена в долларах Количество 

Преступление и наказание $39,00 2 
Что делать? $35,00 3 
Отцы и дети $60,00 2 
Анна Каренина $42,00 3 
Руслан и Людмила $65,00 1 
Средняя цена   
Максимальная цена   
Минимальная цена   

− Ввести курс доллара. 
− Между столбцами Цена в долларах и Количество вставить столбец Цена в 
рублях. Вычислить цену в рублях, используя введенный курс доллара. 

− Найти среднюю, максимальную и минимальную цену в рублях и долларах 
среди всех санаториев. 

− После столбца Количество добавить столбец Сравнение. 
− Заполнить столбец Сравнение следующим образом: если цена путевки в са-

наторий в рублях больше средней цены, то вывести фразу «не покупать», 
иначе – вывести фразу «покупать». 

− Применить к таблице автоформатирование – Цветной 2. 
− Построить диаграмму, отражающую наименование санатория и цену  путев-

ки в него в рублях. Дать заглавие диаграмме (цвет шрифта названия диа-
граммы – зеленый). На диаграмме указать подписи данных. 
Тема: Электронные презентации PowerPoint. 

1. Запустить программу MS PowerPoint. 
2. На первом слайде ввести произвольный заголовок. 
3. Вставить несколько слайдов разных типов и произвольно заполнить их тек-
стовой информацией и изображениями. 
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4. Применить на выбор оформление слайдов. 
5. В одном из слайдов сменить фон на другой цвет и сменить способ заливки на 
градиентный (произвольно); в другом слайде в качестве способа заливки вы-
брать текстуру по выбору. 

6. Продублировать один из слайдов и изменить его содержание. 
7. Добавить слайд и вставить в него диаграмму. 
8. Добавить эффекты анимации в слайды. Для каждого слайда назначить смену 
слайда. 

9. Сделать настройку времени для презентации. 
Тема: СУБД Access. 
Выберете самостоятельно тему, соответствующую вашей специальности и 

создайте БД, выполнив следующие условия:  
1. Создайте таблицу. 
2. Внесите записи. 
3. Отсортируйте их. 
4. Создайте форму. 
5. Внесите еще 2 записи в форму. 
6. Организуйте поиск, задав критерий для поиска. 
7. Представить форму в режиме таблицы. 
8. Примените фильтр, задав условие отбора данных. 
9. Подготовьте отчет. 
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XI. ТЕСТЫ ДЛЯ ОЦЕНКИ КАЧЕСТВА ЗНАНИЙ 
Раздел «Математика» 

Тема: Линейная алгебра. Введение в анализ. Аналитическая геометрия. 

1. Дана матрица 
⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛

−
−
−

=
262
044
137

А . Тогда сумма элементов, расположенных на 

главной диагонали этой матрицы равно: 
a) -7 
b) 13 

c) 5 
d) -5 

2. Если ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

−
=

54
21

А , то матрица С=2А+В имеет вид: 

a) ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−
−

88
31  

b) ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

−
34

31  

c) ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

−
88

31  

d) ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
− 88
10  

3. Если ( 00 ; yx ) решение системы линейных уравнений 
⎩
⎨
⎧

=+
−=+
523
32

yx
yx . Тогда 00 yx +  

равно: 
a) 3,5 
b) 0,5 

c) -0,5 
d) -3,5 

4. Даны точки А(2;3) и В(-6;5). Тогда координаты середины отрезка АВ равны: 
a) (-2;8) 
b) (-4;8) 

c) (-2;4) 
d) (-4;1) 

5. Расстояние между точками В(-3;-4) и D(6;8) равно: 
a) 13 
b) 14 

c) 15 
d) 16 

6. Радиус окружности, заданной уравнением 0222 =−+ уух , равен: 
a) 4 
b) -1 

c) 3 
d) 1 

7. Длина вектора kjiа
rrrr 22 −+=  равна: 

a) 5  
b) 3 
c) 2 

d) 7  

8. Если )2;0;1(=аr и )1;3;2( −=b
r

, тогда скалярное произведение ba
rr
⋅  равно: 

a) 0 
b) 5 

c) 7 
d) 3 

9. Если формула n-го члена числовой последовательности имеет вид 

2
1

2 +
+

=
n
nxn , то 5x  равно: 

a) 
5
1  b) 

9
2  
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1→x

c) 
19
3  d) 

18
5  

10. Значение предела 
1
1lim

2

1 −
−

→ x
x

x
равно: 

a) 2 
b) 0 

c) ∞  
d) 1 

11. Множество первообразных функции 32)( += xexf  имеет вид: 
a) Се х ++32  
b) Се х ++322  
c) Се х ++32

2
1  

d) Се х +− +32

2
1  

12. Площадь фигуры, изображенной на рисунке  определяет-
ся интегралом: 

a) ∫ +
1

0

2 )1( dxх  

b) ∫ −
1

0

2 )2( dxх  

c) ∫ −
2

0

2 )1( dxx  

d) ∫ −
1

0

2 )1( dxx  

13. Производная функции )1sin( 2 += xy  имеет вид: 
a) )1cos( 2 +x  
b) )1cos( 2 +xx  

c) )1cos(2 2 +xx  
d) )1cos(2 2 +− xx  

14. Порядок дифференциального уравнения 53 хуу =′−′′  равен: 
a) 3 
b) 1 

c) 5 
d) 2

15. Дано дифференциальное уравнение 065 =+′+′′ ууу . Тогда соответствующее 
ему характеристическое уравнение имеет вид: 
a) 0652 =++ kk  
b) 0651 2 =++ kk  

c) 0652 =−− kk  
d) 0652 =+− kk  

16. Дано дифференциальное уравнение 5=+′ уу . Тогда его решением является 
функция: 
a) 5−= −хеу  
b) 5−= хеу  

c) 5+= −хеу  
d) 5+= хеу  

Тема: Теория вероятностей и математическая статистика. 
1. Установите правильное соответствие между математическим утверждением 
и его формулировкой. 

1. Площадь прямоугольника  равна произведению его 
смежных сторон. 

2. Две прямые на плоскости  называются  параллельны-
ми, если они  не пересекаются. 

3. На любом  луче от его начала можно отложить отре-
зок, равный данному, и притом  только один. 

а) аксиома 
b) теорема 
с) определение 
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2. Заданы множества А={4,5,6,7,8} и В= {5,6}, тогда для них верным утвер-
ждением будет: 
a) множества А и В равны; 
b) множество А включает  множество В; 
c) множество А есть подмножества В; 
d) множества А и В не имеют одинаковых элементов; 

3. Пусть А и В – множества. Тогда  пересечением  этих множеств является: 
a) А\ В 
b) Ш 
c) В 
d) А 

4. Отношение задано неравенством: 2х-у >0, тогда данному отношению при-
надлежит следующая пара чисел: 
a) (0;0) 
b) (2;2) 

c) (1;3) 
d) (-1;1) 

5. Количество перестановок букв в слове «HOME» равно: 
a) 8 
b) 20 

c) 16 
d) 24 

6. Сколько различных двузначных чисел можно составить из пяти цифр 7, 8, 1, 
3, 5, если все цифры в числе разные? 
a) 4 
b) 6 

c) 12 
d) 24 

7. Игральный кубик бросают один раз. Тогда вероятность того, что на верхней 
грани выпадет число очков менее трёх, равна: 
a) 0 
b) ½ 

c) ⅓ 
d) 1 

8. Студент разыскивает нужную ему формулу в 3-х справочниках. Вероятности 
того, что формула содержится в первом, втором, третьем справочнике, соот-
ветственно 0,6; 0,7; 0,8.Какова вероятность того, что формула содержится во 
всех справочниках? 
a) 2,1 
b) 0,336 

c) 0,842 
d) 1,4 

9. Дискретная случайная величина Х имеет закон распределения вероятностей. 
Тогда математическое ожидание М(Х) этой случайной ве-
личины равно: 
a) 2,1 
b) 1 

c) 2 
d) 2,7 

10. График плотности распределения вероятностей для нормального закона изо-
бражён на рисунке: 
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11. В урне находится 6 шаров: 3 белых и 3 чёрных. Событие А заключается в 
том, что вынули белый шар. Событие В – вынули  чёрный шар. Опыт состо-
ит в выборе только одного шара. Тогда для этих событий неверным будет 
утверждение: 
a) события А и В равновероятны 
b) события А и В несовместимы 
c) событие А невозможно 

12. Вероятность наступления некоторого события не может быть равна: 
a) 3 
b) ½ 

c) 0 
d) 1 

13. По статистическому распределению выборки устано-
вите её объём: 
a) 25 
b) 13 

c) 30 
d) 11 

14. Средняя выборочная вариационного ряда 1, 2, 2, 3, 4, равна: 
a) 3 
b) 3,6 

c) 6 
d) 2,4 

15. Из генеральной совокупности извлечена выборка объё-
ма n=60, полигон частот которой представлен на рисун-
ке. Тогда число вариант xi=2 в выборке равно:  
a) 26 
b) 27 

c) 60 
d) 25 

16. Если основная гипотеза имеет вид Но ׃ а=20, то конку-
рирующей может быть гипотеза: 
a) Н ׃ а ≤ 19 
b) Н ׃ а ≥ 10 
c) Н ׃ а > 20 
d) Н ׃ а = 21 
Тема: Информатика как часть общечеловеческой культуры. Информа-

ция. 
1. Данные – это: 

a) признаки или записанные наблюдения, которые по каким-то причинам не 
используются, а только хранятся; 

b) это выявленные закономерности в определенной предметной области; 
c) совокупность сведений, необходимых для организации хозяйственной 
деятельности предприятия; 

2. По месту возникновения информация бывает: 
a) входная, выходная, внутренняя, внешняя; 
b) текстовая, графическая; 
c) учетная, статистическая; 

3. По признаку стабильности информация бывает: 
a) количественная, суммовая; 
b) обрабатываемая, необрабатываемая; 
c) постоянная и переменная; 
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4. По функциям управления информация бывает: 
a) плановая, учетная, оперативная; 
b) промежуточная, результатная; 
c) первичная, вторичная; 

5. В 4 килобайтах: 
a) 4000 бит; 
b) 4096 байт; 
c) 4096 бит; 

6. Минимальная единица измерения информации: 
a) байт; 
b) символ; 
c) бит; 

7. Информация в ЭВМ кодируется: 
a) в двоичной системе счисления; 
b) в десятичной системе счисления; 
c) в символах; 

8. Один бит содержит: 
a) 0 или 1; 
b) одну цифру; 
c) один символ; 

9. Один байт содержит: 
a) 2 бита; 
b) 8 бит; 
c) 16 бит; 

10. В 1 килобайте 
a) 1012 байт; 
b) 1024 байт; 
c) 1000 бит. 
Тема: Системы счисления. 

1. Система счисления - это:  
a) способ наименования и записи чисел; 
b) представление букв с помощью цифр; 
c) способ представления одних чисел с помощью других; 

2. В двоичной системе используются цифры:  
a) 1 и 2; 
b) 0 и 1; 
c) 0 и 2; 

3. Бит – это:  
a) цифры 0 и 1; 
b) наименьшая единица памяти ЭВМ; 
c) 8 нулей и единиц; 

4. Позиционная система счисления – это:  
a) римская; 
b) десятичная; 
c) все ответы верны;  
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5. В двоичной системе основанием является:  
a) 0  
b) 2  
c) 8  

6. Двоичному числу 1000 соответствует десятичное число:  
a) 2;  
b) 8; 
c) 10;  

7. Системы счисления делятся на: 
a) позиционные и непозиционные; 
b) римские и десятичные; 
c) двоичные и десятичные; 

8. Результатом сложения двоичных чисел 1010 и 111 будет:  
a) 11010; 
b) 10110; 
c) 10100; 

9. Десятичному числу 122 соответствует двоичное число:  
a) 1111010; 
b) 1001010; 
c) 1010101; 

10. При переводе числа 425,7 из восьмеричной системы счисления в десятич-
ную, получится число: 
a) 277,875; 
b) 256,5; 
c) 377,95. 
Тема: Аппаратное обеспечение ПК. 

1. Структура компьютера — это: 
a) комплекс электронных устройств, осуществляющих обработку информации; 
b) некоторая модель, устанавливающая состав, порядок и принципы взаимо-
действия входящих в нее компонентов; 

c) комплекс программных и аппаратных средств. 
2. Основная функция ЭВМ: 

a) общение человека и машины; 
b) разработка задач; 
c) принцип программного управления. 

3. Микропроцессор предназначен для: 
a) управления работой компьютера и обработки данных; 
b) ввода информации в ЭВМ и вывода ее на принтер; 
c) обработки текстовых данных. 

4. Разрядность микропроцессора — это: 
a) наибольшая единица информации; 
b) количество битов, которое воспринимается микропроцессором как 
единое целое; 

c) наименьшая единица информации. 
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5. Постоянная память предназначена для: 
a) длительного хранения информации; 
b) хранения неизменяемой информации; 
c) кратковременного хранения информации в текущий момент времени. 

6. Принтер предназначен для: 
a) ввода алфавитно-цифровых данных, управления работой ПК; 
b) вывода информации на бумагу; 
c) вывода на экран текстовой и графической информации. 

7. Монитор предназначен для: 
a) ввода алфавитно-цифровых данных, управления работой ПК; 
b) вывода информации на бумагу; 
c) вывода на экран текстовой и графической информации. 

8. Клавиатура предназначена для: 
a) ввода алфавитно-цифровых данных, управления работой ПК; 
b) вывода информации на бумагу; 
c) вывода на экран текстовой и графической информации. 

9. Функции системной шины состоят в: 
a) постоянном хранении самозагружаемой части операционной системы; 
b) передаче информации между микропроцессором и устройствами ПК; 
c) архивном копировании больших объемов данных. 

10. Для печати изготовленного на ПК текста используется  
a) принтер; 
b) винчестер; 
c) сканер. 
Тема: Программное обеспечение ПК. 

1. К операционным системам относятся: 
a) MS-Office, Clipper; 
b) MS-Word, Word Pad, PowerPoint; 
c) MS-DOS, Unix, Windows Nt; 

2. Сетевые операционные системы — это: 
a) комплекс программ для одновременной работы группы пользователей; 
b) комплекс программ, переносимых в сети с одного компьютера на другой; 
c) комплекс программ, обеспечивающих обработку, передачу и хранение 
данных в сети; 

3. К программам-архиваторам относятся программы: 
a) Raj.ехе; 
b) Arj.ехе; 
c) Ajr.ехе; 

4. Системное программное обеспечение (System Software) — это: 
a) комплекс программ для решения задач определенного класса в конкретной 
предметной области; 

b) совокупность программ и программных комплексов для обеспечения работы 
компьютера и сетей ЭВМ; 

c) комплекс программ для тестирования компьютера; 
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5. Отличительной особенностью операционной системы MS-DOS является: 
a) система ориентирована на эффективную поддержку процесса разработки 
программного обеспечения; 

b) система характеризуется развитыми средствами доступа ко всем аппарат-
ным средствам, гибкой файловой системой; 

c) наиболее простая операционная система; 
6. Системное программное обеспечение включает: 

a) базовое и сервисное программное обеспечение; 
b) операционную систему и антивирусные программы; 
c) операционные системы и операционные оболочки; 

7.Чем программное обеспечение отличается от аппаратного? 
a) аппаратное обеспечение – это все устройства, входящие в компьютер, а 
программное – это невидимая неотъемлемая часть, без которой не будет 
функционировать аппаратное обеспечение; 

b) аппаратное обеспечение – это все, что можно потрогать и увидеть (сис-
темный блок, кабель), а программное обеспечение – это все компоненты, 
находящиеся внутри (микросхемы и т.д.); 

c) принципиально не отличаются; 
8. Для чего нужны прикладные программы? 

a) для перевода программ в машинные коды; 
b) для управления процессом обработки информации; 
c) для решения задач пользователей; 

9. Утилита – это: 
a) программа; 
b) микросхема; 
c) устройство ввода информации; 

10.Выберите категорию, к которой относятся следующие программы: Scandisk, 
Winrar,  Drweb, Format: 
a) системные; 
b) сервисные; 
c) прикладные. 
Тема: Компьютерная графика. 

1. Пикселизация изображений при увеличении масштаба – один из недостатков: 
a) растровой графики; 
b) векторной графики; 
c) трехмерной графики; 

2. Большой размер файла – один из недостатков: 
a) растровой графики; 
b) векторной графики; 
c) трехмерной графики;  

3. Физический размер изображения может измеряться в:  
a) точках на дюйм (dpi) 
b) мм, см, дюймах или пикселах;  
c) пикселах; 
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4. Растровый графический редактор предназначен для: 
a) построения диаграмм; 
b) создания чертежей; 
c) создания и редактирования рисунков; 

5. В модели CMYK в качестве компонентов применяются основные цвета ...  
a) красный, зеленый, синий, черный; 
b) голубой, пурпурный, желтый, черный; 
c) красный, голубой, желтый, синий; 

6. В модели RGB в качестве компонентов применяются основные цвета: 
a) красный, зеленый, синий; 
b) голубой, пурпурный, желтый; 
c) красный, голубой, желтый; 

7. Какой из графических редакторов является растровым: 
a) Adobe Illustrator; 
b) Paint; 
c) CorelDraw; 

8. Разрешение изображения измеряется в: 
a) пикселах; 
b) точках на дюйм (dpi); 
c) мм, см, дюймах; 

 9. Paint – это: 
a) векторный графический редактор; 
b) растровый графический редактор; 
c) редактор сочетающий растровую и векторную графику; 

10. Графический редактор – это 
a) прикладная программа, предназначена для создания и обработки графи-
ческих изображений на компьютере; 

b) сервисная программа, предназначена для создания и обработки графиче-
ских изображений на компьютере; 

c) прикладная программа, предназначена для обработки графических изо-
бражений на компьютере. 
Тема: Файловая система. Norton-подобные операционные оболочки. 

1. Файл – это: 
a) часть диска; 
b) поименованная область на диске; 
c) последовательность операторов и команд; 

2. Для своего размещения файл требует: 
a) непрерывного пространства на диске; 
b) свободных кластеров в различных частях диска; 
c) Fat-таблицы; 

3. Для обозначения файлов используют: 
a) имена и расширения; 
b) команды операционной системы; 
c) имена кластеров; 
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4. Шаблон имени и расширения файла — это: 
a) специальная форма, в которой в полях имени и расширений типа файла 
используются символы «+» и «-.»; 

b) специальная форма, в которой в полях имени и расширений типа файла 
используются символы «*» и «?»; 

c) специальная форма, в которой в полях имени и расширений типа файла 
используются символы «-» и «?»; 

5. Каталог — это: 
a) постоянная память; 
b) место хранения имен файлов; 
c) внешняя память длительного хранения; 

6. Для отображения краткой информации в окне необходимо нажать: 
a) Ctrl+F2; 
b) Ctrl+F1; 
c) Ctrl+F8; 

7. Для быстрого просмотра файла необходимо нажать: 
a) Ctrl+O; 
b) Alt+O; 
c) Ctrl+Q; 

8. В окне просмотра файлов можно: 
a) редактировать текст; 
b) только просматривать текст; 
c) просматривать и редактировать текст; 

9. Для редактирования файла необходимо нажать: 
a) F4; 
b) F5; 
c) F3; 

10. В окне редактирования файлов можно: 
a) редактировать текст; 
b) только просматривать текст; 
c) просматривать и редактировать текст. 

Тема: Операционная система Windows. 
1. Windows – это 

a) оболочка операционной системы; 
b) драйвер; 
c) операционная система; 

2. Панелью инструментов называется: 
a) панель, содержащая значки и кнопки, предназначенные для открытия 
ниспадающего меню; 

b) панель, содержащая значки и кнопки, предназначенные для быстрого 
доступа к наиболее часто используемым командам приложения; 

c) панель, содержащая значки и кнопки, предназначенные для использова-
ния команд отсутствующих во всех видах меню; 
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3. Какой интерфейс использует Windows? 
a) текстовый; 
b) программный; 
c) графический; 

4. Что такое программа «Поиск»? 
a) программа осуществляет быстрый поиск папок и файлов на компьютере; 
b) программа осуществляет поиск и удаление файлов на компьютере; 
c) программа не осуществляет поиск на компьютере; 

5. Главное меню предназначено для: 
a) быстрого запуска программ, поиска файлов, обеспечения доступа к 
справке; 

b) просмотра структуры папок и файлов; 
c) создания и удаления папок и файлов; 

6. Окно – это: 
a) прямоугольная область экрана, в которой выполняется программа или 
выводится содержимое папки; 

b) все пространство Рабочего стола; 
c) часть экрана, в которой выводятся диски, папки, сети; 

7. Проводник – это: 
a) программное средство Windows, предназначенное для управления файло-
вой системой, обеспечивающее  доступ к локальным и сетевым ресурсам; 

b) программное средство Windows, предназначенное для просмотра файлов; 
c) программное средство Windows, предназначенное для управления при-
ложениями и документами; 

8. Рабочий стол – это … 
a) полоса внизу экрана; 
b) все пространство экрана в среде Windows с расположенными на ней гра-
фическими объектами; 

c) все пространство экрана в среде Windows с расположенными на ней гра-
фическими и цифровыми объектами; 

9. Как запустить программу «Поиск»? 
a) Пуск → Программы → Поиск; 
b) Пуск → Программы → Стандартные → Поиск; 
c) Пуск → Поиск; 

12. Системное меню содержит: 
a) содержит команды для сохранения и удаления объектов; 
b) содержит команды, присущие только для данного объекта; 
c) содержит команды для изменения размеров окна. 
Тема: Табличный процессор Word. 

1. Команды открытия и сохранения файла находятся в пункте меню: 
a) Файл; 
b) Правка; 
c) Формат; 
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2. Колонтитул – это... 
a) граница текста; 
b) строки текста, печатаемые на всех полях страницы; 
c) строки текста, печатаемые на верхних и нижних полях страницы; 

3. Для организации таблицы следует выполнить команду ... и указать число строк, 
столбцов: 
a) Вставка → Таблица; 
b) Таблица → Нарисовать; 
c) Таблица → Добавить; 

4. Для обозначения конца абзаца используется клавиша: 
a) Enter 
b) Shift+Enter 
c) Ctrl+Enter 

5. Поместить в документ рисунок можно при помощи пункта меню: 
a)  Вид; 
b)  Сервис; 
c)  Вставка; 

6. Какая команда помещает выделенный фрагмент текста в буфер обмена без уда-
ления: 

a) Копировать; 
b) Вырезать; 
c) Вставить; 

7. С помощью какого элемента можно вставить объект WordArt: 
a) 2; 
b) 3; 
c) 4; 

8. Копирование выделенного абзаца выполняется так: 
a) Правка→ Копировать; 
b) Формат→Абзац→Копировать; 
c) Абзац→Копировать; 

9. Заменить одно слово на другое можно командой: 
a) Сервис → Правописание → Заменить; 
b) Правка → Правописание → Заменить; 
c) Правка → Заменить; 

10. Для ввода степени числа используют: 
a) шрифт маленького размера; 
b) вставку специального символа; 
c) верхний индекс. 
Тема: Электронная таблица Excel. 

1. Для задания диапазона ячеек Excel, два требуемых адреса необходимо раз-
делить: 
a) двоеточием; 
b) тире; 
c) точкой с запятой; 
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2. Запись «B$1» означает, что при копировании ячейки Excel: 
a) изменится имя столбца; 
b) изменится номер строки; 
c) изменятся имя и номер ячейки; 

3. Изменяющийся при копировании и перемещении адрес ячеек Excel: 
a) ссылка; 
b) абсолютная ссылка; 
c) относительная ссылка; 

4. Содержимым отдельной ячейки может быть: 
a) график, диаграмма или рисунок; 
b) число, текст, или формула; 
c) команда, файл, каталог; 

5. Для задания диапазона ячеек нужно указать: 
a) его левый верхний и правый нижний адреса ячеек; 
b) адрес каждой ячейки диапазона; 
c) адреса двух ячеек с максимальным и минимальным элементами; 

6. Укажите правильную запись формулы, вычисляющей произведение содер-
жимого ячеек А1 и В1: 

a) С1=А1*В1; 
b) А1*В1; 
c) = А1*В1; 

7. Если в клетках ЭТ содержится формула, то при обычном режиме в данной 
клетке отображается: 

a) содержимое данной клетки; 
b) математическая функции; 
c) вычисленное по этой формуле значение; 

8. Для указания абсолютного адреса используется знак: 
a) #; 
b) %; 
c) $; 

9. Файл, в котором хранится таблица Excel, имеет расширение: 
a) .doc; 
b) .exe; 
c) .xls; 

10. Результатом вычислений в ячейке С1 будет: 
a) 5; 
b) 10; 
с)15. 

 А В С 
1 5 = А1*2  =СУММ(А1:В1)   

Тема: Электронные презентации PowerPoint. 
1. В каком режиме просматривается данная 
презентация?  

a) обычный; 
b) страницы заметок; 
c) сортировщик слайдов; 
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2. Как изменить междустрочный интервал в маркированном списке?  
a) Формат → Абзац; 
b) Формат → Список; 
c) Формат → Интервалы; 

3. На картинке изображен слайд с таблицей. Вставить подобную таблицу в 
слайд возможно с помощью 
a) Вставка → Таблица; 
b) Формат → Таблица; 
c) Вид → Таблица; 

4. На рисунке изображена рамка с текстом, 
выровненным определенным образом. 
Укажите номер кнопки, соответствующей 
данному типу выравнивания: 
a) 1; 
b) 2; 
c) 3; 

5. В процессе демонстрации презентации док-
ладчик может использовать инструмент Ка-
рандаш. На рисунке представлен пример при-
менения этого инструмента. Укажите пункт 
контекстного меню, соответствующий выбору 
инструмента Карандаш: 

a) записная книжка; 
b) заметки докладчика; 
c) указатель; 

6. На рисунках изображен слайд с одинаковым содержимым. Чем различаются 
эти слайды? 

   
a) шаблонами оформления; 
b) цветовыми схемами; 
c) эффектами анимации; 

 7. На рисунке представлена картинка из коллекции MS Office 
ClipArt. Укажите все способы вставки картинок из данной 
коллекции: 
a) Вставка → Рисунок → Картинки; 
b) Вставка → Рисунок → Автофигуры; 
c) Вид → Вставка → Вставка картинки;  
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8. На картинке изображено окно Настройки ани-
мации. Меню «Вход» (выделено красным) уста-
навливает эффект анимации: 

a) Для всего слайда при смене слайдов;  
b) Для выделенного на слайде объекта; 
c) Для всех слайдов создаваемой презентации; 

9. На картинке изображен фрагмент слайда. Ука-
жите тип выравнивания названий времен года: 

a) По центру; 
b) По правому краю; 
c) По левому краю. 
Тема: База данных. 

1. Ключ в базе данных – это: 
a) простейший объект БД для хранения значений одного параметра реального 
объекта или процесса; 

b) поле, по которому выполняется фильтрация данных в таблице параметрам; 
c) поле или совокупность полей, однозначно определяющих записи таблицы; 

2. Представлена база данных «Школа»: 
 Фамилия Год рождения Класс Оценка 
 Лыкова Ольга 1988 10 5
 Семенов Олег 1987 11 4
 Морозов Иван 1987 11 3
 Рыков Роман 1988 10 5
 Попов Сергей 1988 10 4
 Зайцева Марина 1987 10 5 

Запрос для вывода спи-
ска: учеников 10 клас-
сов, 1988 года рожде-
ния, имеющих оценки 
не ниже 4 содержит вы-
ражение: 

a) Оценка>=4 и Год рождения = 1988 и Класс = 10; 
b) Класс = 10 и Год рождения = 1988 и Оценка = 5 и Оценка = 4; 
c) Оценка >=4 или Год рождения = 1988 и Класс = 10; 

3. Установленные связи между таблицами реляционной базы данных помогают: 
a) избежать дублирования информации; 
b) определить местонахождение нужной таблицы; 
c) производить сортировку таблицы; 

4. Система управления базами данных – это: 
a) формальный аппарат ограничений на формирование таблиц, который по-
зволяет устранить дублирование; 

b) комплекс программных и языковых средств, предназначенных для созда-
ния, ведения и совместного применения баз данных многими пользовате-
лями; 

c) система, реализующая сбор, обработку и манипулирование данными и 
включающая технические средства, программное обеспечение и соответ-
ствующий персонал; 

5. Тип поля (числовой, текстовой и др.) в базе данных определяется: 
a) названием поля; 
b) количеством строк; 
c) типом данных; 
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6. Какую строку будет занимать запись Pentium II после проведения сорти-
ровки по возрастанию в поле Винчестер? 
a) 1; 
b) 2; 
c) 4; 

 

 Компьютер Опер. память Винчестер 
1 Pentium 16 2Гб 
2 386DX 4 300Мб 
3 486DX 8 800Мб 
4 Pentium II 32 4Гб  

7. Запись в БД Access: 
a) столбцы реляционной таблицы; 
b) строки реляционной таблицы; 
c) одно или несколько полей, имеющих уникальное значение для реляцион-
ной таблицы; 

8. Поле какого типа не может быть ключевым: 
a) числовое; 
b) логическое; 
c) дата; 

9. В какой модели данных предполагается, что любой элемент может быть 
связан с любым количеством других элементов: 
a) реляционная; 
b) сетевая; 
c) иерархическая; 

10. База данных, в которой данные сгруппированы в двумерные таблицы, свя-
занные между собой, называется: 
a) иерархическая; 
b) сетевая; 
c) реляционная; 

11. Поисковая фраза в текстовых БД называется: 
a) вопросом; 
b) ответом; 
c) запросом. 

12. Представлена таблица базы данных «Кадры»: 
 Фамилия Год рождения Оклад 
 Иванов 1956 2400
 Петров 1957 5300
 Сидоров 1956 3600
 Скворцов 1952 1200
 Трофимов 1958 4500 

При поиске по условию (Год 
рождения>1956 и оклад<5000) бу-
дут найдены фамилии: называет-
ся: 

a) Иванов, Петров, Трофимов; 
b) Трофимов; 
c) Иванов, Петров, Трофимов, Скворцов. 
Тема: Алгоритмизация и программирование. Моделирование решения 

функциональных и вычислительных задач. 
1. Программы-компиляторы служат для: 

a) автоматического перевода программы в машинный код и последующего 
её использования без исходного текста; 
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b) анализа структуры очередного оператора языка из текста программы и 
его исполнения перед переходом к следующему оператору языка; 

c) написания текста программы с возможностью определения синтаксиче-
ских ошибок; 

2. Выберите верное высказывание: 
a) алгоритм имеет свойство дискретность, означающее разбиение алгоритма 

на конкретные действия; 
b) алгоритм имеет свойство специфичность, обозначающее, что алгоритм 

составляется для одной задачи; 
c) алгоритм имеет свойство результативность, означающее, что после вы-

полнения алгоритма должен быть получен графический результат. 
3. К языкам программирования высокого уровня относятся: 

a) Pascal, Basic, Cи++, Ассемблер; 
b) Pascal, Basic, Ассемблер, Access; 
c) Basic, Cи++, Pascal, Java. 

4. Алгоритм – это: 
a) точное предписание, определяющее процесс перехода от исходных дан-

ных к результату; 
b) требования, предъявляемые к программе; 
c) проведение расчетов и анализ результатов; 

5. Условие – это: 
a) выражение логического типа; 
b) повторяющиеся команды; 
c) все ответы верны; 

6. Язык программирования низкого уровня – это: 
a) не учитывают особенности конкретных компьютерных архитектур и по-
зволяют разрабатывать программы с помощью понятных для пользовате-
ля команд; 

b) языки, операторы которых близки к машинному коду и ориентированы на 
конкретные команды процессора; 

c) представляют собой комплект программ, обеспечивающий возможности 
работы на компьютере; 

7. Выберите верное высказывание: 
a) каждый алгоритм решения задачи имеет входные и выходные данные; 
b) каждый алгоритм содержит в себе разветвляющиеся и циклические 

структуры; 
c) не всякий алгоритм можно представить в виде блок-схемы; 

8. Выберите верное высказывание: 
a) алгоритм имеет свойство дискретность, означающее разбиение алгоритма 

на конкретные действия; 
b) алгоритм имеет свойство специфичность, обозначающее, что алгоритм 

составляется для одной задачи; 
c) алгоритм имеет свойство результативность, означающее, что после вы-

полнения алгоритма должен быть получен графический результат; 
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9. Выберите верное утверждение  
a) не верна; 
b) полного ветвления; 
c) неполного ветвления; 

10. Цикл в фрагменте программы будет исполнен: 
a) 1 раз; 
b) 4 раза; 

 c)  5 раз; 

P:=4; 
Repeat  
P:=P*0.1; 
Until P<0.0001; 

11. Условие принадлежности точки фигуре:  
a) (sqr(x)+sqr(y)<4) and (x>=0); 
b) (sqr(x)+sqr(y)<=4) or (y<>0); 
c) (x>0) and (x<2) and (y>-2) and (y>2); 

12. 12. a:=3; t:=1; For i:=1 to 5 do t:=t*a;  
a) блок программы вычисления 5!; 
b) блок программы вычисления a в 5 степени; 
c) блок программы вычисления суммы ряда a+2a+3a+4a+5a. 



 159

XII. КАРТА ОБЕСПЕЧЕННОСТИ ДИСЦИПЛИНЫ КАДРАМИ ПРО-
ФЕССОРСКО-ПРЕПОДАВАТЕЛЬСКОГО СОСТАВА 

 
Ф.И.О. должность Ученая степень и 

ученое звание 
Вид занятия Специальность 

Чалкина Н.А., 
ст.преподаватель 

к.п.н. Лекция 031001 – филология, 
030601 – журнали-
стика, 031202 – пе-
ревод и переводове-
дение 

Чалкина Н.А., 
ст.преподаватель 

к.п.н. Лабораторная 
работа 

031001 – филология, 
030601 – журнали-
стика 

Козюра В.Е., 
ассистент 

- Лабораторная 
работа 

031202 – перевод и 
переводоведение 

Голик А.В., 
ассистент 

- Лекция 031001 – филология, 
030601 – журнали-
стика, 031202 – пе-
ревод и переводове-
дение 

Голик А.В., 
ассистент 

- Практическая 
работа 

031001 – филология 

Антонова Т.Б., 
ассистент 

- Практическая 
работа 

030601 – журнали-
стика, 031202 – пе-
ревод и переводове-
дение 

 
 


